Mobile User Manual
Spillman® Public Safety Software

Spillman Technologies, Inc.
4625 West Lake Park Blvd.
Salt Lake City, Utah 84120
Telephone: 1-800-860-8026
www.spillman.com

First Publication: August 2016

Notice

Copyright © 2018, Spillman Technologies, Inc. All rights reserved. The information contained herein is proprietary to Spillman Technologies, Inc.

Spillman Technologies, Inc., reserves the right to make improvements and changes in the product described in this publication at any time and without notice, and may revise this publication from time to time without notice.

Spillman Technologies, Inc., provides this publication “as is” without warranty of any kind, either expressed or implied, including but not limited to the implied warranties or conditions of merchantability or fitness for a particular purpose. While every precaution has been taken in the preparation of this manual and its representation of the product, the publisher and author assume no responsibility for errors, omissions, or any damages or loss of data as a result of said errors or omissions.

Spillman, Summit, Sentryx, Involvements, Spillman Touch, Visual Involvements, and CrimeMonitor are federally registered trademarks of Spillman Technologies, Inc. Spillman Flex, Spillman InSight, and Integrated Hub are trademarks of Spillman Technologies, Inc. All other registered or unregistered trademarks and names are the property of their respective owners. Rev 06.12.18.
# Table of Contents

## Preface 13
- Using this manual 13
- Other Spillman manuals 13
- Windows basics 14
- Manual conventions 14

## 1 Getting Started 17

### Introduction 18
- Using Mobile with other modules 18

### Logging In to Mobile 20

### Using the Automatic Update Feature 22
- Manually updating Mobile 22

### Understanding the Mobile Today Screen 24
- Using the Today Center 25
- Locking Mobile 26

### Getting Help 27
- Accessing the Knowledge Center 27
- Accessing the Mobile Online Help 28

## 2 Message Center 31

### Introduction 32
- Using the Group Management feature 33
  - Hiding or displaying groups 34
  - Creating a custom group 35
  - Editing a custom group 36
Deleting a custom group  37
Adding external users to a custom group  37
Removing external users from a custom groups  38

Managing Messages  39
Opening messages  39
Sorting messages  40
Sending a message  40
   Editing outgoing messages  42
   Using the spelling checker  43
   Setting the priority of a message  44
   Replying to a message  45
   Forwarding a message  46
   Canceling a message  47
Selecting multiple messages  48
Saving messages  48
Deleting messages  48
Printing messages  49
Controlling the Message Center from the CAD command line  49

Using Instant Messenger  51
Understanding the IM pane  51
Updating your status  52
Understanding the Instant Message window  53
Sending instant messages  53
Receiving instant messages  55
Replying to an instant message  56

Working with Alerts  57
Sending an alert (ATL or BOLO)  57
Sending an Emergency alert  59
   Understanding Emergency alerts  59
Modifying an alert  60
Expiring an alert  61
Using StateLink alerts  61

Using Workflow Management  63
Working with Workflow records  65
Using the Group Filter feature  68
3 Queries, Returns, and Records 71

Introduction 72
Understanding the Mobile search screens 73

Performing Queries 74
Using wildcard characters 77
Entering state passwords 77
Changing your state password 78
Sending InSight queries 79
Searching for hazardous materials 80
Viewing hazardous material information 82

Working with Returns 83
Viewing RMS returns 83
Viewing State and InSight returns 85
Using the Message Center with returns 86
Using the History folder 86
Printing returns 87
Forwarding returns 88
Adding state returns to a CAD call 89

Importing Information from a State Return 91
Linking the vehicle owner 93
Confirming the vehicle owner 95
Searching for another Name record 95
Importing owner information 97
Separating records to import to the database 99

Importing Information from an InSight Return 102

Using the Record Screens 104
Using the Name screen 106
Using the Vehicle screen 108
Completing a Form  189
  Opening a form  189
  Choosing a form  191

Using Form Features  193
  Using fields with drop-down lists  193
  Expanding form areas  194
  Adding fields  195
  Writing narratives  195
  Using action buttons  195

5 Voiceless CAD and Mobile Mapping  197

Introduction  198

Assigning Yourself to a Unit  199

Understanding the CAD Screen  200
  Opening the CAD screen  200
  Working with CAD detail grids  201
    Sorting calls and units  201
    Resizing columns  202
    Resizing rows  202
    Filtering the Calls area  202
    Filtering the Units area  203
  Viewing the backup units dispatched to a call  203
  Understanding StateLink alerts in the CAD screen  204

Adding and Completing Calls in Voiceless CAD  206
  Viewing a CAD call  206
  Receiving CAD calls  207
  Becoming the Responsible Unit  208
  Updating your unit status  209
    Using the radio log to update your unit status  209
  Modifying a call  210
    Modifying a call in Mobile  211
    Viewing changes to a closed call  213
Completing a CAD call   214
Reactivating a call   215
Viewing upcoming scheduled events   216
  Filtering upcoming scheduled events   217
Assisting another unit as a backup unit   217
Using the Add a CAD Call feature   218
Using the Assign Self to Call feature   222
Using the On-Site Call feature   224

Understanding the CAD Call Information Screen   226
  Opening a record from the CAD Call Information screen   227
  Using the Incident # button on the Other tab   229

Using the Radio Log   230
  Sorting radio log entries   230
  Viewing radio log history   230
  Selecting the radio logs to display   231
  Using client time for radio log entries   231
    Making radio log entries in Offline mode   232
    Sending radio log entries to the server   232

Using the Mapping Module   234
  Opening the map   234
  Viewing the entire map   235
  Buttons on the Mapping toolbar   236
  Viewing CAD information on the map   237
  Viewing ScreenTips for calls, units, and devices   239
  Filtering the CAD calls that appear on the map   239
  Understanding the Clustering function   240
  Determining a location's latitude and longitude   242
  Locating an address on the map   242
    Using a street address to search for a location   242
    Using x- and y-coordinates to search for a location   243
    Clearing location labels   245
  Measuring distances on the map   245
  Viewing hyperlinks   246
  Determining the zoom factor   247
  Zooming in on the map   247
Zooming to a layer 248
Zooming to a polygon in a polygon layer 248
Zooming out on the map 248
Panning the map 249
Opening the map in Pictometry 249
Opening the map in a web browser 250
Viewing the current weather 250
Printing the map 251

Working with Map Layers 252
Adding a layer to the map 253
Removing a layer 254
Defining layer properties 254
  Setting general properties for a layer 254
  Setting label properties for a layer 255
  Setting hyperlink properties for a point layer 256
Working with layer components 257
Defining properties for a polygon 259
Defining properties for all lines in a layer 260
Defining properties for all points in a layer 261
  Selecting a font marker 261
Selecting a configuration 262

6 Mobile Settings 263

Using the Customize Dialog Box 264
Managing toolbar buttons 265
  Changing button appearance 265
  Moving, removing, or restoring buttons 265
Using the Commands tab 266
Using the Toolbars tab 268
  Resetting the main toolbar or menu bar 268
  Showing or hiding the main toolbar 268
Using the Tools tab 269
  Adding programs to the Tools area 269
  Removing programs from the Tools area 270
Using the Keyboard tab 271
  Assigning or changing keyboard shortcuts 271
  Removing keyboard shortcuts 272
Using the Menu tab 273
  Changing the items in the menu bar 275
Using the Options tab 276

Using the Options dialog box 277

Setting Search Options 278
  Setting default search options 278
  Setting InSight search options 279
  Setting Mobile’s behavior for query responses 280
  Displaying the Requesting Unit field 281
  Setting driver license scanning options 282

Changing Sound Notifications 284

Setting Voiceless CAD Options 286
  Changing the default view for call comments 286
  Enabling flashing StateLink alerts 287
  Changing the CAD list font size 288
  Setting the hours of radio log activity to be displayed 289
  Displaying One-Touch Status buttons on the map 290

Customizing Color Settings 292
  Setting the Alert marquee options 292
  Setting the Mobile color theme 293
    Setting Night mode settings 294
  Setting CAD colors 295

Setting Mapping Options 298
  Defining the appearance of markers and labels 298
  Adding a current weather feed to the map 300
  Setting the Emergency Alert Map Zoom settings 302
  Setting auto-zoom options 303
  Setting CAD information display options 304
    Viewing the Call Information and Unit Information areas 304
    Viewing the Call Comments area 305
Setting Message Center Options  307

A Appendix A  309

Using the Verified Entry feature with electronic forms  309
Viewing unverified records in Mobile  310
Verifying unverified records  311
Welcome to the *Mobile User Manual*.

This manual is written for users about how to use the Spillman Mobile software using Spillman Flex.

**Using this manual**

This manual contains the following information:

- Chapter 1 describes other modules available with Mobile, how to log in to and update Mobile, and a description of the Mobile Today screen.
- Chapter 2 describes how to use the Message Center, including sending email and instant messages, and managing workflow.
- Chapter 3 describes how to perform queries, work with local and state returns, and manage records, including how to add records, manage file attachments, and add narratives.
- Chapter 4 describes how to use the Mobile PDF forms to enter information about events such as a field interview, accident, or citation.
- Chapter 5 describes how to use the Voiceless CAD and Mapping modules, including how to read the CAD screen, update unit status, assign yourself to a call, and use the map to view call information.
- Chapter 6 describes how to customize Mobile settings, such as themes, notifications, Message Center options, CAD options, and Mapping options.
- Appendix A describes how to use the Verified Entry feature.

**Other Spillman manuals**

The *Automatic Vehicle Location (AVL) Manual* provides information on how to use the Mobile Mapping module with the AVL module to track units. The *Quickest Route Manual* provides information on how to use the AVL and Mapping modules to determine the quickest route for units to reach call locations. The *Mobile State eCitation and State Crash Forms Manual* provides information on how to create electronic Citation and Crash records.
using Mobile. The *Mobile Field Report and Field Interview Manual* provides information on how to create Law Incident records, Field Interview forms, and Fire Field Interview forms using Mobile.

**Windows basics**

Before using the software, be familiar with the standard features of Microsoft® Windows®. At a minimum, know how to do the following:

- Use a mouse or keyboard to perform basic tasks, such as choosing menu options and buttons.
- Work with windows, such as selecting, minimizing, restoring, maximizing, sizing, scrolling, closing, and so forth.
- Work with dialog boxes.

If these tasks are unfamiliar, then refer to your Windows online documentation or complete an online Windows tour.

**Manual conventions**

When using this manual, note the following conventions.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning/Use</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Used for names of menus, options, text boxes, buttons, fields, and other items that appear on the screen.</td>
<td><strong>OK</strong> is a button on the screen. Click <strong>OK</strong> or press Enter.</td>
</tr>
<tr>
<td><strong>angle bracket (&gt;)</strong> between items</td>
<td>Shows the menu option(s) that must be selected, in sequence, to get to a specific option.</td>
<td>From the Start menu, select <strong>All Programs &gt; Spillman &gt; Spillman Mobile</strong>.</td>
</tr>
<tr>
<td><strong>plus sign (+)</strong> between keys</td>
<td>Used for keys that are pressed at the same time. Hold down the first key, and then press the other key(s). When a keystroke is available for a mouse action, both the mouse action and the keystroke are presented.</td>
<td>Press Ctrl+E. Click <strong>Close</strong>, or press Ctrl+F4.</td>
</tr>
<tr>
<td><strong>comma (,)</strong> between keys</td>
<td>Used for keys that are pressed in sequence. Press and release each key, in the order shown.</td>
<td>Press Alt, F, O to open the File Options dialog box.</td>
</tr>
<tr>
<td><strong>Courier font</strong></td>
<td>Used for displayed text. Used for table names.</td>
<td>The software prompts: Are you sure you want to delete this record? Open the Names table (nmmain).</td>
</tr>
</tbody>
</table>
The following boxes indicate special information.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning/Use</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold Courier font</strong></td>
<td>Used for information you enter.</td>
<td>Type the street address, such as <strong>401 W Sycamore St.</strong></td>
</tr>
<tr>
<td><em>italics</em></td>
<td>Used for emphasis.</td>
<td>Type the date, using the <em>mm/dd/yyyy</em> format.</td>
</tr>
<tr>
<td></td>
<td>Used for variable information you supply.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**
Notes call attention to information that is of particular importance or that varies depending on a particular condition, such as the way your Spillman Application Administrator has configured the software.

**TIP**
Tips present recommendations, optional actions, and additional ways to perform specific tasks.

**CAUTION**
Cautions point out actions that might endanger your data or its integrity (usefulness) or cause other problems later.

Features on your computer depend on your software version, modules, and privileges. Actual screens on your computer might vary from the example screens shown in this manual. However, any differences are minor and do not affect the tasks being described.

To find more manuals, visit MySpillman or the Spillman Knowledgebase.
# Introduction

Mobile is a mobile data communications product that provides access to your agency's local database by means of a direct LAN or wireless modem connection from a personal computer or laptop computer.

Mobile includes the following features:

- **Integrated Messenger.** Exchanges email with other users of your database.
- **Alert Messaging.** Sends and receives priority alerts, such as Attempt to Locate (ATL) or Be On the Look Out (BOLO).
- **Instant Messenger (IM).** Exchanges instant messages with other users of your database.

## Using Mobile with other modules

The following optional modules can be used with Mobile:

- **Local RMS Queries.** Used to search for Name, Vehicle, Incident, Property, and other records in your database.
- **StateLink.** Used to search for Name, Vehicle, and Property records, and to send gun and stolen property queries to your state and national databases. Mobile adds a radio log entry to the Radio Log table in your database for each query that is performed.
- **Mobile AVL and Mapping.** Used to track the location of your agency's units and Computer-Aided Dispatch (CAD) calls on a map of your jurisdiction. The map is integrated into Mobile so that officers, dispatchers, and supervisors who have access to Mobile can view the map.
- **State eCitation and State Crash Forms.** Used to complete traffic citations and crash reports while in the field. Once completed, the form is saved as a record in the database.
- **Mobile Field Report and Field Interview.** Used to create Law Incident records with narratives, Field Interview forms, and Fire Field Interview forms while in the field.
- **Mobile Premises Information.** Used to protect personnel by viewing information about unfamiliar sites when responding to law incidents or disasters. From the Premises screen, the Premises table in your agency's local database can be queried for information about commercial, public, and residential premises.
• **Hazardous Materials (HAZMAT).** Used to search the National Oceanic and Atmospheric Administration (NOAA) Computer-Aided Management of Emergency Operations (CAMEO ®) database for information on more than 6,000 chemicals, including handling instructions, first-aid responses, and protective clothing recommendations.

• **Mobile Voiceless CAD.** Used to perform many CAD functions, including viewing detailed information about a call, updating your unit status, and viewing the status of other units, assisting another officer, and adding a call.
Logging In to Mobile

Mobile can run with or without opening Flex.

To log in to Mobile, do one of the following:

- In the Login screen, enter your user name and password, and then press Enter. From the **Database** field, select the database for your agency.

  ![Login Screen](image)

  The software opens to the command center and the Mobile Today screen.

- If Flex was started without Mobile, then from the command center, from the menu bar, select **Message Center > Message Center**.

  The Message Center opens.

- To start Mobile without Flex, double-click the **Mobile** icon on your desktop.
The Mobile Login screen opens.

- Enter your user name and password, and then press Enter.

**NOTE**
Depending on the settings configured by your SAA, when you log in to the software, you might be automatically assigned to a call.

If your agency uses Voiceless CAD, then when logging in, you can assign yourself to a unit. For more information see “Assigning Yourself to a Unit” on page 199.

The Mobile Today screen opens.

**NOTE**
If Flex and Mobile are opened at the same time, then closing Flex also closes Mobile.

If the Mobile update dialog box opens after logging in, then see “Using the Automatic Update Feature” on page 22.

To open the command center from Mobile, from the menu bar, select **Tools > Launch Spillman**.
Using the Automatic Update Feature

Mobile can automatically update your system, using the code tables in your agency’s database. If your SAA added new files to the Mobile server, such as sound files, new code tables, or a newer version of the software, then a dialog box opens after logging in. Some updates require logging in again.

When the Mobile update dialog box opens, do one of the following:

- To download all available files and update your system, click **Update Now**.

  **NOTE**
  The Mobile update dialog box shows an approximate download time at an average speed of 28.8 Kbps. Your actual download time might differ, depending on your network speed. Mobile is unavailable during an update.

  - To log in without updating, click **Ask Me Later**. Mobile can be updated at a later time. See “Manually updating Mobile” on page 22.
  - To select the updates to download, do the following:
    - Click **Customize**.
      The Customize Download dialog box opens, listing the files available for download.
    - Select the updates that your system should download.
    - Click **OK**.

  **NOTE**
  Mobile prompts to update during login until your system is up to date.

Manually updating Mobile

If the **Update Now** button is not clicked when prompted, then the update can be manually started later.

To manually update Mobile:

1. In Mobile, select **Tools > Update Application** (Alt+T, U).
   The Mobile update dialog box opens.
2. Click **Update Now**.
   Mobile is updated with any changes from your agency’s server and the software is restarted.
3. If prompted, enter your user name and password.

The Mobile Today screen opens.
Understanding the Mobile Today Screen

After logging in to Mobile, the Mobile Today screen opens.

The Mobile Today screen contains the following:

- **Menu bar.** Use the menu bar to perform operations and move to other areas of Mobile. Press Alt+ underlined characters for keyboard access to menus. The menu bar options change depending on which screen is active. See “Using the Menu tab” on page 273.

- **Main toolbar.** Use the main toolbar to move to other areas of Mobile. This toolbar can be modified and is available from any Mobile screen. See “Using the Commands tab” on page 266.

- **Tools area.** Use the Tools area to access websites and programs on your computer from the Mobile Today screen. This menu appears on the Mobile Today screen only if hyperlinks have been added. See “Using the Tools tab” on page 269.

- **Today Center.** Use the Today Center to view agency updates or the message of the day, to lock Mobile, view system information, and access shortcuts to other areas in Mobile.

- **Status bar.** Displays your connection status, unit status, the time, the number of unread state returns and messages, and any current alerts.
The Connection Status Indicator changes from green to red when the connection to the server is lost.

Using the Today Center

Depending on the modules your agency has purchased, the Today Center is divided into the following areas:

- **Agency Update.** Contains important messages for your agency, such as training notices or changes to procedure. This area is set by your SAA or supervisor.

- **Message of the Day.** Contains important messages. However, unlike the Agency Update area, the Message of the Day area is visible system-wide to any agency sharing your server. A message of the day also appears after logging in to the software, if one is set.

- **Message Center.** Contains links to any of the following new or unread items in the Message Center:
  - Alerts
  - Messages
  - Approvals
  - InSight Returns, if your agency has purchased the InSight module
  - State Returns, if your agency has purchased the StateLink module

For more information about the Message Center, see “Message Center” on page 31. For more information about InSight returns and state returns, see “Queries, Returns, and Records” on page 71.

- **System.** Contains the name of the user currently logged in, the Mobile version currently running, and the name of the server to which Mobile is connected. It also contains a link to lock Mobile for security purposes. For more information, see “Locking Mobile” on page 26.

- **CAD.** Contains information regarding current CAD calls, your unit information, your zone, your active call (if applicable) and a link to search the last two weeks of Law Incident records. This area is only available if your agency has purchased the Voiceless CAD module.

- **Field Reports.** Contains a link to any draft forms, and if applicable, the number of citation numbers currently available. This area is available only if your agency has purchased the Mobile Field Report and Field Interview Form or the Mobile State eCitation and State Crash Forms.
Locking Mobile

Mobile is equipped with a locking feature that prohibits unauthorized persons from viewing or retrieving information from Mobile if your computer is left unattended.

NOTE
The locking feature disables only Mobile. The other applications on your computer are still accessible.

To lock Mobile, from the menu bar, select File > Lock (Ctrl+K), or from the Today Center, in the System area, click the activate now link.

Mobile locks the screen and the following message is displayed:
Spillman Mobile has been locked. Select Unlock to return to your session. Select Exit to quit.

To unlock Mobile, from the Locked dialog box, click Unlock (Alt+U). When prompted, enter your password, and then press Enter.

To exit Mobile, from the Locked dialog box, click Exit.
Getting Help

For help using Mobile, see the Knowledge Center or Mobile Online Help. The Knowledge Center can be accessed from Mobile or Flex, and the Mobile Online Help can be accessed from only Mobile.

Accessing the Knowledge Center

**From Mobile and Flex**

To access the Knowledge Center in Mobile or in Flex, from the Help menu, select **Knowledge Center**.

**NOTE**

An Internet connection is required to access the Knowledge Center.

The Knowledge Center opens in a web browser, and a menu providing access to additional training, documentation, videos, and more is displayed.
From Flex

If Flex is launched, then the Knowledge Center can be accessed from the Tree Menu or from the command line. To access the Knowledge Center, do one of the following:

- To access the Knowledge Center from the Tree Menu, select **Hub Menu > Knowledge Center**.

- To access the Knowledge Center from the command line, at the command line, enter `kc`.

Accessing the Mobile Online Help

To access the Mobile Online Help, from the Help menu, select **Help Topics**.
The Mobile Online Help opens, and a list of articles pertaining to Mobile are displayed in the **Contents** tab.
Chapter 2

Message Center

Introduction 32
Managing Messages 39
Using Instant Messenger 51
Working with Alerts 57
Using Workflow Management 63
Introduction

Use the Message Center to exchange email or instant messages within your agency, to receive query results, and to retrieve form drafts.

To open the Message Center, do one of the following:

- From the main toolbar, click the **Message Center** button.
- Press F6.
- From the menu bar, select **Screens > Message Center**.

The Message Center contains the following areas:

- **Messages toolbar.** Used to perform operations in the Message Center. Toolbar options change depending on which folder in the **Messages** pane is selected.

**NOTE**

The options available in the Message Center depend on the modules purchased by your agency.
• **Messages pane.** Used to select and work with a message. Messages are divided into the following folders by type:
  - Alerts
  - Local Returns
  - State Returns
  - Approvals
  - InSight Returns
  - Draft Forms

• **IM pane.** Used to select recipients for email and instant messages. Click the plus sign to expand a group. A red icon and italic font indicate that a user is offline. A green icon indicates that a user is online. A yellow icon indicates that a user is away from their unit. See “Using Instant Messenger” on page 51.

• **Message Header area.** Displays message header information. Click a message to display it in the **Message area.**

• **Message area.** Displays the text of the selected message.

**Using the Group Management feature**

Use the Group Management feature to create custom email and instant messaging groups. Using groups is a quick way to send emails and instant messages to a pre-defined group of people.

The following group types are available:

• **Agency.** Contains all users associated with a particular agency. This group type is created by the software and cannot be edited.

• **System.** Contains all users associated with a particular operating system group, such as Dispatch, Fire, EMS, and Admin. This group type is created by the software and cannot be edited.

• **Custom.** Contains the selected users of your choice. Custom groups are not created by the software and can be edited. For more information, see “Creating a custom group” on page 35 and “Editing a custom group” on page 36.

The **IM** pane displays all your custom groups and your selected system or agency groups. For more information, see “Hiding or displaying groups” on page 34.

Groups are managed in the Group Management dialog box. To open the dialog box, from the menu bar, select **Actions > Group Management,** or from the IM pane, do one of the following:

• Right-click a group, and then select **Group Management.**
Click the drop-down list, and then select **Group Management**.

![Group Management dialog box]

**Hiding or displaying groups**

System and agency groups can be displayed or hidden from the **IM** pane. Custom groups are always shown in the **IM** pane. Display frequently-used groups to quickly choose a group to instant message or email.

To hide or display a group in the **IM** pane:

1. From the Group Management dialog box, do any of the following:
   - To add a group, select a group from the **Groups** list area, and then click **Add**. The group appears in the **My Groups** list area.
   - To remove a group, select a group from the **My Groups** list area, and then click **Remove**. The group is removed from the **My Groups** list area.

**TIP**

To select multiple groups, in the appropriate list area, hold down the Ctrl key while clicking the name of each group, and then click **Add** or **Remove**. To select a range of groups, hold down the Shift key while clicking the first and last group name in the range of groups, and then click **Add** or **Remove**.

2. Repeat step 1 until the **My Groups** list area shows all the desired groups, and then click **OK**.

The Group Management dialog box closes, and any group added to the **My Groups** list area is displayed in the **IM** pane. Any group removed from the **My Groups** list area is no longer displayed.
Creating a custom group

Custom groups can be created as desired.

To create a custom group:

1. From the Group Management dialog box, click the **New Group** button.

   The New Custom Group dialog box opens.

2. In the **Group Name** field, enter a name for the group.

3. In the **Type name or select from list** field, enter the name of the user as it is displayed in the **User Names** list area, or select a name from the list, and then click **Add**.

   **TIP**
   To select multiple users, hold down the Ctrl key while clicking the name of each user, and then click **Add**. To select a range of users, hold down the Shift key while clicking the name of the first and last user in the range of users, and then click **Add**.

   The selected users appear in the **Group Members** list area.

4. Repeat step 3 until all desired users are listed in the **Group Members** list area, and then click **OK**.

   The New Custom Group dialog box closes, and the new group appears in the **My Groups** list area in the Group Management dialog box.

5. Click **OK**.

   The custom group is displayed in the IM pane.
**Editing a custom group**

Custom groups can be edited after they are created.

| NOTE | System and Agency groups cannot be edited. |

To edit a custom group:

1. From the Group Management dialog box, in the **My Groups** list area, select the group to be edited, and then click the **Edit Group** button.

The Edit Custom Group dialog box opens.

2. Do any of the following:
   - To change the group name, enter a new name in the **Group Name** field.
   - To add another member, in the **Type name or select from list** field, enter the name of the user as it is displayed in the **User Names** list area, or select a name from the list, and then click **Add**.
   - To remove a member from the group, from the **Group Members** list area, select the desired member, and then click **Remove**.

| TIP | To select multiple users, hold down the Ctrl key while clicking the name of each user, and then click **Add**. To select a range of users, hold down the Shift key while clicking the name of the first and last user in the range of users, and then click **Add**. |
3. Click **OK**.

The changes are applied to your custom group.

**Deleting a custom group**

Custom groups can be deleted from the **My Groups** list area, which also removes them from the **IM** pane when the Mobile session is ended.

To delete a custom group:

1. From the Group Management dialog box, in the **My Groups** list area, select the custom group to delete, and then click **Remove**.

A confirmation dialog box opens.

2. Click **OK**.

The group is removed from the **My Groups** list area. The group remains in the **IM** pane until the current Mobile session is ended. When the next session is started, the group no longer exists.

3. In the Group Management dialog box, click **OK**.

**Adding external users to a custom group**

Depending on your agency’s server settings, external users can be added to a custom group, such as a person at another agency or a non-Mobile user.

To add an external user to a custom group:

1. From the Group Management dialog box, do one of the following:

   - To add an external user to a new custom group, click **New Group** to open the New Custom Group dialog box. In the **Group Name** field, enter the name of your new custom group.

   - To add an external user to an existing custom group, select the desired group, and then click **Edit Group**.

2. Click **Add External Users**.

The Add External User dialog box opens.

3. In the **User Name** field, enter the user name of the person being added in the following format:
username@ip/hostname

where username is the user name of the person being added, and ip/hostname is the person’s IP address or host server. For example, lsamson@im.spd.org.

4. In the Nickname field, enter a nickname for the external contact.

5. Click OK.

The new contact is added to the Group Members area of the New Custom Group and Edit Custom Group dialog boxes.

Removing external users from a custom groups

To remove an external user from a custom group:

1. From the Group Management dialog box, in the My Groups list area, select the custom group, and then click Edit Group.

   The Edit Custom Group dialog box opens.

2. In the Group Members list area, select the external user’s name, and then click Remove.

   The following message is displayed:

   Remove External User from custom group?

3. To remove the user from the group, click Yes or press Enter.

4. Click OK.

   The user is removed from the group.
Managing Messages

Use the Message Center to manage the messages received in Mobile. To manage messages, do any of the following:

- “Opening messages” on page 39
- “Sorting messages” on page 40
- “Sending a message” on page 40
- “Saving messages” on page 48
- “Deleting messages” on page 48
- “Printing messages” on page 49

After logging in to Mobile, the software checks the server for messages that have been sent to your account since the last Mobile session. New messages are placed in the Messages folder, and the message headers are displayed in the Message Header area. While logged in to Mobile, new messages are received automatically.

Depending on your settings, when a new message arrives in your Messages folder, the following occurs:

- On the main toolbar, the Message Center button is animated.
- In the Mobile Today screen, the Message Center area is updated.
- In all Mobile screens, the status bar is updated.
- The New Message Received sound is played.

The sound notification for a new message received can be changed. For more information, see “Changing Sound Notifications” on page 284.

Opening messages

To open a message, do one of the following:

- Click the message header.

- Press the Tab key to move to the Message Header area. Use the Up Arrow and Down Arrow keys to select a message header, and then press Enter.

When a message is opened, the message body is displayed in the Message area. The message body can take a few moments to appear, depending on the length and content of the message, as well as the speed of your network.

Once a message is opened, it is stored on your device until the message is deleted or the Mobile session is ended.
**Sorting messages**

Messages in any folder can be sorted by priority, status, sender, subject, or date sent.

To sort messages, in the **Message Header** area, click the heading of the column to sort. An arrow icon indicates if the order is ascending or descending. To reverse the sort order, click the heading again.

**Sending a message**

The Message Center is used to send messages to users or groups in your system.

To send a message:

1. In the **Messages** pane, click the **Messages** folder.
2. From the Messages toolbar, click **New Message**.
   - The Message window opens, and the Select Names dialog box opens.
3. Select the desired recipients in the **User Names** list area by doing one of the following:
   - Double-click the name of the desired individual or group.
– Click the name of the individual or group, and then click **Add**.
– Use the Up Arrow or Down Arrow key to select the user or group, and then press Enter.

**TIP**

Use the Right and Left Arrow keys to expand a group and view its members.

To select multiple recipients, hold down the Ctrl key while clicking each user or group name, and then click **Add**. To select a range of recipients, hold down the Shift key while clicking first and last user or group name in the range of recipients, and then click **Add**.

4. To accept the list and close the Select Names dialog box, click **OK**.

**TIP**

To reopen the Select Names dialog box and add or change the recipients of the message, click the **To** button.

5. From the Message window, in the **Subject** field, enter a subject title for the message.

6. In the **Message** area, enter the desired message text.

7. If desired, to insert an image located on your agency’s network, do the following:

   – Right-click the area in which to insert the message, and then select **Insert Image**.
     
     The Picture dialog box opens.

   – In the **Picture Source** field, click **Browse** to locate and select the file location.
   
     – To create a label that appears when the recipient rests the mouse pointer on the image, enter the text to be displayed in the **Alternate Text** field.
To change the image alignment in the **Message** area, select a value from the **Alignment** field.

To add a border to the image, in the **Border Thickness** field, enter a value in pixels for the thickness of the border. A black border appears around the image when it is inserted.

To apply spacing around the image, in the **Horizontal** and **Vertical** fields, enter a value in pixels for the spacing in width and height.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If either the image or the recipient of the message is not on the network for your agency, then the recipient will not be able to see the image when the message is received.</td>
</tr>
</tbody>
</table>

Click **OK** to close the Picture dialog box and apply your settings to the inserted image.

8. If desired, set the priority of the message. See “**Setting the priority of a message**” on page 44.

9. To send the message, in the Message window, do one of the following:

- From the toolbar, click **Send**.
- From the menu bar, select **File > Send** (Alt+F, S).

The sent message appears in the **Sent** folder.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the Message Center options are set to automatically check spelling, then if there are spelling errors, the Check Spelling dialog box opens. Correct any errors before sending the message. For more information, see “<strong>Using the spelling checker</strong>” on page 43.</td>
</tr>
</tbody>
</table>

**Editing outgoing messages**

Messages that are being written or forwarded can be modified in the following ways:

- Copy (Ctrl+C) and paste (Ctrl+V) text from another message into a new message.
- Cut (Ctrl+X) and paste (Ctrl+V) selected text to reorganize a message.
- Delete selected text.
• Add additional text anywhere in the message.

**NOTE**
Windows commands for selecting, cutting, copying, and pasting all function the same in the Message area and Subject field. The Select All (Ctrl+A) and Undo (Ctrl+Z) commands can also help to quickly edit your message.

**Using the spelling checker**
To enable automatic spell-check when messages are sent, see “Setting Message Center Options” on page 307. The spelling checker can also be started manually.

To manually start the spelling checker:

1. Place the cursor in the desired location of the message body text.
2. Do one of the following:
   - From the menu bar, select Edit > Spelling (Alt+E, S).
   - From the toolbar, click the Spelling icon.

The spelling checker checks the text in the Message area and Subject field. If a word is encountered that is not in the spelling checker dictionary, then the Check Spelling dialog box opens and displays the following:

   - The word in the Not in Dictionary field.
   - The most likely alternative word in the Change To field.
   - A list of alternative words in the Suggestions field.

3. For each questionable word found by the spelling checker, determine the action to take by using the following table.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore the questionable word</td>
<td>Click Ignore.</td>
</tr>
<tr>
<td>Ignore all occurrences of the questionable word in the current document</td>
<td>Click Ignore All.</td>
</tr>
<tr>
<td>Replace the questionable word with the word in the Change To field</td>
<td>Click Change.</td>
</tr>
<tr>
<td>Replace the questionable word with a word in the Suggestions field</td>
<td>Select the correct word by clicking the word or pressing the Down Arrow key until the word is selected. When the correct word is displayed in the Change To field, click Change.</td>
</tr>
</tbody>
</table>
When no more questionable words are found, a confirmation dialog box opens.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace the questionable word with a word that is not suggested by the spelling checker</td>
<td>In the Change To field, either enter a new word or change the spelling of the existing word. Click Change.</td>
</tr>
<tr>
<td>Replace all occurrences of the questionable word in the current document with the word that is displayed in the Change To field</td>
<td>Make sure the correct word is displayed in the Change To field. If necessary, enter the correct word or select it in the Suggestions field. Click Change All.</td>
</tr>
</tbody>
</table>

4. To return to the Message window, click OK.

**Setting the priority of a message**

The priority level of a message is displayed in the priority column of the Message Header area:

- A red exclamation mark identifies a message with Immediate Attention priority.
- A blue exclamation mark identifies messages with Require Reading priority.
- No entry in the priority column identifies messages with normal priority.

The default priority level for new or forwarded messages is normal. The priority of a message can be changed while it is being edited or created. To change the priority of a message, click the desired priority icon from the Message window toolbar.
Replying to a message

The Message Center has the option to reply to only the sender of a message, or to reply to the sender and all other recipients of the message.

To reply to a message:

1. Select the desired message by doing one of the following:
   - Click the message header.
   - In the **Message Header** area, use the Up Arrow or Down Arrow key to navigate to the desired message.

2. Do one of the following:
   - To reply to the sender only, click the **Reply** button on the Messages toolbar, or from the menu bar, select **Actions > Reply** (Alt+A, R).
   - To reply to all recipients and the sender, click **Reply to All**, or select **Actions > Reply to All** (Alt+A, L).

   The Message window opens. In the **To** field, names of the selected are displayed. In the **Subject** field, the following is displayed:

   \[ \text{RE: Original Message} \]

   where **Original Message** is the subject of the original message.

3. To add additional recipients, click the **To** button, the Select Names dialog box and select the desired recipients. For more information, see “Sending a message” on page 40.

4. In the **Message** area, enter your reply.

5. If desired, set the priority of the message. For more information, see “Setting the priority of a message” on page 44.

6. To send the message, in the Messages window, do any of the following:
   - From the toolbar, click **Send**.
   - From the menu bar, select **File > Send** (Alt+F, S).
   - Press Ctrl+Enter.

**NOTE**

If the Message Center options are set to check spelling automatically, then the Check Spelling dialog box opens. Correct any errors before sending the message. For more information, see “Using the spelling checker” on page 43.
Forwarding a message

Messages can be forwarded to other groups or users.

To forward a message:

1. In any of your Message Center folders, locate the message to forward.

2. Select the message header, and then do one of the following:
   - From the messages toolbar, click **Forward**.
   - From the menu bar, select **Actions > Forward** (Alt+A, F).
   
The Message window opens, and the Select Names dialog box opens.

3. Select the desired recipient(s) in the **User Names** list area by doing one of the following:
   - Double-click the name of the desired user or group.
   - Click the name of the user or group, and then click **Add**.
Managing Messages

4. To accept the list and close the Select Names dialog box, click OK.

5. In the Message area, enter the message text.

6. If desired, set the priority of the message. See “Setting the priority of a message” on page 44.

7. To send the message, in the Message window, do one of the following:
   – From the toolbar, click Send.
   – From the menu bar, select File > Send (Alt, F, S).
   – Press Ctrl+Enter.

**Canceling a message**

A message can be canceled before it is sent.

To cancel a message:

1. In the Message window, do one of the following:
   – In the upper-right corner, click the Close button.
   – From the menu bar, select File > Close (Alt+F, C).
   – Press Alt+F4.

   If any changes have been made in the message body, then the Close Message dialog box opens.

2. Click Yes, or press Y to close the Message window and discard all changes. Otherwise, click No or press N to close the dialog box and return to the Message window.
Selecting multiple messages

Multiple messages can be selected for saving, deletion, or printing.

To select multiple messages, select the folder containing the messages, and then in the Message Header area, do one of the following:

- To select all messages in the Message Header area, press Ctrl+A.
- To select a range of messages, press Shift and click the first and last message in the desired range.
- To select multiple messages that are not directly next to each other, press Ctrl and click each message.

Saving messages

When a message is saved, it is placed in the Saved folder. Saved messages are stored on the server so that the messages can be retrieved if logging in from a different computer.

To save one or more messages:

1. Select the message to save. To select multiple messages, see “Selecting multiple messages” on page 48.
2. Do one of the following:
   - From the messages toolbar, click Save.
   - From the menu bar, select File > Save (Alt+F, S).
   - Right-click the message header, and then select Save.

   The message is moved to the Saved folder.

Deleting messages

Multiple messages can be selected for deletion. When a message is deleted, it is moved to the Deleted folder.

To delete one or more messages:

1. Select the message to delete. To select multiple messages, see “Selecting multiple messages” on page 48.
2. Do one of the following:
   - From the Messages toolbar, click the Delete button.
   - Press Delete.
   - From the menu bar, select Edit > Delete (Alt+E, D).
Managing Messages

Right-click the message header, and then select Delete from the shortcut menu.

The message is moved to the Deleted folder.

Printing messages

To print one or more messages:

1. Select the message to print. To select multiple messages, see “Selecting multiple messages” on page 48.

2. Do one of the following:
   - From the messages toolbar, click Print.
   - From the menu bar, select File > Print (Alt+F, P).
   - Right-click the message body, and then select Print from the shortcut menu.

The Print dialog box opens.

3. Configure your printer settings, and then click Print.

The message is printed.

Controlling the Message Center from the CAD command line

Depending on the settings established by your SAA, Message Center commands can be recognized and executed from the command line.

The following table lists the function to perform, the command to use, and a description of the action it invokes. These commands work for messages in the State Returns folder only.

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to Call</td>
<td>XA call#</td>
<td>Appends the displayed state return to the comments of the specified CAD call.</td>
</tr>
<tr>
<td></td>
<td>XA long-term call ID</td>
<td></td>
</tr>
<tr>
<td>Up Arrow</td>
<td>XB</td>
<td>Scrolls to the previous state return in the list.</td>
</tr>
<tr>
<td>Delete</td>
<td>XD</td>
<td>Deletes the displayed state return.</td>
</tr>
<tr>
<td>Next Message (F6)</td>
<td>XF</td>
<td>Scrolls to the next state return in the list.</td>
</tr>
<tr>
<td>Page Down</td>
<td>XN</td>
<td>Scrolls to the next page of a multiple-page state return.</td>
</tr>
<tr>
<td>Page Up</td>
<td>XP</td>
<td>Scrolls to the previous page of a multiple-page state return.</td>
</tr>
</tbody>
</table>
### Message Center

#### Managing Messages

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>XPR</td>
<td>Prints the displayed state return to the default Message Center printer.</td>
</tr>
<tr>
<td>Forward</td>
<td>XM <em>username</em></td>
<td>Emails a copy of the displayed state return to another user, where <em>username</em> is the user name of the person to whom the return should be forwarded.</td>
</tr>
</tbody>
</table>
Using Instant Messenger

Instant Messenger includes the following features:

- **Presence List.** A list of active users is in the *Instant Messaging (IM)* pane. See “Understanding the IM pane” on page 51.

- **User Status.** The Instant Messenger status can be changed to either **Online** or **Away**. See “Updating your status” on page 52.

- **Send Messages.** Instant messages can be sent and received in real time to individuals and groups. Authorized users can also send Alert messages, such as Attempt To Locate (ATL), Be On The Lookout (BOLO), or Emergency alerts. For more information on Alert messages, see “Working with Alerts” on page 57.

- **Emoticons.** A list of emoticons that can be used in your instant messages is available.

Understanding the IM pane

The *Instant Messaging (IM)* pane serves as a contact list and as a way to initiate instant messaging with online users in your agency's network.

In the **IM** pane, online groups are listed first, with their users in alphabetical order, followed by offline groups, also in alphabetical order. The name of each user is under their agency group. If a user is assigned to additional groups, such as a custom group, then the user appears as part of that group as well.

Use the **IM** pane to do any of the following:

- From the **IM** drop-down list, the Group Management feature can be opened and your online status can be changed. For more information, see “Updating your status” on page 52 and “Using the Group Management feature” on page 33.
- To show all the members in a group, click the plus sign. To collapse an expanded group, click the minus sign.

- Groups and users display a colored icon to indicate their Instant Messenger status:
  - **Green.** The user is online, or the group has at least one user online.
  - **Yellow.** The user or group is logged in, but currently away from the unit.
  - **Red.** The user or group is offline. In this case, the user or group name is in italics.

- To open an IM window, double-click an available online group name or user name. A message can then be created and sent to the group or person selected.

- To view a shortcut menu, right-click a group or user name. From the shortcut menu, either Send Instant Message or Send Message can be selected if the group or user is online. If the group or user is away or offline, then Send Message is the only option available.

**Updating your status**

Change your instant messenger status to inform other users of your availability. The default status is Online when first logging in to Mobile.

To change your instant messenger status, select a new status from the drop-down list in the IM pane. If Away is selected, then [Away] is displayed next to the IM heading in the IM pane.
Understanding the Instant Message window

The Instant Message window is used to send and receive instant messages.

The Instant Message window contains the following:

- **Title Bar.** Used to identify the window and the user.
- **Message Log pane.** Used to show the messages that are sent and received. Your name is in blue text and the other user’s name is in red text. Instant Messenger skips a line between each message.
- **Pin button.** Used to make the Instant Message window stay on top of other windows and applications.
- **Message Entry area.** User to compose your message.
- **Emoticon drop-down list.** Used to insert an emoticon into your message.
- **Send button.** Used to send your message to the user or group specified.

Sending instant messages

Instant messages can be sent from the Instant Message window or from the CAD command line. Messages can be sent to a single recipient, groups, or multiple recipients. This section describes how to send an instant message from the Instant Message window. For information on sending an instant message from the CAD command line, see the *CAD User Manual.*
To send an instant message to a single recipient or group:

1. In the IM pane, select a group, and then click the plus sign to show all members in the group.

2. Do one of the following:
   - To message a single recipient:
     - Right-click the user’s name, and then select Send Instant Message.
     - Double-click the user’s name.
   - To message an entire group:
     - Right-click the group, and then select Send Instant Message.
     - Double-click the group.

The Instant Message window opens.

3. In the Message Entry area, compose your message.

4. Click Send, or press Enter.

In the Message Center, when an instant message is sent to multiple recipients, a temporary group is created. Temporary group IDs can be used to send subsequent messages using the IM command until the Mobile session is ended, even if the original IM window is closed. For more information on the IM command, see the CAD User Manual.

To send an instant message to multiple recipients:

1. In the IM pane, hold down the Ctrl key, and then click each recipient. To select a range of recipients, hold down the Shift key, and then click the first and last recipient in the range.

2. Right-click the recipients, and then select Send Instant Message.
The IM window opens and a temporary group is created.

The temporary group ID is displayed in the window header for every member of the group. A temporary group always starts with the word GRP, followed by a number. The numbers ascend according to the order in which the group is created. For example, the first temporary group in a Mobile session is GRP1.

3. In the **Message Entry** area, compose your message.

4. Click **Send**, or press Enter.

Your instant message is sent and appears in the **Message Log** pane.

**NOTE**

Instant messages are logged and can be reviewed by administrators. Only active users can receive instant messages.

**Receiving instant messages**

Depending on your settings, when a message is received, one or more of the following occurs:

- A minimized Instant Message window flashes in the task bar.
- The Instant Message window is brought to the front of the screen.
- A sound notification is emitted.
To read the message, in Instant Messenger, scroll as needed to view the message.

**Replying to an instant message**

To reply to a message:

1. Bring the Instant Message window to the front of the screen.
2. In the **Message Entry** area, compose your reply.
3. Click **Send**.
Working with Alerts

Alerts bring important messages to the attention of the officer. The following alerts are used in the Message Center:

- **Attempt To Locate (ATL) and Be On The Lookout (BOLO).** Used to notify officers in the field to watch for a suspect, victim, suspicious person, or vehicle that might have been involved in recent or ongoing criminal activity. For more information, see “Sending an alert (ATL or BOLO)” on page 57.

- **Emergency.** Used to notify other Mobile and Message Center users in the agency that the person sending the alert is in an emergency situation and needs assistance. For more information, see “Sending an Emergency alert” on page 59.

- **StateLink.** Used to notify officers and dispatchers if a state return contains important information, especially for safety and situational awareness. For more information, see “Using StateLink alerts” on page 61.

Sending an alert (ATL or BOLO)

Privileges are required to send an alert (ATL or BOLO).

To send an alert (ATL or BOLO):

1. With the Message Center open, do one of the following:
   - From the menu bar, select **Actions > New Alert** (Alt+A, A).
   - In the **Messages** pane, select the **Alerts** folder, and then click **New Alert** from the Messages toolbar.

   The Alert - ATL - Attempt To Locate window opens, and the Select Names dialog box opens.

2. Select a group from the **User Names** list area, and then click **Add**. Multiple groups can be added, if desired.

3. Click **OK**.

   The Select Names dialog box closes, and the selected group is listed in the **To** field of the Alert - ATL - Attempt To Locate window.

NOTE

Alerts are sent to all individuals with Super User privileges, even if they are not part of the selected group. Super Users not in the selected group receive the alert in message format, and by the alert message that scrolls across the Status bar. The Alert does not appear on their screen.
4. To change the alert type to BOLO, in the Type field, select BOLO - Be On the Look Out from the drop-down list.

5. In the Expires field, select an expiration time from the drop-down list.

TIP
Remember to expire the alert if the situation is resolved before the specified expiration time. For more information, see “Expiring an alert” on page 61.

6. In the Message area, enter the desired subject and message text.

7. If time permits, do one of the following to check the spelling in the message text:
   - Select Edit > Spelling (Alt+E, S).
   - Click the Spelling icon. See “Using the spelling checker” on page 43.

8. Click Send or press Enter.

   A message is received in the Alerts folder of each group member, and an alert notification scrolls across the Status bar. If a group member is offline, then if the alert is still active, the notification scrolls across the Status bar the next time the group member opens Mobile. For online group members, an Alert window similar to the following opens.
Sending an Emergency alert

An Emergency alert can be sent to notify Mobile users when someone in their agency is in an emergency situation and needs assistance.

To send an Emergency alert, do one of the following:

- From the menu bar in the Message Center, select **Actions > Emergency Alert**.

**NOTE**
The Actions menu is available only from the Message Center screen.

- If your agency uses the Automatic Vehicle Location (AVL) module with the Motorola Unified Network Service interface, then press the emergency button on your Motorola GPS device. For more information, see the *Automatic Vehicle Location (AVL) Manual*.

If desired, the **Emergency Alert** button can be added to your toolbar. For more information, see “Using the Commands tab” on page 266.

Understanding Emergency alerts

When an Emergency alert is sent, a message is received in the **Alerts** folder, and an alert notification scrolls across the Status bar. For Mobile users that are offline at the time of the alert, if the alert is still active the next time Mobile is opened, then the alert notification scrolls across the Status bar.
For online Mobile users, an Alert window similar to the following opens.

To view the current Call record for the officer who sent the Emergency alert, from either the message or the alert pop-up notification, click the **Assigned Call** link. If the officer sending the Emergency alert is not assigned to a call, then the **Assigned Call** link is not displayed.

If your agency uses the AVL module, then click the **Locate on Map** link to view and center the alerted unit or device on the map. If the officer sending the Emergency alert does not have AVL, then the **Locate on Map** link is not displayed.

The viewable distance from the center point of the map (the unit’s location) is determined by the Emergency Alert Map Zoom option. For more information, see “Setting the Emergency Alert Map Zoom settings” on page 302.

**Modifying an alert**

Alerts (Emergency, BOLO, or ATL) can be modified after they are sent.

To modify the text of an alert after it is sent:

1. From the Message Center, in the **Messages** pane, select the **Alerts** folder.
2. In the **Message Header** area, select the alert to modify.
3. From the Messages toolbar, click **Modify**.
4. Modify the alert text as needed.
5. Click **Send**, or press Ctrl+Enter.

Mobile sends a new alert and expires the original alert.
## Expiring an alert

If an alert situation (Emergency, BOLO, or ATL) is resolved prior to the expiration time, then the alert can be expired manually.

### CAUTION

Expanding an alert removes the alert for all users. Do not dismiss the alert before verifying the alert situation is resolved.

To expire an alert:

1. From the Message Center, in the **Messages** pane, select the **Alerts** folder.
2. In the **Messages** pane, select the **Alerts** folder.
3. In the **Message Header** area, select the alert to expire.
4. Do one of the following:
   - From the Messages toolbar, click the **Expire** button.
   - In the **Message Header** area, right-click the alert, and then select **Expire Alert**.
   - From the menu bar, select **Actions > Expire Alert**.

The alert is expired and removed from the **Message Header** area and Status bar.

## Using StateLink alerts

When a StateLink return is received in Message Center, if the return has an alert associated with it, then the message header is displayed in red with a High Priority indicator. If the return has multiple StateLink alerts associated with it, then the subject line displays the alert with the highest priority and a plus sign (+) with the total number of additional alerts, such as +2. Your SAA determines the priority level of the alerts.

[Image: StateLink alert message header and plus sign (+) indicating multiple alerts]
Depending on the settings for your agency and the requirements for your state, a StateLink return message with an alert can be automatically forwarded to a group, which can consist of users, printers, terminals, other groups, or a combination thereof. Your SAA determines who or what receives forwarded returns with StateLink alerts. For more information, see the StateLink manual.

StateLink alerts also affect Voiceless CAD. For more information, see “Understanding StateLink alerts in the CAD screen” on page 204.
Using Workflow Management

The Workflow Approval Management feature is used to track and update the status of Workflow records. From the Message Center, the contents of the record can be viewed, the record status updated, or the record can be opened.

When a Workflow record is received, in the Mobile Today screen, the number of new (unread) records listed in the Approvals link is updated. The Workflow record is sent to the Approvals folder in the Message Center.

The subject lines for workflow notifications allow your agency to determine what information is displayed. This feature affects Law, Fire, and EMS Incident records, as well as Case Management records.

Depending on the settings established by your SAA, the subject line displays one of the following as additional information at the beginning of the subject line:

- **Nature**: Displays the incident nature.
- **Offense/Condition**: Displays the description of the offense (for Law incidents) or condition (for Fire and EMS incidents).
- **Observed**: Displays the description of the offense (for Law incidents) or condition (for Fire and EMS incidents) as it was observed.
- **None**: Displays no additional information.
Regardless of the additional information displayed, the subject line also displays the table description, the record number, and the approval status.

To open a record, from the Approvals folder, from the Messages toolbar, click the Open in Spillman button. To use this feature, Flex must be actively running on your computer.

When a Workflow record is assigned to your workflow, it is received in the Approvals folder.

The Approvals folder contains the following sub-folders:

- **Group.** Contains records assigned to your group. Select records according to your agency’s workflow process. Always follow department policy when updating records that are in the Group folder. If a record assignment is changed from the group to an individual user, then it is moved from the Group folder to the Approvals folder for the user.

- **Supervisor.** Contains records assigned to the Workflow record supervisor.
Working with Workflow records

If your SAA has enabled the Workflow Approval Management feature for a record type, then the Approval button is displayed at the bottom of the screen for that record in Mobile.

To view the approval history for a record, in the Approval History area, click the plus sign. The most recent status is displayed first.

To create or update a Workflow record:

1. In the Messages pane, select the Approval folder.

2. From the Message Header area, select the desired message, and then click the Number link.

   The selected record type opens in Mobile.

3. Review the data for accuracy.

   – If data is accurate, or changes are not allowed by your state, then continue to step 6.

   – If data is inaccurate, and changes are allowed by your state, then continue to step 4.

4. If the record needs to be updated, then do one of the following:

   – For Crash and Citation records, to open the form, in the Files area, click the plus sign, and then double-click the .afr link.
The form opens in Review mode. For more information on editing Crash and Citation records, see the State eCitation and State Crash Forms Manual.

NOTE
To open the form in Review mode directly from the Approval folder, click the .afr link for the form.

- For Law Incident records, to open the form, click the Edit button. For more information on editing Law Incident records, see the Mobile Field Report and Field Interview Manual.

5. Once the changes are completed and submitted to the database, return to the open record, and then click the Refresh Data button.

6. To update the record status, click the Approval button. The Update Status dialog box opens.

In the Current Status area, in the Status field, the first status assigned to the record type is displayed. In the New Status area, in the Status field, the next possible status for the record is displayed.

NOTE
If the record already has a Workflow record associated with it, then the next appropriate status for the record is displayed in the New Status area.
7. In the **New Status** area, in the **Assigned Individual** field, select the individual who will complete the next step in the workflow process.

8. Complete the remaining fields according to your agency’s workflow process, and then click **OK**. For field descriptions, see “Fields in the Update Status dialog box” on page 67.

   The Workflow record is created or updated, and the responsible parties are notified. The record is removed from your **Approvals** folder.

---

**Fields in the Update Status dialog box**

The following describes the fields in the Update Status dialog box.

---

**Assigned Individual**

In the **Current Status** area, the individual currently assigned to the record is displayed. In the **New Status** area, if necessary, select a new assigned individual from the drop-down list.

---

**Assigned Group**

In the **Current Status** area, the group currently assigned to the record is displayed. In the **New Status** area, if necessary, select a new assigned group from the drop-down list.

---

**Status**

In the **Current Status** area, the current workflow status of the record is displayed. In the **New Status** area, if necessary, select a new status for the record from the drop-down list.

---

**NOTE**

The options available in the **Status** field vary according to agency. For questions regarding which status to choose for your record, contact your SAA.

---

**Responsible**

In the **Current Status** area, the officer responsible for the record is displayed. In the **New Status** area, if necessary, select a new responsible officer for the record from the drop-down list.

---

**Supervisor**

In the **Current Status** area, the supervisor assigned to the record is displayed. In the **New Status** area, if necessary, select a new supervisor from the drop-down list.
In the **New Status** area, enter any additional comments regarding the status of the record. The comments display in the **Message** column of the Workflow record.

**Using the Group Filter feature**

Using the Group Filter feature, workflow approval messages can be filtered by group.

The Group Filter feature is available only to users who are members of multiple system groups, and when a user has active messages assigned to multiple groups.

To use the filter, from the Messages toolbar, in the **Group Filter** field, select the group by which to filter results. In the **Message Header** area, only the messages for the selected group are shown.
Working with automatically generated Workflow records

Your SAA can set Law Incident clearance codes to automatically generate Workflow records.

When a user closes a CAD call with a designated clearance code, then a Workflow record is generated for the responsible officer. The record is sent to the Approvals folder of the officer assigned to the call.

The record contains a message similar to the following:

You have been assigned Law record (0202-0037).
The current status of the record is: INPUT
Please update the record and status using the buttons above at your earliest convenience.

Updating an automatically generated Workflow record

To update an automatically generated record:

1. In the Messages pane, select the Approvals folder.
2. In the Message Header area, select the desired record, and then click the Update Approval button.
   
   The Update Status dialog box opens. In the Current Status area, in the Status field, the first status assigned to the record type is displayed.

3. In the New Status area, complete the appropriate information fields. For field descriptions, see “Fields in the Update Status dialog box” on page 67.
4. Click OK.

   The Workflow record is updated and the responsible parties are notified. The record is removed from your Approvals folder.

Updating multiple automatically generated Workflow records

To update multiple automatically generated records:

1. In the Messages pane, select the Approvals folder.
2. In the Message Header area, select the desired records, and then click the Update Multiple Approvals button.
The Update Status dialog box opens.

3. In the **Record Type** field, select the type of record to update from the drop-down list.

4. In the **Records** list area, select the records to update using the following commands:
   - To select a group of individual returns, press Ctrl and click each desired return.
   - To select a series of returns, press Shift and click the first and last returns in the desired series.
   - To select all returns, press Ctrl+A.

5. In the **New Status** area, complete the appropriate fields. For field descriptions, see “Fields in the Update Status dialog box” on page 67.

6. Click **OK**.

The Workflow records are updated and the responsible parties are notified. The records are removed from your **Approvals** folder.
Chapter 3

Queries, Returns, and Records

Introduction 72
Performing Queries 74
Working with Returns 83
Importing Information from a State Return 91
Importing Information from an InSight Return 102
Using the Record Screens 104
Understanding Warning and Alert Flags 115
Working with Narratives and Supplemental Narratives 120
Working with File Attachments 123
Adding Name, Vehicle, or Property Records 128
Validating a New Record 174
Queries for information on suspects, vehicles, property, and other categories can be performed in Mobile. The types of queries that can be performed depend on the modules purchased:

- **Mobile Local RMS Queries.** Used to query your agency’s local RMS database. Some kinds of searches require other optional modules. For example, if your agency has installed the Premises Information module, and uses the CAMEO database, then information about thousands of different chemicals and hazardous materials can be searched.

- **Mobile State and National Queries.** Used to query state and national databases.

- **InSight.** Used to query Spillman and non-Spillman databases that are shared on an InSight broker server.

Query screens are designed for easy reading and data entry, and contain only the fields most often searched by Mobile users. Name, vehicle, property, law, and premises queries have advanced search options available.

The kinds of queries Mobile can perform also depend on the data provided. For example, in a name query, at least a birth date and a partial last name must be entered to query the NCIC Wanted Persons database. In addition, a sex and race must be entered to extend the query to the Person Multi-Query, Criminal History, NCIC Criminal History, and Juvenile Criminal History databases.

Responses to queries are received as returns. Returns from state and national queries and InSight queries can be used to create new records in your local database.

Local returns are displayed in the Search Results screen, and all returns are delivered to the Message Center.

The Message Center contains the following return folders:

- **Local Returns.** Contains results from your local database.

- **State Returns.** Contains state and federal returns.

- **Insight Returns.** Contains results from your InSight server.
**Understanding the Mobile search screens**

The following table lists the main categories for which queries can be performed in Mobile. The queries available depend on the modules your agency has purchased. To access these screens, from the menu bar, select **Search > Table**, where *Table* is the name of the table to search, or use the keyboard shortcut command for the desired search.

<table>
<thead>
<tr>
<th>Category name</th>
<th>Shortcut</th>
<th>Required module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names</td>
<td>Alt+S, N</td>
<td>Local RMS Queries</td>
</tr>
<tr>
<td></td>
<td>F2</td>
<td></td>
</tr>
<tr>
<td>Vehicle</td>
<td>Alt+S, V</td>
<td>Local RMS Queries</td>
</tr>
<tr>
<td></td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Alt+S, P</td>
<td>Local RMS Queries</td>
</tr>
<tr>
<td></td>
<td>F4</td>
<td></td>
</tr>
<tr>
<td>Law</td>
<td>Alt+S, L</td>
<td>Local RMS Queries</td>
</tr>
<tr>
<td></td>
<td>F7</td>
<td></td>
</tr>
<tr>
<td>Gun</td>
<td>Alt+S, G</td>
<td>State and National Queries</td>
</tr>
<tr>
<td></td>
<td>Ctrl+G</td>
<td></td>
</tr>
<tr>
<td>Boat</td>
<td>Alt+S, B</td>
<td>Local RMS Queries</td>
</tr>
<tr>
<td>Offender Tracking</td>
<td>Alt+S, O</td>
<td>Offender Tracking</td>
</tr>
<tr>
<td>Premises</td>
<td>Alt+S, E</td>
<td>Premises Information</td>
</tr>
<tr>
<td></td>
<td>F11</td>
<td></td>
</tr>
<tr>
<td>HAZMAT</td>
<td>Alt+S, Z</td>
<td>Premises Information</td>
</tr>
<tr>
<td></td>
<td>F12</td>
<td></td>
</tr>
</tbody>
</table>

Any query that can be performed in Flex can also be performed in Mobile. To see additional Search screens, from the menu bar, select **Search > Other Local Searches > Table**, where *Table* is the name of the table to search.
Performing Queries

The Mobile Local RMS Queries and Mobile State and National Queries modules must be installed to send both RMS (local) and state queries. If your agency has both modules, then queries can be sent to your state's database, your agency's database, or both. If your agency has the State and National Queries module, then queries to national databases are submitted at the same time as queries to state databases. For each state query performed, a radio log entry is added to the Radio Log table in your agency’s database.

To perform a query:

1. Do one of the following:
   – To search your local database, and for state searches available from the Mobile Search screens, do one of the following:
     – From the menu bar, select Search, and then select the option for the desired Search screen. See “Understanding the Mobile search screens” on page 73.
     – From the main toolbar, click Search (Ctrl+J). From the Search screen toolbar, click the button for the desired search. For example, the Vehicle button.
     – To search a StateLink screen, from the menu bar, select Search > StateLink Searches, select the type of search, and then the specific search to run.

     The selected Search screen opens.

2. Enter the search criteria. To perform a state query in addition to a local query from a Mobile Search screen, select any return check boxes as appropriate for your agency, such as the Driver License check box.

3. Click Search, or press Enter.
The search status results are displayed. If search results were returned immediately, then a **Matches found** link is displayed next to the query sent.

4. Click a **Matches found** link to view local search results in the Message Center.
The search results are displayed in the Message Center.

**NOTE**
Depending on your agency settings, queries that match a single record automatically open that record in Flex. However, this feature works only if Mobile is used with Flex. For more information, see “Viewing a record in Flex” on page 84.

5. Depending on the search results, do one of the following:
   - If the desired record is displayed, then open it. See “Working with Returns” on page 83.
   - If no local records match the search criteria, or if the desired record is not displayed, then verify whether the record is in your state returns. See “Working with Returns” on page 83.
   - If no local or state records match the search criteria, or if the desired record is not displayed, then click the Create New button
Performing Queries and create a new record. See “Adding Name, Vehicle, or Property Records” on page 128.

**NOTE**

For local returns, records that have certain alerts or warning flags associated with them appear at the top of the list. Other records are listed according to the record number. For more information on alert flags, see “Understanding Warning and Alert Flags” on page 115.

---

**Using wildcard characters**

Use wildcard characters to represent one or more unknown characters. In Mobile, the wildcard characters are the question mark (?), asterisk (*), and brackets ([ ]). Wildcard characters can be used in most fields, with the exception of time-date fields, dollar amount fields, and record number fields. A question mark (?) can be used only in fields that contain masked information, such as a phone number field or a Social Security number field. For more information on using wildcard characters, see the RMS User Manual.

Only local queries to your database support the use of wildcard characters. For queries performed using the State and National Queries module, most states do not allow the use of wildcard characters.

---

**Entering state passwords**

Depending on the requirements of your state, a password might be required to submit a state query.

If your state requires a password, then it must be entered before performing any state queries. The password is retained until the Mobile session is ended.

To enter your state password:

1. Do one of the following:
   - From the Search screen, enter your search criteria, select the desired state return check boxes, and then click Search.
   - From the menu bar, select Tools > State Database Login.
Performing Queries

The User Login dialog box opens.

2. In the **Password** field, enter your state password, and then click **OK**.

**NOTE**

If the password entered does not match the length requirements set by your state, then a message box opens, stating so. Click **OK** to close the message box, and then enter your password again.

The password is sent to the state, the dialog box closes, and one of the following occurs:

- If the password is correct, then the state sends a message to the Message Center stating the login was accepted.
- If the password is incorrect, then the state sends a message to the Message Center stating so. Repeat steps 1–2 to re-enter your password.

**Changing your state password**

The password for the state database can be changed if necessary.

To change your state password:

1. Select **Tools > State Database Login**.
   
The User Login dialog box opens.

2. Click the **Change Password** button.
Performing Queries

The Change Password dialog box opens.

3. Complete the following fields:
   - **Old Password**: Enter your current password.
   - **New Password**: Enter your new password.
   - **Confirm New Password**: Enter your new password again.

4. Click **OK** to accept your new password and close the dialog box.

The change password request is sent to the state. Continue to use your old password until your new password is confirmed by the state.

**NOTE**
If the passwords entered in the **New Password** and **Confirm Password** fields do not match, then the change is not sent to the state, and a message appears in the Change Password dialog box stating that the passwords do not match. Enter your new state password in both fields again.

**Sending InSight queries**

If your agency has the InSight module, and the necessary privileges have been given, then a single query can be performed from the Name, Property, or Vehicle Search screen to receive responses from Spillman and non-Spillman databases whose information is shared on a broker server. Using InSight, specific agencies or groups of agencies established by your SAA can be
queried, and information including demographics, images, alert codes, and involvements (links between records) is received. For more information, see the InSight Manual.

To send an InSight query:

1. Click Search.
2. Click Names (F2), Vehicle (F3), or Property (F4).
   The selected Search screen opens.
3. Enter your search criteria.

   **TIP**
   To display additional fields for searching, click More advanced search options.

4. Select the InSight check box, located on the right side of the Search screen.
   The Default Sites and Choose Sites options appear.
5. Do one of the following:
   - To query default agencies and groups, select Default Sites.
   - To query specific agencies and groups, select Choose Sites.
6. Click Search.
   - If querying specific agencies and groups, then the InSight search options are displayed. Select the agencies and groups to query, and then click OK.

The query is sent and the InSight returns are received in the InSight Returns folder in the Message Center. In the Today Center, the number of new or unread InSight returns is displayed.

   **NOTE**
   If prompted to log in to InSight, enter your InSight password in the Password field that appears on the Search screen, and then click OK.

**Searching for hazardous materials**

If your agency uses the Premises module, then to view hazardous chemical information, use the CAMEO® Chemicals Database developed by the Environmental Protection Agency (EPA) and the National Oceanic and
Atmospheric Administration (NOAA). The database is available as both a website and a desktop application. Information about hazardous materials can also be stored in Premises records.

The website for CAMEO is https://cameochemicals.noaa.gov, and is the default application used to perform searches for hazardous materials. To use this website, an Internet connection is required. If your agency has purchased and licensed the CAMEO database, then your SAA can download the desktop application for offline use. Contact your SAA for more information.

To search for hazardous materials:

1. Select **Search > Hazmat** (Alt+S, Z), or press F12.
   
The CAMEO Chemicals Search screen opens.

2. Enter your search criteria. The **Name**, **CAS Number**, or **UN/NA Number** fields can be searched. For assistance searching, click the **How does this search work?** hyperlink.

   **NOTE**
   
The **Name** field can contain a large amount of information. To make it easier to search for hazardous materials, the asterisk (*) wildcard character is added to the front and back of search criteria in the **Name** field. For example, a search for lithium in the **Name** field appears as *lithium*.

3. Click the **Search** button, or press Enter.
Performing Queries

The CAMEO Chemicals search results are displayed.

4. To view a HAZMAT record, click the record hyperlink.

The selected record is displayed.

Viewing hazardous material information

The Hazardous Material screen displays information that can help Law, Fire, and EMS personnel identify and safely handle hazardous material. The information includes a description of the possible health hazards, recommendations for protective clothing, fire-fighting techniques, and first-aid procedures. For help understanding the information on the screen, click the **What is this information?** hyperlink in each section.
Working with Returns

The way returns are received depends on the type of query submitted. This section describes the following:

- “Viewing RMS returns” on page 83
- “Viewing State and InSight returns” on page 85
- “Using the Message Center with returns” on page 86

Viewing RMS returns

RMS (local) returns appear as a list in the Search Results screen. Records that have certain alerts or warning flags associated with them appear at the top of the list. Other records are listed according to the record number. For more information on alert flags, see “Understanding Warning and Alert Flags” on page 115.

To print the list of results, right-click anywhere in the list, and then select Print from the shortcut menu.

View a record in Mobile

To view a record in Mobile, do one of the following:

- Double-click the desired record to view. Use the scroll bar to view any records in the list that do not fit in the window.
Use the Up Arrow or Down Arrow key to highlight the desired record, and then press Enter. To navigate to the beginning of the list, press the Home key. To navigate to the end of the list, press the End key.

The selected record opens.

The information displayed depends on the record type. For more information, see “Using the Record Screens” on page 104.

**Viewing a record in Flex**

Local returns for Name and Vehicle records can be opened in Flex when the software is used to open Mobile. When returns are listed, the **Open** button is displayed next to the return. For more information, see “Logging In to Mobile” on page 20.
To view a local return in Flex, click the **Open** button next to the record.

Depending on the settings established by your SAA, if a local query produces a single search result, then the record automatically opens in Flex. Contact your SAA for more information.

**Viewing State and InSight returns**

Responses to federal queries are included in state returns. The specific format of a state or federal query return is different for every state. In some states, returns are a continuous block of text. In other states, returns are formatted into paragraphs and certain fields (such as alerts, date of birth, and expired license information) are highlighted with different fonts or colors. Some states include driver license photographs that are displayed in the message.

When a state or federal query produces more than one record, some states send a separate return for every record and others provide a list return.

InSight query responses are formatted as list returns. Depending on how your SAA sets up Mobile, the InSight returns might include agency contact information. Use the agency contact information to contact agencies if additional information for a specific return is needed. If your SAA sets up agency contact information, then it is displayed in the **Agency Contact Details** area of the return.
Using the Message Center with returns

The Message Center contains folders for each return type, including the Local Returns folder, the Insight Returns folder, and the State Returns folder.

With returns, do any of the following:

- “Printing returns” on page 87
- “Forwarding returns” on page 88
- “Adding state returns to a CAD call” on page 89

To select multiple returns, the following standard Windows functions can be used:

- To select a group of individual returns, hold down the Ctrl key and click each desired return.
- To select a series of returns, hold down the Shift key and click the first and last returns in the desired series.
- To select all returns, press Ctrl+A.

Using the History folder

By default, state and InSight returns are moved to the History folder after they are viewed, unless they are saved or deleted.

When a return is saved, it is moved into the Saved folder and kept indefinitely. To save a return, in the Message Heading area, select the returns to save, and then, from the Messages toolbar, click the Save button.

Your SAA can set up Mobile to move state and InSight returns to the History folder only after viewing the return and leaving Message Center. For more information, see “Setting Message Center Options” on page 307.
The **History** folder is emptied when Mobile is exited. However, the returns can be retrieved for up to 48 hours. After 48 hours, the returns are permanently deleted. If a return is deleted, then it cannot be retrieved.

### Retrieving returns

To retrieve returns:

1. Right-click the **History** folder.
2. Select **Get Additional “History” Items**.
3. Select the time frame for the additional history items to retrieve.

   The returns appear in the **History** folder.

### Permanently deleting returns

To permanently delete all returns from the **History** folder, right-click the **History** folder and then select **Delete All “History” Items**.

To choose which returns to permanently delete, from the **History** folder, select the returns, and then do one of the following:

- Press Delete.
- From the Messages toolbar, click **Delete**.
- From the menu bar, select **Edit > Delete** (Alt+E, D).

### Printing returns

Returns can be printed from any of the return folders.

To print returns:

1. In the Message Center, in the **Messages** pane, select the desired return folder. If necessary, do one of the following:
   - For returns viewed in the last 48 hours that were not saved or deleted, select the **History** folder. If the desired return is not visible, then retrieve it. See “Retrieving returns” on page 87.
   - For saved returns, select the **Saved** folder.
2. In the **Message Header** area, select the returns to be printed.
Working with Returns

3. Click **Print** to open the Print dialog box.

4. Configure your printer settings, and then click **Print**.

All of the selected returns are sent to the printer at once, but each return is printed on a separate sheet of paper as its own print job.

**Forwarding returns**

Returns from any return folder can be forwarded to specified users or groups.

To forward returns:

1. In the Message Center, from the **Messages** pane, select the desired return folder. If necessary, do one of the following:
   - For returns viewed in the last 48 hours that were not saved or deleted, select the **History** folder. If the desired return is not visible, then retrieve it. See “Retrieving returns” on page 87.
   - For saved returns, select the **Saved** folder.

2. In the **Message Header** area, select the returns to be forwarded.
3. Click the **Forward** button to open the Select Names dialog box.

![Forward button](image)

4. Select the desired recipients, and then click **OK**. For more information, see “Forwarding a message” on page 46.

The returns are forwarded to the selected recipients.

**Adding state returns to a CAD call**

State returns can be added to a CAD call. Local and InSight returns cannot be added to a CAD call.

To add state returns to a CAD call:

1. In the Message Center, from the **Messages** pane, select the **State Returns** folder. If necessary, do one of the following:
   - For returns viewed in the last 48 hours that were not saved or deleted, select the **History** folder. If the desired return is not visible, then retrieve it. See “Retrieving returns” on page 87.
– For saved returns, select the **Saved** folder.

2. From the **Message Header** area, select the returns to add.

3. Click the **Add to Call** button to open the Select Call window.

4. Select the call to which the returns will be added. Returns can be added to open or closed calls.

   – To show an additional eight hours of call history, click the **Show More** button. The **Show More** button can be clicked until a week of calls is displayed.

   – If the desired call is not on the list, then click **Enter ID** to manually enter the long-term call ID.

5. Click **OK**.

The selected state returns are added to the call.
Importing Information from a State Return

If the necessary privileges have been given, then data from state returns can be imported to the database to create a new Name or Vehicle record. If the software can determine how the data from the return matches the fields in the software, then the fields for the new record are completed automatically when the record is imported.

If the software cannot read the return, such as when the return is not from your state, then the appropriate record type must be selected and the information copied and pasted into the correct fields. For more information, see “Separating records to import to the database” on page 99.

To import information from a state return:

1. From the Message Center, click the State Returns folder.
2. Select the state return to import.
3. Click the Import to Spillman button.

One of the following occurs:

- If the software cannot read the record, then see “Separating records to import to the database” on page 99.
- If the software can read the record, and the record contains information for only one record type, then the Add Record screen opens for the record type.
- If the software can read the record, but the record contains return information for both names and vehicles, then a dialog box opens, prompting for verification of which information to import. Select
the desired record type. The Add Record screen opens for the record type.

Fields are automatically populated with data from the state return. Fields that contain values not found in the drop-down list are outlined in red. Fields with warnings are outlined in yellow. To view messages for the outlined fields, rest the mouse pointer over each field.

**NOTE**

If a value is not found in a field drop-down list, then a translation for that value should be added to the database. See your SAA for assistance.

4. Verify that the imported data is correct.

5. Complete the remaining fields. For field descriptions of each record type, see the following sections:
   - “Completing the Add Name Record screen” on page 129
   - “Completing the Add Vehicle Record screen” on page 149.

6. If importing a Vehicle record, then link the vehicle owner. See “Linking the vehicle owner” on page 93.
7. When finished, click **Save**.

[NOTE]
If your agency maintains a geobase, and the address has not yet been validated, then the Address Selection window opens. Select the correct address, and then click **Select**. Otherwise, click **Don't Validate** to continue without validating the address.

A new record is created using the imported information.

**Linking the vehicle owner**

When importing a state return for a Vehicle record, the software helps associate the owner of the vehicle in the **Owner** tab of the Add Vehicle Record screen, and searches the database for a Name record that could potentially be the owner.

Using data from the state return, the software searches the database for a Name record with matching data in the following fields:

- Social Security Number
- Driver License Number
- Date of Birth
- Address
- Name
The record with the closest matching data is displayed in the **Owner** tab, in the **Is this the owner?** area.

Data in the suggested record that matches data in the state return is highlighted for quick comparison. To open the Name record in Mobile and verify owner information, click the **View Names Record** link.

**NOTE**

The suggestions displayed depend on the amount of information in the state return. Suggested owners are not guaranteed matches to the vehicle. Suggestions must be reviewed carefully before confirming an owner.

Use the following table to determine how to link the vehicle owner to the Vehicle record, based on whether the software is able to find a potential candidate.

<table>
<thead>
<tr>
<th>If the software</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finds a potential candidate with matching data</td>
<td>Link the Name record to the <strong>Owner</strong> tab. See “Confirming the vehicle owner” on page 95.</td>
</tr>
<tr>
<td>Finds a potential candidate that might be correct</td>
<td>Click the <strong>View Name record</strong> link to view more record details.</td>
</tr>
</tbody>
</table>
Importing Information from a State Return

### Confirming the vehicle owner

If the suggested record belongs to the owner, then in the **Is this the owner?** area, click the **Confirm Owner** button to link the Name record to the Vehicle record.

### Searching for another Name record

To search for another Name record:

1. From the **Owner** tab, do one of the following:
   - If a match is found, but is incorrect or inaccurate, then click the **Search More** link.

<table>
<thead>
<tr>
<th>If the software</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finds a potential candidate that is not correct</td>
<td>Search again. See “Searching for another Name record” on page 95.</td>
</tr>
<tr>
<td>Does not find any potential candidates</td>
<td>Search for a matching Name record (see “Searching for another Name record” on page 95), or create a new Name record using the state return information (see “Importing owner information” on page 97).</td>
</tr>
</tbody>
</table>
– If no matches are found, then click the **Search for the Owner** link.

The Name Search screen opens with details from the state return in the search fields.

2. If necessary, remove details from the fields to expand the search.

3. Click **Search**.

   All matching records are displayed on the screen.

4. Do one of the following:
   – If a match is found, then double-click the record to view it, and continue to step 5.
   – If no matches are found, then the information from the state return can be imported to create a new record in the database. See “Importing owner information” on page 97.

5. Return to the Add Vehicle Record screen.

6. Click the **Select** button, located next to the **Owner ID** field.
A list of Name records that were recently opened in Mobile appears, with the most recently viewed records at the top.

7. Select the desired Name record from the list.

Information for the selected Name record is added to the Owner tab.

**Importing owner information**

After searching for records, if a match is not found, or if the suggested record is not a match, then owner information from the Vehicle return can be imported to the database to create a new Name record.
To import owner information:

1. From the Owner tab, in the Owner from the vehicle return area, click the Import to Spillman button.
The Add Name Record screen opens. Details from the state return are automatically populated in the matching fields.

2. Verify that the imported data is correct.

3. Complete additional fields as needed. For field descriptions, see “Completing the Add Name Record screen” on page 129.

4. When finished, click Save.

The new Name record is validated and added to the Owner tab. See “Validating a new Name record” on page 174.

**Separating records to import to the database**

If a StateLink return is not readable by the system, and cannot be imported to the Add Record screen, then the information must be copied and pasted into the appropriate fields for the selected record type.
To separate records to import to the database:

1. From the Message Center, click the **Import to Spillman** button.

The Unable to parse StateLink return prompt box opens.

2. Do one of the following:
   - To add a new Name record, click **Import Name Record**.
   - To add a new Vehicle record, click **Import Vehicle Record**.
   - To cancel the action, click **Cancel**.
The Add Record screen for the record type opens. The screen is split into two frames: the StateLink Return pane on the left, and the Add Record tabs on the right. The split allows data to be easily viewed and transferred between frames.

By default, information in the StateLink Return pane is displayed in plain text. The text is selectable, but not editable.

To view the information with the word wrap function, so that all the information is displayed in the window without scrolling across the pane, click the Word Wrap link.

3. Copy (Ctrl+C) and paste (Ctrl+V) information from the StateLink Return pane to the fields of each Add Record tab, as necessary.

4. When finished, click Save.

The software runs an advanced search to validate the record against existing records to avoid duplicates. See “Validating a New Record” on page 174.
Importing Information from an InSight Return

If the necessary privileges have been given, then the data from InSight returns can be imported to the database to create a new Name, Vehicle, or Property record.

To import information from an InSight return:

1. From the Message Center, click the InSight Returns folder.
2. Select the InSight return to import.
3. Click the Import to Spillman button.

   The Add Record screen opens for the record type.

   ![Import to Spillman button]

   **NOTE**

   Fields are automatically populated with the data from the InSight return. Fields with warnings are outlined in yellow. To view messages for outlined fields, rest the mouse pointer over each field. Images cannot be imported from InSight returns.

4. Verify that the imported data is correct.
5. Complete any remaining fields. For Vehicle and Property records, InSight returns do not include owner information. Instead, the agency or officer that reported the item is referenced. Enter the owner information into the record, if available. For field descriptions of each record type, see “Adding Name, Vehicle, or Property Records” on page 128.

6. When finished, click Save.

NOTE

If your agency maintains a geobase, and the address has not yet been validated, then the Address Selection window opens. Select the correct address, and then click Select. Otherwise, click Don't Validate to continue without validating the address.

A new record is created using the imported information.
Using the Record Screens

Each record is divided into areas to list any involvements, alerts, images, files, or other important information connected to that record.

The areas on each Record screen depend on the type of record and the information attached. However, most records contain the following:

- **Record number.** Each record is assigned a record number, which can be used in the Search screens to search for the record.

- **Record heading.** Each record screen has a record heading. The information in the record heading varies by record type. For example:
  - Name records contain the name of the individual or business.
  - Vehicle records contain the color, year, make, model, and state of the vehicle.
  - Property records contain the color, type, brand, model, and estimated value of the property.
  - Law Incident records contain the nature of the incident.
  - Premises records contain the name of the premises.

- **Images area.** Displays a thumbnail image, if an image is attached. To view attached images, click the link for the image file. To return to the original record, click the Back button (Alt+Left Arrow). Image files must be managed from the record in Flex.
- **Involvements area.** Contains links to involvements for the current record. Expand the Involvements area to view the list of involvements. To filter involvements by type, click the link above the involvement list for the record type.

If there are more involvements connected to the record than fit on the expanded list, then use the Next and Prev links to navigate through the full list. To return to the original record from the full involvement list, click the Back button (Alt+Left Arrow).

To view the involved record, double-click the detail record.

- **Files area.** Contains links to files attached to the record. To view a file, double-click the detail record.

If there are more files attached to the record than fit on the expanded list, then click the Next and Prev links to navigate through the full list. To return to the original record, click the Back button (Alt+Left Arrow).

- **Manage Files button.** Opens the File Capture window. For more information, see “Managing file attachments” on page 124.

- **Refresh Data button.** Refreshes the screen to show any changes made to the record in Flex since opening the record in Mobile.

The following sections describe some of the most commonly used Record screens:

- “Using the Name screen” on page 106
- “Using the Vehicle screen” on page 108
- “Using the Property screen” on page 109
- “Using the Law Incident screen” on page 111
- “Using the Premises screen” on page 112
Using the Name screen

The Name screen provides information about individuals or businesses in your local database.

Depending on the information in your database, the Name screen might contain the following areas. This list is not all-inclusive. The information available depends on your record type and data available:

- **Name Information.** Contains basic information about the individual or business, such as the address, phone number, Social Security number, and record type. Any alert flags for the record are also displayed.

- **Critical Notices.** Contains summary information for any critical notices linked to the record. For more information on critical notices, see “Understanding Critical Notice alerts” on page 116.

- **Other Phones.** Contains additional phone numbers.

- **Internet.** Contains Internet contact information, such as a website address or an email address.

- **Addresses.** Contains additional address information, such as a second home or a work address.
- **Other Information.** Contains information such as additional contacts or employer information.

- **Alerts.** Contains summary information for general alert flags attached to the record. For more information, see “Understanding Warning and Alert Flags” on page 115.

- **Scars/Marks/Tattoos.** Contains information about the individual’s scars, marks, or tattoos.

- **Modus Operandi.** Contains information about the individual’s *modus operandi*, or method of operation.

- **Comments.** Contains additional useful information, such as where an individual can typically be found during a certain time of day.

The following buttons are on the Name screen:

- **Search More.** Opens the Name Search screen, populates the current record information in the appropriate fields, and selects all possible search options. To complete the search, click **Search**.

- **Edit.** Opens the Edit Name Record screen. Make the desired changes to the record, and then click **Save**. The fields in the Edit Name Record screen are the same as the fields in the Add Name Record screen. For field descriptions, see “Completing the Add Name Record screen” on page 129.
**Using the Vehicle screen**

The Vehicle screen contains information about vehicles in your local database.

Depending on the information in your database, the Vehicle screen might contain the following areas. This list is not all-inclusive. The information available depends on your record type and data available:

- **Vehicle Information.** Contains basic information about the vehicle, such as the license plate, license type, VIN, vehicle status, and the agency and officer responsible.

- **Owner Information.** Contains information about the owner of the vehicle, if known. If there are any warnings or alerts linked to the owner’s Name record, then the applicable alert flags are displayed. To view the owner’s Name record, click the Name link. To return to the Vehicle record, click the Back button (Alt+Left Arrow). If there are any images attached to the owner’s Name record, then an Image icon is displayed next to the Name link.

- **Other Information.** Contains other information, such as the vehicle make and model, vehicle color, vehicle type, and related incidents. To view the related incident, click the link. To return to the Vehicle record, click the Back button (Alt+Left Arrow).
 Queries, Returns, and Records
Using the Record Screens

- **Local IDs.** Contains local ID types and numbers for the record, such as the NCIC number or evidence number.

- **Comments.** Contains additional useful information, such as comments from the officer working on the case.

The following buttons are on the Vehicle screen:

- **Search More.** Opens the Vehicle Search screen, populates the current record information in the appropriate fields, and selects all possible search options. To complete the search, click **Search**.

- **Edit.** Opens the Edit Vehicle Record screen. Make the desired changes to the record, and then click **Save**. The Vehicle record fields in the Edit Vehicle Record screen are the same as the fields in the Add Vehicle Record screen. For field descriptions, see “Completing the Add Vehicle Record screen” on page 149.

**Using the Property screen**

The Property screen contains information about property in your local database.
Depending on the information in your database, the Property screen might contain the following areas. This list is not all-inclusive. The information available depends on your record type and data available:

- **Property Information.** Contains basic information about the property, such as the brand, model, serial number, local status, and the agency and officer responsible.

- **Owner Information.** Contains information about the owner of the property, if known. If there are any warnings or alerts linked to the owner’s Name record, then the applicable alert flags are displayed. To view the owner’s Name record, click the Name link. To return to the Property record, click the Back button (Alt+Left Arrow). If there are any images attached to the owner’s Name record, then an Image icon is displayed next to the Name link.

- **Other Information.** Contains other information, such as the total value of the property, storage location, and related incidents. To view a related incident, click the link for the incident. To return to the Property record, click the Back button (Alt+Left Arrow).

- **Local IDs.** Contains local ID types and numbers for the record, such as the NCIC number or evidence number.

- **Comments area.** Contains additional useful information, such as comments from the officer working on the case.

The following buttons are on the Property screen:

- **Search More.** Opens the Property Search screen, populates the current record information in the appropriate fields, and selects all possible search options. To complete the search, click Search.

- **Edit.** Opens the Edit Property Record screen. Make the desired changes to the record, and then click Save. The fields in the Edit Property Record screen are the same as the fields in the Add Property Record screen. For field descriptions, see “Completing the Add Property Record screen” on page 160.
Using the Law Incident screen

The Law Incident screen contains information about Law Incident records in your database.

Depending on the information about the incident in your database, the Law Incident screen can contain the following areas. This list is not all-inclusive. The information available depends on your record type and data available:

- **Incident Information.** Contains general information about the incident, such as when it was reported, the address, the responsible agency, the responsible officer, contact information, and the disposition status. If there are any Address alerts linked to the incident location, then a red alert flag is displayed next to the address. Rest the mouse pointer on the flag to view the alert information.

- **Complainant Information.** Contains information about the complainant who reported the incident, if any. If there are any warnings or alerts linked to the complainant’s Name record, then the applicable alert flags are displayed. To view the complainant’s Name record, click the Name link. To return to the Law Incident record, click the Back button (Alt+Left Arrow). If there are any images attached to the complainant’s Name record, then an Image icon is displayed next to the Name link.
Using the Record Screens

- **Other Information.** Contains other information, such as the reported offense, responding officers, CAD call ID, clearance code, and case numbers.

- **Narrative.** Contains narratives entered by the officers working on the incident. See “Working with Narratives and Supplemental Narratives” on page 120.

- **Supplemental Narrative.** Contains supplemental narratives entered by the officers working on the incident. See “Working with Narratives and Supplemental Narratives” on page 120.

- **Radio Logs.** Contains the radio log entries from the CAD call, if a CAD call is linked to the incident.

- **Approval History.** Contains the Workflow records for the incident. See “Working with Workflow records” on page 65.

The following buttons are on the Law Incident screen:

- **Edit Narratives.** Opens the narrative editor. For more information, see “Working with Narratives and Supplemental Narratives” on page 120.

- **Approval.** Opens the Update Status dialog box. For more information, see “Working with Workflow records” on page 65.

- **Edit.** Opens the Mobile Field Report to edit the Law Incident record. For more information, see the Mobile Field Report and Forms Manual. If your agency does not use the Mobile Field Report, then this button is not available.

---

**Using the Premises screen**

If your agency uses the Premises Information module, then Premises records provide valuable information to emergency and law enforcement personnel for responding to disasters or law incidents at unfamiliar sites. From the Premises screen, the Premises table in your agency's database can be queried for information about commercial, public, and residential premises.

Each Premises record contains occupant and owner information, contact information, alarm types and locations, the number of floors, the responsible law, fire, and EMS agencies, and a description of the premises. In addition, if
your agency uses CAMEO Chemicals, then the Premises record indicates whether hazardous materials are stored on the premises. For more information, see the Premises Information Manual.

Depending on the information about the premises in your database, the Premises screen might contain the following areas. This list is not all-inclusive. The information available depends on your record type and data available:

- **Premises Information.** Displays information such as the premises address, type, number of floors, and the responsible fire and law agencies. If there are any Address alerts linked to the incident location, then a red alert flag is displayed next to the address. Rest the mouse pointer on the flag to view the alert information.

- **Business Information.** Displays information such as the primary business name, business type, and phone number. Warning and alert flags linked to the business are not displayed. To view the Name record and any flags for the business, click the **Name** link. To return to the Premises record, click the **Back** button (Alt+Left Arrow).

- **Plans Number.** Displays the file number for the floor or building plans of the premises.

- **Alarm Number.** Displays the alarm number for the premises.

- **Businesses.** Displays information for businesses attached to the premises. To view the business’ Name record, double-click the detail
record. To return to the Premises record, click the Back button (Alt+Left Arrow).

- **Contacts.** Displays a list of contacts for the premises, including the contact’s name, relationship to the premises, and phone number. To view a contact’s Name record, double-click the detail record. To return to the Premises record, click the Back button (Alt+Left Arrow).

- **Alarms.** Displays the types of alarms used at the premises.

- **Areas.** Displays the law, fire, and EMS zones in which the premises is located.

- **Descriptions.** Displays information such as a description of the grounds and structures, the location of utilities, and the best routes from emergency response stations.

- **Hazardous Materials.** Displays any hazardous materials associated with the premises. To view the CAMEO Chemical data sheet, double-click the detail record, or use the Up Arrow or Down Arrow key to select the desired record, and then press Enter. To return to the Premises record, click the Back button (Alt+Left Arrow).

- **Proximate Populations.** Displays information from the Premises Proximate Population record in the database to help agencies plan rescue efforts and evacuations in case of emergency.

- **Comments.** Displays comments for the record.
Understanding Warning and Alert Flags

Records with warning and alert flags receive special identification and handling. The manner in which the flag is displayed and information is available depends on the flag type and record type.

The flag colors vary as follows:

- Warning flags and Address alert flags are highlighted in red. For more information, see the RMS User Manual.
- Critical Notice alert flags are highlighted in orange. For more information, see “Understanding Critical Notice alerts” on page 116.
- Offender Tracking alert flags are highlighted in blue. For more information, see the Offender Tracking Manual.
- Name alerts are not highlighted. For more information, see the RMS User Manual.

Warnings and alerts are displayed as follows:

- **In the Search Results screen.** Records that are involved with warning, Critical Notice, or Offender Tracking flags are placed at the top of the list in alphabetical order. Records with Name alerts are sorted alphabetically with the remaining records. If more than one warning or alert is involved, then a plus sign (+) is displayed next to the highest-ranking flag.

  The column in which the flag appears depends on the record type:

  - **Name.** The warning or alert is displayed in the Alerts column. The flag is highlighted according to its type.
  - **Vehicle and Property.** If the owner has an involved warning, Critical Notice, or Offender Tracking flag, then in the Owner column, the owner’s name is highlighted according to the flag type.
  - **Law Incident.** If the complainant has an involved warning, Critical Notice, or Offender Tracking flag, then in the Complainant column, the complainant’s name is highlighted according to the flag type.
  - **Premises.** Warnings and alerts are not displayed on the Premises Search Results screen.

NOTE
Other record types not included in this section might also have alert flags. However, the process of identifying the flag type and viewing the information is similar. Use the information in this section as a guide.
In the Record screen. If more than one warning is involved, then a plus sign (+) is displayed next to the highest-ranking flag. The area in which the flag and additional information is displayed depends on the record type:

- **Name.** Name alert flags are displayed in the Alerts area. To view all the alert flags for the record, expand the Alerts area. Warning, Critical Notice, and Offender Tracking flags are displayed in the record header. To view the warning flag information, click the flag to expand the Involvements area, and then double-click the desired flag. Warnings are placed at the top of the involvements list and are highlighted in red. Address alert flags are displayed in red next to the person’s address. Rest the mouse pointer on the flag to view the alert information.

- **Vehicle and Property.** Warning, Critical Notice, and Offender Tracking flags are displayed in the Owner area. Click the Name link to open the Name record and view the warning information. Other Name alert flags not associated with a warning, critical notice, or offender tracking are not displayed in the Owner area of the Vehicle and Property screens. Review the owner’s Name record for complete information.

- **Law Incident.** If the warning, Critical Notice, or Offender Tracking flag is for the complainant, then the flag is displayed in the Complainant area. Click the Name link to open the record and view the flag information. If there is an Address alert for the address where the incident occurred, then the flag is displayed next to the address. Rest the mouse pointer on the flag to view the alert information.

- **Premises.** If there is an Address alert for the premises address, then the flag is displayed next to the address and in the record heading. Rest the mouse pointer on the flag next to the address to view the alert information.

**Understanding Critical Notice alerts**

Depending on your privileges, Critical Notice alerts can be added to a record, and those records can be searched for based on the alert type.

**Searching for Critical Notice alerts**

To find records containing a specific Critical Notice alert, perform a Critical Notice search. For example, to find all Name records for those on parole, search for the Critical Notice alert of PAROL.
To search Critical Notice alerts:

1. From the Mobile menu bar, select Search > Other Local Searches > Critical Notice.

   The Critical Notice Search screen opens.

2. Enter search criteria. For field descriptions, see “Fields in the Critical Notice Search screen” on page 117.

3. Click Search.

   Records matching the search criteria are displayed.

**Fields in the Critical Notice Search screen**

The following describes fields in the Critical Notice Search screen.

- **Type**
  
  Select the type of critical notice to find from the drop-down list.

- **Comments**

  To search comments added to the Critical Notice alert, enter a key word about the alert.

**TIP**

Use the asterisk (*) wildcard to expand your search. For example, to find any alerts with a knife in the Comments field, enter *knife*.
Date Begin

Enter the date the alert begins in the mm/dd/yyyy format. This field is made available by expanding the More advanced search options area.

Date Expires

Enter the date the alert expires in the mm/dd/yyyy format. This field is made available by expanding the More advanced search options area.

Entered By

To search by who entered the alert, select a name from the drop-down list. This field is made available by expanding the More advanced search options area.

Adding and modifying Critical Notice alerts

Depending on your privileges, Critical Notice alerts can be added to a Name record, and existing notices can be modified.

To add or modify Critical Notice alerts:

1. Search for the Name Record that needs the alert. See “Performing Queries” on page 74.

   **NOTE**

   Critical Notice alerts can also be added when adding a new Name record. See “Adding Name, Vehicle, or Property Records” on page 128.

2. Select the desired record.

   The Name record screen opens.

3. Click the Edit button.
The Edit Name Record screen opens.

4. Click the **Notices** tab.

5. Complete the fields. For field descriptions, see “Fields in the Notices tab” on page 147.

6. Do any of the following:
   - To enter an additional Critical Notice alert, click the **Add** icon.
   - To delete an existing Critical Notice alert, click the **Remove** icon.
   - To end the alert without removing it, in the **Expire Date** field, enter the date to end the alert in the *mm/dd/yyyy* format, or use the drop-down calendar.

7. Click **Save**.
Working with Narratives and Supplemental Narratives

The following sections describe how to work with narratives or supplemental narratives for Law Incident records:

- “Viewing the narrative and supplemental narratives” on page 120
- “Using the Narrative window” on page 120

Viewing the narrative and supplemental narratives

The narrative and supplemental narratives for Law Incident records can be viewed in Mobile.

To view the narrative and supplemental narratives for a Law Incident record:

1. Search the Law Search screen. See “Performing Queries” on page 74.
2. Select the desired record. See “Viewing RMS returns” on page 83.
   
   The Law screen opens, and in the Narrative area, the narrative is displayed. In the Supplements area, the supplemental narratives are listed.

3. Do any of the following:
   - In the Narrative area, if the narrative does not fit it in the viewing area, then click the plus sign to view the entire narrative.
   - In the Supplements area, click the plus sign to view the list of supplemental narratives. To view a supplemental narrative, in the detail record, in the Text column, click the plus sign to view the supplemental narrative text.

Using the Narrative window

Depending on your privileges, narratives or supplemental narratives for Law Incident records can be appended, or additional supplemental narratives can be added using the Narrative window.

If an alert or a new message is received while working with the narrative or supplemental narrative, then the Narrative window can be minimized without losing any changes.

To use the Narrative window:

1. Open the Law Incident record to view the narrative.
2. Click the **Edit Narratives** button.

   The Narrative window opens. In the title bar, the Incident Number and the nature of the incident are displayed.

3. Do one of the following:

   - To make changes to the narrative, click the **Append to Narrative** button.
     
     The narrative editor opens, and the title bar changes to indicate that the narrative is being appended.

   - To create a supplemental narrative, click the **New Supplement** button.
     
     The narrative editor opens, and the title bar changes to indicate that a new supplemental narrative is being added.

   - If the record already has a supplemental record, then to make changes to the supplemental record, select the record, and click the **Append to Supplement #** button. The number on the button changes to reflect the supplement number being appended.
     
     The narrative editor opens, and the title bar changes to indicate that the supplemental narrative is being appended.

4. In the narrative editor, enter the desired text. To use a template, click the **Templates** button, select a template from the list, and then click **Select** (Alt+S).

5. To check your spelling, click the **Spell Check** button. See “Using the spelling checker” on page 43.

6. To save your changes, click **Save** (Alt+S).
The changes appear in the Narrative window with the current time and date. If the associated Law Incident record is no longer open in Mobile, then the record opens with the new information.

7. Click **Close** to close the Narrative window.
Working with File Attachments

Depending on your privileges, file attachments can be added, viewed, or managed in the following Mobile screens:

- Accident
- Citation
- Field Interview
- Incident
- Names
- Premises
- Property
- Vehicle

File Capture functions

Depending on your privileges, the following functions can be performed within the File Capture window. For more information, see the RMS User Manual.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a file</td>
<td>![Open Button]</td>
<td>Opens the selected file. Multiple files can be selected and opened at once.</td>
</tr>
<tr>
<td>Import Files</td>
<td>![Import Files]</td>
<td>Attaches files to the current record. See “Adding file attachments” on page 125.</td>
</tr>
<tr>
<td>Copy</td>
<td>![Copy]</td>
<td>Copies an attached file, which can then be pasted in another location. Multiple files can be copied at once.</td>
</tr>
<tr>
<td>Hide</td>
<td>![Hide]</td>
<td>Hides the selected files from all users. Only users with the necessary privileges can view hidden files using the Show Hidden button. To reveal a hidden file, select the hidden file and click the Unhide button.</td>
</tr>
<tr>
<td>Lock</td>
<td>![Lock]</td>
<td>Restricts access to files. Other users are able to see the file, but are not able to open it. Only users with the necessary privileges can unlock and open a locked file.</td>
</tr>
<tr>
<td>Show Hidden</td>
<td>![Show Hidden]</td>
<td>Displays files that have been hidden using the Hide button. To hide the files again, click the Hide Hidden button.</td>
</tr>
</tbody>
</table>
**Viewing attached files**

The number of files attached to a record is displayed in the **Files** area at the bottom of the Record screen.

To view attached files, in the **Files** area, click the plus sign. The area expands to reveal the list of files attached to the record. Information for each file is displayed, including the file name, size, type, description, who captured the file, and the date the file was added. Double-click a detail record to open a file.

**TIP**

Consider the file size of the attachment before opening it. Large attachments take longer to download.

**Managing file attachments**

Depending on your privileges, files can be added to or deleted from records using the File Capture window.
To manage file attachments:

1. With the record open, click **Manage Files**.

The File Capture window opens.

2. Do any of the following, as necessary:
   - Add file attachments to the record. See “Adding file attachments” on page 125.
   - Delete file attachments from the record. See “Deleting file attachments” on page 126.

3. In the Record screen, click **Refresh Data**.
   In the **Files** area, the list of attached files is updated.

**Adding file attachments**

To add a file attachment:

1. From the File Capture window, click **Import Files**.
The Import Files window opens.

2. Do one of the following:
   - If the **Look In** field points to the location of the file, then click **Quick Import**.
     
     All files in the selected location are displayed, and each file is selected by default.
   - If the **Look In** field is empty or points to the wrong location, then click **Browse** to find the correct file. Select the desired file and continue to step 4.

### TIP

Files can be moved from a File Explorer window or from your desktop by dragging the file to the File Capture window.

3. Clear the check boxes for files that do not need to be imported.

4. In the **Default File Type** area, select the file type to be assigned to all the files being imported.

5. Click **Import Selected**.

   The files are displayed in the File Capture window.

6. Click the **Close** button to exit the File Capture window.

### Deleting file attachments

To delete a file attachment:

1. From the File Capture window, select the files to delete.
2. Click the **Delete** button.

   The Delete Files prompt box opens, asking for confirmation to delete the selected files.

3. Click **Delete Files**.

   The files are removed from the File Capture window.

4. Click the **Close** button to exit the File Capture window.
Adding Name, Vehicle, or Property Records

Depending on your privileges, Name, Vehicle, or Property records can be added in Mobile.

To add a record in Mobile:

1. Perform a search for the record. See “Performing Queries” on page 74.

2. Do one of the following:
   - If results are returned, but the desired record is not displayed, then click the Create New button.
   - If no results are returned, then click the Create New link.

**NOTE**
A search is required before adding a record to the Names and Vehicle tables. However, depending on the settings established by your SAA, a search might not be required before adding a record to the Property table.
The Add Record screen opens for the type of record being added, and any field values included in the search criteria are completed.

3. Complete the fields as required by your agency. For tab and field descriptions of each Add Record screen, see the following sections:
   – “Completing the Add Name Record screen” on page 129
   – “Completing the Add Vehicle Record screen” on page 149
   – “Completing the Add Property Record screen” on page 160
   – “Completing the Add Evidence Record screen” on page 170

4. When finished, click Save.

The record is added to the database and the Add Record screen closes. The completed record is displayed in Mobile.

**Completing the Add Name Record screen**

The Add Name Record screen contains information about a person, such as the birth date, sex, and race, as well as detailed information, such as any identifying scars, marks, or tattoos.
The Add Name Record screen is organized into the following tabs: Name, DL, IDs, Traits, Addresses, Contacts, Misc, Aliases, Notices, and Comments.

Fields in the Name tab

The following describes fields in the Name tab of the Add Name Record screen.

**NOTE**

To add multiple entries, if applicable, click the Add icon. To delete an entry, click the Remove icon.

**Last**

Enter the last name of the person. If this is a business, then enter a name that uniquely identifies the business or building. For example, if your agency’s jurisdiction has three 7-Eleven stores, then add three Name records, each with a unique identifier, such as the address. For example, use the following values:

- 7-Eleven, 200 S Main St
- 7-Eleven, 7800 N Main St
- 7-Eleven, 2700 E Elm St
First
Enter the first name of the person.

Middle
Enter the middle name or initial of the person.

Suffix
Enter the name suffix of the person. For example, Sr. or III.

Sex
Enter the sex of the person. Enter M for male, F for female, U for unknown, or select a value from the drop-down list.

Race
Enter the race of the person, or select a value from the drop-down list.

Type
Select the type of Name record. For example, Individual or Business.

DOB
Enter the date of birth of the person in the mm/dd/yyyy format, or use the drop-down calendar.

Age
Displays the age of the person based on the value in the DOB field.

SSN
Enter the Social Security number of the person.

Date of Death
If the person is deceased, then enter the date of death of the person in the mm/dd/yyyy format, or use the drop-down calendar.
Height

Enter the height of the person in feet and inches. For example, 5'10" for 5 feet, 10 inches. Spaces are not required.

Weight

Enter the weight of the person in pounds.

Eyes

Enter the eye color of the person, or select a value from the drop-down list.

Hair

Enter the hair color of the person, or select a value from the drop-down list.

Street

Enter the street address for the person’s residence, or if this is a business, then the address for the business. If your agency maintains a geobase, then the software validates the address when the cursor is moved to another field, or the Validate button is clicked.

The Address Selection window opens.

Select the correct address, and then click Select. Otherwise, click Don’t Validate to continue without validating the address.
### City
Enter or select the city where the person lives. If the address was validated, then this field is completed automatically.

### State
Enter or select the state where the person lives. If the address was validated, then this field is completed automatically.

### Zip
Enter the postal ZIP Code. The last four characters are optional. If the address was validated, then this field is completed automatically.

### Home Phone
Enter the person’s primary telephone number, such as a home telephone number, in the `(xxx)-xxxx` format.

### Work Phone
Enter the person’s work telephone number and extension, if applicable, in the `(xxx)-xxx-xxxx, xxxx` format.

### Other Phone
Enter an additional phone number. For example, the number for a cell phone.

### Type
Select a description for the other phone number from the drop-down list.

### Priority
Select the importance of the other number from the drop-down list.
### Fields in the DL tab

The following describes fields in the **DL** tab of the Add Name Record screen.

![Add Name Record - Spillman Flex](image)

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.

---

**DL Number**

Enter the driver license number of the person.

---

**State**

Enter the abbreviation for the state that issued the driver license, or select a value from the drop-down list.

---

**Type**

Enter the type of license, or select a value from the drop-down list.
Expiration

Enter the expiration date of the driver license in the \textit{mm/dd/yyyy} format, or use the drop-down calendar.

Class

Enter the driver license classification, or select a value from the drop-down list.

Restriction

Enter any restrictions associated with the license, or select a value from the drop-down list. For example, \textit{Corrective Lenses}.

Endorsement

Enter any state-issued endorsements for the license, or select a value from the drop-down list. For example, \textit{School Bus}.

\textbf{Fields in the IDs tab}

The following describes fields in the \textbf{IDs} tab of the Add Name Record screen.
Subtype

Select a secondary name type from the drop-down list. For example, if in the Name tab, School was selected from the Type field drop-down list, then Child Care Facility is a possible subtype for the Name record.

Alert Code

Enter a code that describes a characteristic about the person, or select a value from the drop-down list. For example, DUSR-Drug User.

State ID

Enter the state identification for the person.

FBI Number

Enter the FBI number associated with the person.

Local ID Type

Enter the type of additional local identification, or select a value from the drop-down list. For example, Email Address.

Local ID Number

Enter the local identification number described in the Local ID Type field. For example, if Fax Number is selected in the Local ID Type field, then enter a fax number in the (xxx) xxx-xxxx format.

M.O. Factor

Enter or select from the drop-down list the factor or general category associated with the modus operandi, or method of operation. For example, Hand.

M.O. Method

Enter the method that describes the factor. The drop-down list for the factor indicates what type of information can be entered in the M.O. Method field. For example, if the modus operandi factor is Hand, then the drop-down list
suggests entering which hand is dominant in the **M.O. Method** field. For example, **Right**.

**Professional Licenses Type**

Select any certifications or professional licenses held by the person from the drop-down list.

**State**

Enter the state that issued the professional license or certificate, or select a value from the drop-down list.

**License Description**

Enter any identifying numbers or a description of the license or certificate as needed.

**Fields in the Traits tab**

The following describes fields in the **Traits** tab of the Add Name Record screen.
Ethnicity

Enter a code that describes the ethnic background of the person, or select a value from the drop-down list.

Build

Enter a code that describes the body shape of the person, or select a value from the drop-down list. For example, MCLR-Muscular.

Complexion

Enter a code for the skin coloring or appearance of the person, or select a value from the drop-down list. For example, MDF-Medium, Freckled.

Glasses

Enter a code for the type of eye wear of the person, or select a value from the drop-down list. For example, B-Bifocals.

Hairstyle

Enter a code for the hair color of the person, or select a value from the drop-down list.

Beard

Enter a code that describes the person’s facial hair, if any, or select a value from the drop-down list. For example, G-Goatee.

Speech

Enter a code that describes the way of speaking of the person, or select a value from the drop-down list. For example, GRUF-Gruff or Harsh Voice.

Teeth

Enter a code that describes the teeth of the person, or select a value from the drop-down list. For example, BRAC-Braces.
Shoe Size

Enter the shoe size for the person in whole or half sizes. For example, 7.5.

Cover Size

Enter the coverall size for the person.

Misc Size

Enter additional size information. Follow your agency’s guidelines for entering information in this field.

NCIC Code

Enter or select a code from the drop-down list that describes the person’s scar, mark, or tattoo.

Comments

Enter a short, detailed description of the person’s scar, mark, or tattoo. For example, size, length, colors, or images.
Fields in the Addresses tab

The following describes fields in the Address tab on the Add Name Record screen.

![Add Name Record - Spillman Sentryx](image)

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.

**Internet Address**

Enter an Internet address associated with the person or business. For example, an email or website.

**Type**

Select the type of Internet address from the drop-down list. For example, E-MAIL Address or WEBSITE URL.

**Priority**

Select the importance of the Internet address. For example, PRIMR-Primary or SECND-Secondary.
Additional Addresses area

Each additional address entry contains a detail row of information. Each detail row contains the following fields.

**Type**

Select the category for the additional address from the drop-down list. For example, Mailing Address.

**Description**

Enter an explanation about why the address is significant. For example, the person receives mail, attends school, or works at the address.

**Street**

Enter the street number and name for the additional address. If your agency maintains a geobase, then the software verifies the address when the cursor is moved to another field, or the Validate button is clicked.

The Address Selection window opens.

Select the correct address, and then click Select. Otherwise, click Don’t Validate to continue without validating the address.

**City**

Enter or select the city where the person lives. If the address was validated, then this field is completed automatically.
Entries, Returns, and Records

Adding Name, Vehicle, or Property Records

State

Enter or select the state where the person lives. If the address was validated, then this field is completed automatically.

Zip

Enter the postal ZIP Code. The last four characters are optional. If the address was validated, then this field is completed automatically.

Fields in the Contacts tab

The following describes fields in the Contacts tab of the Add Name Record screen.

Name

Enter the full name of the emergency contact for the person.

Relationship

Enter the relationship of the emergency contact to the person described in the Name record. For example, Mother or Friend.
Address
Enter the full address for the person’s emergency contact. The address is not validated.

Phone
Enter the phone number for the person’s emergency contact in the (xxx)-xxx-xxxx format.

Name
Enter the name of the person’s employer.

Phone
Enter the main phone number of the employer in the (xxx)-xxx-xxxx format.

Address
Enter the address of the employer. The address is not validated.

Date Hired
Enter the date the person was hired in the mm/dd/yyyy format, or use the drop-down calendar.

Job Description
Enter the description or title of the person’s job.

Job Location
Enter the address of the person’s place of employment. The address is not validated.

Job Phone
Enter the phone number of the person’s place of employment in the (xxx)-xxx-xxxx format.

Supervisor
Enter the full name of the person’s direct supervisor.
Super’s Work Phone

Enter the work phone number for the person’s direct supervisor in the (xxx)-xxx-xxxx format.

Super’s Home Phone

Enter the home phone number for the person’s direct supervisor in the (xxx)-xxx-xxxx format.

Fields in the Misc tab

The following describes fields in the Misc tab of the Add Name Record screen.

Probation Type

Enter or select the code from the drop-down list for the type of probation the person is on.

Probation Officer

Enter the full name of the person’s probation officer.
Attorney
Enter the full name of the attorney for the person.

Birth City
Enter the city where the person was born, or select a value from the drop-down list.

Birth State
Enter the state where the person was born, or select a value from the drop-down list.

Birth Country
Enter the country where the person was born, or select a value from the drop-down list.

Citizenship
Enter the country where the person holds citizenship, or select a value from the drop-down list.

Marital Status
Enter a code that indicates the person’s current marital status, or select a value from the drop-down list. For example, M-Married, or D-Divorced.

Religion
Enter a code to indicate the person’s religious affiliation, or select a value from the drop-down list.

School
Enter the last school attended by the person.

Education Years
Enter the number of years of schooling the person has completed.

NCIC Print
Enter the 20-digit NCIC or AFIS fingerprint code for the person.
Enter up to four NCIC FPC codes describing the fingerprints of the person. For example, \textit{AA} for Plain Arch or \textit{25} for the ridge count.

The \textbf{Aliases} tab of the Add Name Record screen.

The \textbf{Aliases} tab displays any aliases already associated with the Name record in the menu on the left. Select an alias from the menu to view any available information in the fields on the right.

To add an alias to the record:

1. With the \textbf{Aliases} tab open, click the \textbf{New Alias} button.

2. Complete the following fields:
   - \textbf{Last}: Enter the last name of the alias.
   - \textbf{First}: Enter the complete first name of the alias.
   - \textbf{Middle}: Enter the full middle name or middle initial of the alias.
   - \textbf{DOB}: Enter the date of birth for the alias in the \textit{mm/dd/yyyy} format, or use the drop-down calendar.
   - \textbf{SSN}: Enter the Social Security number for the alias.
– **DL Number**: Enter the driver license number for the alias.

– **DL State**: Enter the state that issued the driver license, or select a value from the drop-down list.

– **Comments**: Enter any additional comments about the alias. This field expands as information is entered.

3. When finished, click **Save**.

A Name record for the alias is created and the two Name records are linked through an involvement.

**Fields in the Notices tab**

The following describes fields in the **Notices** tab of the Add Name Record screen.

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.

**Begin Date**

Enter the date the critical notice began in **mm/dd/yyyy** format, or use the drop-down calendar.
Notice Type
Enter the notice type, or select a value from the drop-down list.

Entered by
Enter your name, or select your name from the drop-down list.

Expire Date
Enter the date the critical notice expires in mm/dd/yyyy format, or use the drop-down calendar.

Comments
Enter any comments regarding the critical notice that might be helpful to others.

Fields in the Comments tab
The following describes fields in the **Comments** tab of the Add Name Record screen.
Comments

Enter additional information associated with this record, or copy and paste information from another document. Misspelled words are underlined in red. Right-click the word to select the correct spelling.

Completing the Add Vehicle Record screen

The Add Vehicle Record screen contains information about a vehicle, such as the make, model, and color, as well as information used for uniform crime reporting (UCR) and incident-based reporting (IBR). A Vehicle record can be linked to the Name record of the owner.

The Add Vehicle Record screen is organized into the following tabs: Vehicle, Status, Incident, Owner, Addresses, and Comments.

For more information on the Evidence tab, see “Completing the Add Evidence Record screen” on page 170.

Fields in the Vehicle tab

The following describes fields in the Vehicle tab of the Add Vehicle Record screen.
Adding Name, Vehicle, or Property Records

License Plate

Enter the license plate number of the vehicle with no spaces.

State

Enter the state that issued the license plate, or select a value from the drop-down list.

Expiration

Enter the date the vehicle registration expires in the mm/dd/yyyy format, or use the drop-down calendar.

Evidence

Select this to create an Evidence record. See “Completing the Add Evidence Record screen” on page 170.

License Type

Enter the type of license plate, or select a value from the drop-down list. For example, CO-Commercial.

VIN

Enter the Vehicle Identification Number (VIN) for the vehicle.

Year

Enter the year the vehicle was manufactured.

Make

Enter a code for the make of the vehicle, or select a value from the drop-down list.

Model

Enter a code for the model of the vehicle, or select a value from the drop-down list.
Primary Color

Enter a code for the dominant color of the vehicle, or select a value from the drop-down list.

Secondary Color

Enter a code for the supplemental color of the vehicle, or select a value from the drop-down list. For example, the color of the trim or decals.

Doors

Enter the number of doors on the vehicle.

Vehicle Type

Enter the category type of the vehicle. For example, PCAR-Passenger Car.

Value

Enter the value of the vehicle.

Characteristic

Enter a code for any distinguishing traits of the vehicle, or select a value from the drop-down list. For example, CUSWH-Custom Wheels or STBTR-Shortbed Truck.
### Fields in the Status tab

The following describes fields in the **Status** tab of the Add Vehicle Record screen.

#### IBR/UCR Agency

Enter a code for the agency responsible for handling the vehicle, or select a value from the drop-down list.

#### Officer

Enter a code for the officer in charge of handling the vehicle, or select a value from the drop-down list.

#### Status Date

Enter the date the status was declared in the `mm/dd/yyyy` format, or use the drop-down calendar.

---

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.
IBR/UCR Status

Enter a code for the IBR or UCR status, or select a value from the drop-down list. For example, SNR-Stolen, Not Recovered or DDA-Damaged Due to Arson.

Local Status

Enter a code for the status of the vehicle, or select a value from the drop-down list. The local status codes are defined by your agency and are usually more specific than the UCR status codes.

Date Recovered

Enter the date the vehicle was recovered in the \textit{mm/dd/yyyy} format, or use the drop-down calendar.

Amount Recovered

Enter the dollar value for the recovered vehicle.

UCR uses the value in this field to calculate the recovered value of the vehicle. For accurate UCR reports, enter the recovered value in the \textbf{Amount Recovered} field—not in the \textbf{Value} field.

Storage Location

Enter the location where the vehicle is stored.

Wrecker Service

Enter a code for the wrecker service used to tow the vehicle, or select a value from the drop-down list.

Area

Enter a code for the geographic location where the vehicle was recovered or reported stolen, or select a value from the drop-down list. This information helps your agency identify trends and problem areas in your jurisdiction.

Date released

Enter the date the vehicle was released in the \textit{mm/dd/yyyy} format, or use the drop-down calendar.
Local ID Type

Enter a code for a local identification number, or select a value from the drop-down list. For example, INV-Investigation Number.

Local ID number

Enter the number that corresponds to the code selected for the Local ID Type field.

Fields in the Incident tab

The following describes fields in the Incident tab of the Add Vehicle Record screen.

Related Incident

Click the Select button to link the Vehicle record to a Law Incident record. If the Law Incident record was recently searched for, then the record is displayed in the Recent Searches list. If the Law Incident record is not displayed, then it can be searched for.

To search for a Law Incident record that is not displayed after the Select button is clicked:

1. Click the New Search button.
The Law Search screen opens.

2. Enter the search criteria for the incident, such as when it was reported.

3. Click the **Search** button.

   The search results are displayed.

4. Open the records that match your search criteria to find the desired record.

   In the Add Vehicle Record screen, records that are opened appear in the **Incident** tab, in the Recent Searches list.

5. When the desired record is located and opened, return to the **Incident** tab on the Add Vehicle Record screen.

6. Click **Select**.

   The Recent Searches list opens.

7. Double-click the desired record to select it.

   The **Related Incident** field is populated with the Incident Number, and the details of the incident are displayed.
Fields in the Owner tab

The following describes fields in the **Owner** tab of the Add Vehicle Record screen.

**Owner ID**

Click the **Select** button to link the Vehicle record to the Name record for the owner. A list of recently searched for Name records is displayed in the Recent Searches list. If the owner’s Name record is not displayed, then it can be searched for.

To search for a Name record that is not displayed after the **Select** button is clicked:

1. Click the **New Search** button.
   
   The Name Search screen opens.

2. Enter the search criteria for the owner, such as the last name.

3. Click the **Search** button.

   The search results are displayed.

4. Open the records that match your search criteria to find the desired record.

   In the Add Vehicle Record screen, records that are opened appear in the **Owner** tab, in the Recent Searches list.
5. When the desired record is located and opened, return to the Owner tab on the Add Vehicle Record screen.

6. Click Select.

   The Recent Searches list opens.

7. Double-click the desired record to select it.

   The **Owner ID** field is populated with the Name Number, and the details of the Name record for the owner are displayed.

**Fields in the Addresses tab**

The following describes fields in the **Address** tab in the Add Vehicle Record screen.

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.

**Street**

Enter the street number and name for the primary location of the vehicle. If your agency maintains a geobase, then the address is validated when the cursor is moved to another field, or the **Validate** button is clicked.
The Address Selection window opens.

![GeoValidation Address Selection - Spillman Flex](image)

Select the correct address, and then click **Select**. Otherwise, click **Don’t Validate** to continue without validating the address.

**City**

Enter or select the city for the address. If the address was validated, then this field is completed automatically.

**State**

Enter or select the state for the address. If the address was validated, then this field is completed automatically.

**Zip**

Enter the ZIP code for the address. If the address was validated, then this field is completed automatically.

**Frequent Locations area**

Each frequent locations entry contains a detail row of information. Each detail row contains the following fields.

**Type**

Select a description for the type of location from the drop-down list.
Adding Name, Vehicle, or Property Records

Street

Enter the street number and name for the location type. If your agency maintains a geobase, then the address is validated when the cursor is moved to another field, or the **Validate** button is clicked.

The Address Selection window opens.

Select the correct address, and then click **Select**. Otherwise, click **Don’t Validate** to continue without validating the address.

City

Enter or select a city for the address. If the address was validated, then this field is completed automatically.

State

Enter or select the state for the address. If the address was validated, then this field is completed automatically.

Zip

Enter the ZIP code for the address. If the address was validated, then this field is completed automatically.
Fields in the Comments tab

The following describes fields in the Comments tab of the Add Vehicle Record screen.

Enter additional information associated with this record, or copy and paste information from another document. Misspelled words are underlined in red. Right-click the word to select the correct spelling.

Completing the Add Property Record screen

The Add Property Record screen contains information about items involved in an incident, such as the brand, model, year, and value, as well as information used for uniform crime reporting (UCR) and incident-based reporting (IBR). A Property record can be linked to the Name record of the owner.

The Add Property Record screen is divided into the following tabs: Property, Status, Incident, Owner, Custody, and Comments.

For more information on the Evidence tab, see “Completing the Add Evidence Record screen” on page 170.
The following describes fields in the **Property** tab of the Add Property Record screen.

### Item
Enter the type of property, or select a value from the drop-down list.

### Qty
Enter the quantity of the property. The value entered corresponds with the measurement entered in the **Measurement** field.

### Total Value
Enter the total value of the item in dollars.

---

**NOTE**
To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.
Evidence

Select this to create an Evidence record. See “Completing the Add Evidence Record screen” on page 170.

IBR/UCR Code

Enter the code for the UCR or IBR crime category that best describes the item, or select a value from the drop-down list.

Measurement

Enter a code for the type of measurement used, or select a value from the drop-down list. The code entered corresponds to the value in the Qty field. For example, kilograms.

Brand

Enter the brand name of the item.

Model

Enter the model name or number of the item.

Year

Enter the model year of the item.

Primary Color

Enter the dominant color for the item, or select a value from the drop-down list.

Secondary Color

Enter a code for the supplemental color of the vehicle, or select a value from the drop-down list. For example, the color of the trim or decals.

Serial Number

Enter the serial number for the item.

Owner Applied Number

Enter the number, name, or initials that the owner gave the item. Follow your agency’s guidelines when completing this field.
Characteristic

Enter a code for any traits that help identify the item, or select a value from the drop-down list.

Fields in the Status tab

The following describes fields in the **Status** tab of the Add Property Record screen.

![Add Property Record Screen](image)

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.

**IBR/UCR Agency**

Enter the code for the agency responsible for the item, or select a value from the drop-down list.

**Officer**

Enter the name of the officer responsible for the item, or select a value from the drop-down list.
Queries, Returns, and Records
Adding Name, Vehicle, or Property Records

Status Date
Enter the date the status was declared, or use the drop-down calendar.

IBR/UCR Status
Enter a code for the UCR or IBR status, or select a value from the drop-down list. For example, SNR - Stolen, Not Recovered or DDA - Damaged Due to Arson.

Local Status
Enter a code for the status of the item, or select a value from the drop-down list. The local status codes are defined by your agency and are usually more specific than the UCR status codes.

Date Recovered
Enter the date the property was recovered in the mm/dd/yyyy format, or use the drop-down calendar.

Amount Recovered
Enter the dollar value for the property recovered within the current month.

UCR and IBR use the value in this field to calculate the recovered value of the property. For accurate UCR and IBR reports, enter the recovered value in the Amount Recovered field—not in the Value field.

Accumulative Amount Recovered
Enter the total dollar value for the property recovered so far. For example, the total amount for the current month and all previous months.

Storage Location
Enter the location where the item is currently being held.

Tag Number
Enter the tag number assigned to the item for storage retrieval.

Crime Lab Number
Enter the crime lab number assigned to the item.
Date Released

Enter the date the item was released in the *mm/dd/yyyy* format, or use the drop-down calendar.

Released By

Enter the name of the person who released the item, or select a value from the drop-down list.

Released To

Enter the name of the person who received the item at the time it was released, or select a value from the drop-down list.

Local ID Type

Enter or select a code from the drop-down list for a local identification number. For example, INV-Investigation Number or POL-Police Investigation Number.

Local ID number

Enter the number that corresponds to the code selected for the **Local ID Type** field.
The following describes fields in the **Incident** tab of the Add Property Record screen.

**Related Incident**

Click the **Select** button to link the Property record to a Law Incident record. If the Law Incident record was recently search for, then it is displayed in the Recent Searches list. If the Law Incident record is not displayed, then it can be searched for.

To search for a Law Incident record that is not displayed after the **Select** button is clicked:

1. Click the **New Search** button.
   
   The Law Search screen opens.

2. Enter the search criteria for the incident, such as when it was reported.

3. Click the **Search** button.
   
   The search results are displayed.

4. Open the records that match your search criteria to find the desired record.
In the Add Property Record screen, records that are opened appear in the **Incident** tab, in the Recent Searches list.

5. When the desired record is located and opened, return to the **Incident** tab on the Add Property Record screen.

6. Click **Select**.

   The Recent Searches list opens.

7. Double-click the desired record to select it.

   The **Related Incident** field is populated with the Incident Number, and the details of the incident are displayed.

**Fields in the Owner tab**

The following describes fields in the **Owner** tab of the Add Property Record screen.

![Add Property Record - Spillman Sentryx](image)

**Owner ID**

Click the **Select** button to link the Property record to the Name record for the owner. A list of recently searched for Name records is displayed in the Recent Searches list. If the owner’s Name record is not displayed, then it can be searched for.
To search for a Name record that is not displayed after the Select button is clicked:

1. Click the New Search button.
   - The Name Search screen opens.
2. Enter the search criteria for the owner, such as the last name.
3. Click the Search button.
   - The search results are displayed.
4. Open the records that match your search criteria to find the desired record.
   - In the Add Property Record screen, records that are opened appear in the Owner tab, in the Recent Searches list.
5. When the desired record is located and opened, return to the Owner tab on the Add Property Record screen.
6. Click Select.
   - The Recent Searches list opens.
7. Double-click the desired record to select it.
   - The Owner ID field is populated with the Name Number, and the details of the Name record for the owner are displayed.
The following describes fields in the **Custody** tab of the Add Property Record screen.

![Add Property Record](image)

### Fields in the Custody Tab

Each detail row contains the following fields.

**Date**

Enter the date and time on which the custody status for the item changed in the `mm/dd/yyyy hh:mm:ss` format, or use the drop-down calendar.

**Who To/From**

Enter the code for the officer who received or distributed the property, or select a value from the drop-down list.

**Custodian**

Enter the code for the officer who is in possession of the property, or select a value from the drop-down list.

---

**NOTE**

To add multiple entries, if applicable, click the **Add** icon. To delete an entry, click the **Remove** icon.
Queries, Returns, and Records
Adding Name, Vehicle, or Property Records

Reason
Enter an explanation for the change of custody.

Fields in the Comments tab
The following describes fields in the Comments tab of the Add Property Record screen.

Comments
Enter additional information associated with this record, or copy and paste information from another document. Misspelled words are underlined in red. Right-click the word to select the correct spelling.

Completing the Add Evidence Record screen
The Mobile record screens allow officers in the field to create Evidence records.

NOTE
The Evidence module is required to use this feature. Privileges are determined by your SAA.
Evidence records can be added to both Property and Vehicle records. The following steps use the Add Property Record screen, but the process is the same for both screens.

To add an Evidence record in Mobile:

1. Open the Add Property Record screen.

2. On the Property tab, select the Evidence check box.
   
The Evidence tab is enabled for the record.
3. Click the Evidence tab.

4. Complete the fields. For more information, see “Fields on the Evidence tab” on page 172.

5. Click Save.

The Evidence record is saved.

**NOTE**

If an Evidence record is modified in Mobile, then an Evidence History record is created in Flex as well. Once an Evidence record is saved, it can only be deleted from Flex. For more information, see the *Evidence Manual*.

**Fields on the Evidence tab**

**Record Type**

Select the record type using the drop-down list. For example, EVI - Evidence.

**Sequence number**

For records with multiple pieces of evidence, enter the sequence number for the current item. Depending on your agency’s settings, this field might be view-only.
Adding Name, Vehicle, or Property Records

Status Code
Select the status code for the item using the drop-down list. For example, Released.

When Status Declared
Displays the date and time when the status code for the evidence was modified. If necessary, modify this field using the `mm/dd/yyyy hh:mm:ss` format, or use the drop-down calendar.

Transaction Type
Select the transaction type using the drop-down list. For example, ROF - Released to Officer.

Transaction Date
Displays the date and time for the transaction. If necessary, modify this field using the `mm/dd/yyyy hh:mm:ss` format, or use the drop-down calendar.

Current Location
Select the current location for the evidence using the drop-down list. For example, COURT - Released for Trial.

Officer
Enter the name of the officer that collected the evidence, or select the officer using the drop-down list.

Current Custodian
Enter the name of the person responsible for the evidence item, or select the person using the drop-down list.

Property/Inv1 Description
Enter a description of the evidence. For example, Smith & Wesson Handgun.

Reason for custody change
If the evidence changes custody, then enter a reason for the change. For example, Transferred to SPD.
Validating a New Record

As Name or Vehicle records are imported or added in Mobile, the software runs an advanced search to validate new records against existing records to avoid duplicates. Validation acts as a safety net for officers against inaccurate reporting and is easy to do.

NOTE
To avoid potential duplicate records, follow your agency’s policy for proper searching.

Validating a new Name record

To validate a new Name record, the software runs an advanced search to determine whether the record matches any existing Name record.

For individuals, the software searches for the following:

- Social Security number
- Driver license number and state
- Date of birth
- Address

For businesses, the software searches for the following:

- Name
- Address
If a potential duplicate record exists, then the Name Validation screen opens and lists the potential duplicates in an area under the attempted record.

![Potential Duplicates area](Image)

The most likely match is listed at the top, but any record listed can be selected. A summary of the record is on the right, and matching data between the considered record and the potential duplicate is highlighted.

Based on the matching data, decide whether the attempted Name record is a duplicate record, an alias to one of the potential duplicates, or a new record.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The attempted Name record is a duplicate</td>
<td>Merge the two Name records. See “Merging a new Name record with an existing record” on page 176.</td>
</tr>
<tr>
<td>The attempted Name record is an alias for an existing record</td>
<td>Add the record as an alias. See “Adding a new Name record as an alias” on page 178.</td>
</tr>
<tr>
<td>The attempted Name record is not a duplicate</td>
<td>Ignore the potential duplicates and continue adding the record. See “Ignoring the existing Name record” on page 179.</td>
</tr>
<tr>
<td>Information needs to be edited or added for another search</td>
<td>Click the Close button to return to the Add Name Record screen.</td>
</tr>
</tbody>
</table>
**Merging a new Name record with an existing record**

If the Name Validation screen highlights several matches between the potential duplicate Name record and the attempted new Name record, then it is likely that the records are duplicates. Merge the attempted record with the existing Name record to avoid having duplicate records in the database. This also allows new information to be added to the existing record.

To merge the attempted Name record with an existing record:

1. With the existing Name record selected from the **Potential Duplicates** area, click the **Merge with this Name** button.

The existing record is updated using the following rules.

<table>
<thead>
<tr>
<th>If the attempted record</th>
<th>And the existing record</th>
<th>Then the software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains data in a field</td>
<td>Does not contain data in a field</td>
<td>Keeps the new data.</td>
</tr>
<tr>
<td>Does not contain data in a field</td>
<td>Does contain data</td>
<td>Keeps the old data.</td>
</tr>
<tr>
<td>Contains a new detail entry</td>
<td>Contains a matching detail entry</td>
<td>Keeps the old entry and discards the new entry.</td>
</tr>
</tbody>
</table>
Validating a New Record

If there are data conflicts, then the Name Merge screen opens.

<table>
<thead>
<tr>
<th>If the attempted record</th>
<th>And the existing record</th>
<th>Then the software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains a new detail entry</td>
<td>Does not match the detail entry</td>
<td>Appends the new entry to the end of the existing detail entries.</td>
</tr>
<tr>
<td>Contains new comments</td>
<td>Does or does not contain comments</td>
<td>Appends the new comments to the end of the comments.</td>
</tr>
<tr>
<td>Contains aliases</td>
<td>Does or does not contain aliases</td>
<td>Appends the new aliases.</td>
</tr>
<tr>
<td>Contains new data</td>
<td>Contains old data</td>
<td>Adds the data value to the Name Merge screen to be reconciled.</td>
</tr>
</tbody>
</table>

The Name Merge screen displays any conflicts between the two records that must be resolved before the existing record can be updated. For example, the new Name record has a different weight value and a different hair color value than the old record.

2. Determine which conflicting value to use in the record:
   - To keep the new value, leave it highlighted in the New column.
Validating a New Record

- To keep the old value, click the value in the **Old** column.

**TIP**
To select which values to keep using the keyboard, press Tab until the value to keep is highlighted, and then press the Spacebar.

In the following example, the old value for the eye color is correct. Therefore, click the value for the **Eyes** field in the **Old** column to select it.

In the following example, the old value for the eye color is correct. Therefore, click the value for the **Eyes** field in the **Old** column to select it.

3. With the correct values highlighted, click the **Merge** button.

The existing record is updated and the Name Validation and Add Name Record screens close. The updated Name record is displayed in Mobile.

**Adding a new Name record as an alias**

If the potential duplicate record contains some matches, but not enough to determine it is a duplicate, then it might be an alias for an existing record. For example, if the two records have the same driver license number, date of birth, and physical features, but the address and first name are different, then this
might be a situation where a nickname was entered, such as Bob instead of Robert. In this case, the person can be linked to the existing Name record as an alias.

To add the new Name record as an alias:

1. In the Potential Duplicates area, select the name record to add.
2. Click the Alias to this Name button.

The new Name record is linked with the existing record as an alias, and the Name Validation and Add Name Record screens close. The new Name record is displayed in the Involvements area in Mobile.

**Ignoring the existing Name record**

If the potential duplicate Name record contains some matching information, but not enough to determine that the individuals are the same person, then the potential duplicate record can be ignored and a new Name record created. For example, if there is a potential duplicate record for someone with the same driver license number issued by another state, but there is no other matching criteria, then it can be determined that the record is not a duplicate.
To ignore the potential duplicates and add a new record, click the **Ignore and Create New** button in the Name Validation screen.

The new Name record is added and the Name Validation and Add Name Record screens close. The new Name record is displayed in Mobile.

**Validating a new Vehicle record**

To validate a new Vehicle record, the software runs an advanced search to determine whether the record matches any existing Vehicle record.

For Vehicle records, the software searches for the following:

- Vehicle Identification Number (VIN)
- License Plate number
- State
If records are found with matching information, then the Vehicle Validation screen opens.

Any potential duplicate records are listed in the **Potential Duplicates** area, and matching data is highlighted.

Based on the matching data, decide whether the attempted Vehicle record is a duplicate record or a new record.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The attempted Vehicle record is likely a duplicate</td>
<td>Merge the two Vehicle records. See “Merging a new Vehicle record with an existing record” on page 182.</td>
</tr>
<tr>
<td>The attempted Vehicle record is not a duplicate</td>
<td>Ignore the validation and continue adding the record. See “Ignoring the existing Vehicle record” on page 184.</td>
</tr>
<tr>
<td>Information needs to be added or edited for another search</td>
<td>Click the <strong>Close</strong> button to return to the Add Vehicle Record screen.</td>
</tr>
</tbody>
</table>
Merging a new Vehicle record with an existing record

If the Vehicle Validation screen highlights several matches between the potential duplicate Vehicle record and the attempted new Vehicle record, then it is likely that the records are duplicates. Merge the attempted record with the existing Vehicle record to avoid having duplicate records in the database. This also allows new information to be added to the existing record.

To merge the attempted Vehicle record with an existing record:

1. With the existing Vehicle record selected from the Potential Duplicates area, click the Merge with this Vehicle button. The two records are merged using the following rules.

<table>
<thead>
<tr>
<th>If the attempted record</th>
<th>And the existing record</th>
<th>Then the software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains data in a field</td>
<td>Does not contain data in a field</td>
<td>Keeps the new data.</td>
</tr>
<tr>
<td>Does not contain data in a field</td>
<td>Does contain data</td>
<td>Keeps the old data.</td>
</tr>
<tr>
<td>Contains a new detail entry</td>
<td>Contains a matching detail entry</td>
<td>Keeps the old entry and discards the new entry.</td>
</tr>
</tbody>
</table>
Validating a New Record

If there are data conflicts, then the Vehicle Merge screen opens.

<table>
<thead>
<tr>
<th>If the attempted record</th>
<th>And the existing record</th>
<th>Then the software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains a new detail entry</td>
<td>Does not match the detail entry</td>
<td>Appends the new entry to the end of the existing detail entries.</td>
</tr>
<tr>
<td>Contains new comments</td>
<td>Does or does not contain comments</td>
<td>Appends the new comments to the end of the comments.</td>
</tr>
<tr>
<td>Contains new data</td>
<td>Contains old data</td>
<td>Add the data value to the Name Merge screen to be reconciled.</td>
</tr>
</tbody>
</table>

The Vehicle Merge screen displays any conflicts between the two records before the existing record can be updated. For example, the new Vehicle record has a different license plate, registration expiration, and make than the old record.

2. Determine which conflicting value to use in the merged record:
   - To keep the new value, leave it highlighted in the New column.
Validating a New Record

- To keep the old value, click the value in the **Old** column.

**TIP**
To select which values to keep using the keyboard, press Tab until the value to keep is highlighted, and then press the Spacebar.

In the following example, all of the new values are correct, except for the **License Plate** field. Therefore, click the value for the **License Plate** field in the **Old** column to select it.

3. With the correct values highlighted, click the **Merge** button.

The Vehicle record is updated and the Vehicle Validation and Add Vehicle Record screens close. The Vehicle record is displayed in Mobile.

*Ignoring the existing Vehicle record*

If the potential duplicate record contains some matching information, but not enough to determine that it is the same vehicle, then the potential duplicate record can be ignored and a new Vehicle record created. For example, if there is a potential duplicate record for a vehicle with the same license plate, but it has a different VIN and issuing state, then it can be determined that the record is not a duplicate.
To ignore the potential duplicates and add a new record, click the **Ignore and Create New** button in the Vehicle Validation screen.

The new Vehicle record is added and the Vehicle Validation and Add Vehicle Record screens close. The new Vehicle record is displayed in Mobile.
Chapter 4

Automated Field Reporting

Introduction  188
Completing a Form  189
Using Form Features  193
Introduction

The Automated Field Reporting module (AFR) can be used to enter information about certain events, such as a field interview, in Mobile. When a form is selected, a pre-filled PDF form is opened. Fill in any incomplete information and save the form.

When the AFR form is saved, the Accidents, Citations, and Warnings XML Interface is used to create the necessary records in the database. The form is also attached to a record. If your agency uses the Workflow feature, then a Workflow record is created for the responsible officer and, where applicable, the record is sent to the state when final approval is received.

The AFR module is purchased separately from Mobile. To use AFR forms, your computer must have Adobe Acrobat Reader 8.0 or greater installed. Contact your SAA to find out if your agency uses the AFR module.

NOTE
This chapter refers to the Automated Field Reporting module, which uses PDF versions of state forms.

For information on the Mobile Field Report, Field Interview, Fire Field Interview, and Arrest forms, see the Mobile Field Report and Forms Manual. For information on submitting State eCitation and State Crash forms, see the Mobile State eCitation and State Crash Forms Manual.

The forms described in the Mobile Field Report and Forms Manual and Mobile State eCitation and State Crash Forms Manual are integrated with Mobile and do not use Adobe PDFs.
Completing a Form

Forms can be customized by your SAA with your agency’s name, graphics, and report titles. When the form is completed and saved, the data collected is sent to the database. Depending on the settings established by your SAA, electronic workflow might be initiated to begin the approval process.

To complete a form:

1. Open the form. See “Opening a form” on page 189.
2. Enter information to complete the form. See “Using Form Features” on page 193.
3. When finished, click Save.

The following occurs:

– The form is saved to your database and records are created as applicable using information from the form.
– If workflow is set up by your SAA, then the record for the form enters workflow in the Message Center for approval.

NOTE

If the Save as Draft button is clicked, then the form is saved as a draft in the Draft Forms folder of the Message Center. To avoid inaccurate data, drafts should be completed in a timely manner.

4. If desired, to print the form, click Print.

The Print dialog box opens.

5. Configure your printer settings, and then click Print.

Opening a form

Mobile forms can be opened from the Actions menu in the Message Center, or from the Field Reports screen.

To open a form:

1. Complete one of the following:

   – In the Message Center, from the menu bar, select Actions > Form > Field Reports.
   – From the Mobile toolbar, click the Field Reports icon.
The Field Reports screen opens.

2. Select the form to complete. For an explanation of available forms, see “Choosing a form” on page 191.

The selected form opens.
Choosing a form

The form to choose depends on the type of data being collected.

The following forms are available:

- “General Use Warnings form” on page 191
- “General Use Law form” on page 191
- “General Use Field Interview form” on page 191
- “General Use Fire Field Interview form” on page 192
- “General Use Citation form” on page 192
- “General Use Accident form” on page 192

NOTE
Other forms might be available and can vary by state. For more information on specific state forms, contact your SAA.

General Use Warnings form

The Warnings form is used to collect the following information:

- Warnings
- Comments
- Name information
- Vehicle Information
- Property Information

General Use Law form

The Law form is used to collect the following information:

- Law Incident information
- Narratives
- Supplemental narratives
- Name information
- Vehicle information
- Property information

General Use Field Interview form

The Field Interview form is used to collect the following information:

- Field interview information
- Name information
- Vehicle information
General Use Fire Field Interview form

The Fire Field Interview form is used to collect the following information:

- Fire field interviews
- Name information
- Vehicle information

General Use Citation form

The Citation form is used to collect the following information:

- Citations
- Comments
- Name information
- Vehicle information
- Property information

General Use Accident form

The Accident form is used to collect the following information:

- Accident data
- Crash diagrams
- Road information
- Narratives
- Name information, including crash-specific data elements
- Vehicle information, including crash-specific data elements
- Property information
Using Form Features

Mobile forms have many features that simplify the process of completing forms.

Use any of the following features to complete a form:

- “Using fields with drop-down lists” on page 193
- “Expanding form areas” on page 194
- “Adding fields” on page 195
- “Writing narratives” on page 195
- “Using action buttons” on page 195

Using fields with drop-down lists

Some fields contain drop-down lists with options to quickly fill out multiple form fields from database records. Drop-down lists with the ability to fill out multiple form fields are highlighted in blue.

Information that can be imported includes:

- **CAD call information.** Some fields, such as the Address field, provide the option of importing information from the current CAD call.

- **Name records.** Some fields, such as the Last Name field, provide the option of importing Name record information by selecting from a drop-down list of names queried in the current Mobile session.

- **Vehicle records.** Some fields, such as the Plate/State field, provide the option of importing Vehicle record information by selecting from a drop-down list of vehicles queried in the current Mobile session.

- **Categorized code selections.** Some fields, such as the Offense(s) field, provide the option of importing code information from a drop-down list.
Other fields that are not highlighted might contain drop-down lists with pre-determined values to meet the requirements of your state.

Expanding form areas

Some areas contain hidden fields for additional information and can be expanded. Expandable areas are indicated by a blue triangle and text, such as the More button.

To expand the area and enter additional details in a form, or to collapse the expanded area, click More.

The button names vary depending on the area being completed and the form being used. For example, to complete the Signature area in the Citation form, at the bottom of the form, click Signature Block.
Adding fields

Some fields can be duplicated to add more information. For example, multiple Offense(s) fields can be added.

![Field Adding Example]

Use the **Add (+)** button to add fields or the **Remove (-)** button to remove fields that have been added.

Writing narratives

Narrative fields can be completed with an unlimited amount of text, and your SAA can load templates to use for collecting specific information. To use a template, click the **Template** button. The narrative section expands to fit the amount of text entered.

Using action buttons

Action buttons are found at the bottom of each page to which they are applicable.

The following table lists the action buttons available on AFR forms and a description of what they do.

<table>
<thead>
<tr>
<th>Action Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Form</td>
<td>Sends the complete form to the default printer.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the form to the database.</td>
</tr>
<tr>
<td>Save as Draft</td>
<td>Saves the form to the computer on which it is being drafted.</td>
</tr>
<tr>
<td>Show Property</td>
<td>Reveals a Property sub-form to enter an unlimited number of property items.</td>
</tr>
<tr>
<td>Show Supp Narr</td>
<td>Adds the first supplemental narrative to the form.</td>
</tr>
<tr>
<td>Show Vehicle</td>
<td>Reveals a Vehicle sub-form to enter an unlimited number of vehicles.</td>
</tr>
</tbody>
</table>
Chapter 5

Voiceless CAD and Mobile Mapping

Introduction 198
Understanding the CAD Screen 200
Adding and Completing Calls in Voiceless CAD 206
Understanding the CAD Call Information Screen 226
Using the Radio Log 230
Using the Mapping Module 234
Working with Map Layers 252
Introduction

The Mobile Voiceless CAD module and the Mobile Mapping module are purchased separately from Mobile.

The Voiceless CAD module lets dispatchers assign calls to a unit without using the radio. This frees up air time for high-priority calls and still ensures that all the information needed to respond to calls is received. Depending on your privileges, new calls can also be added from Voiceless CAD.

The Mobile Mapping module allows the location of your agency’s calls to be viewed on a map of your jurisdiction. The map is integrated with Mobile so that officers, firefighters, dispatchers, and supervisors who have access to Mobile can view the map. If your agency has the Automatic Vehicle Location (AVL) module, then the location of each unit that has a GPS receiver can also be viewed. If your agency has the Motorola Unified Network Service (UNS) interface, then UNS devices can be viewed. For more information on the AVL module and the UNS interface, see the Automatic Vehicle Location (AVL) Manual.

This chapter describes the following:

- “Assigning Yourself to a Unit” on page 199
- “Understanding the CAD Screen” on page 200
- “Adding and Completing Calls in Voiceless CAD” on page 206
- “Understanding the CAD Call Information Screen” on page 226
- “Using the Radio Log” on page 230
- “Using the Mapping Module” on page 234
- “Working with Map Layers” on page 252
Assigning Yourself to a Unit

Depending on the settings configured by your SAA, while logging into Voiceless CAD, you can assign yourself to a unit.

To assign yourself to a unit, while logging in, enter the unit number.

**NOTE**

When you assign yourself to a unit that is already assigned to another user, that user is unassigned from the unit.

If you are unable to assign yourself to a unit, then contact your SAA.
Understanding the CAD Screen

The CAD screen contains information about assigned calls, unassigned calls, and the status of units for your agency.

To view call and unit information at a glance, complete any of the following:

- “Opening the CAD screen” on page 200
- “Working with CAD detail grids” on page 201
- “Viewing the backup units dispatched to a call” on page 203
- “Understanding StateLink alerts in the CAD screen” on page 204

Opening the CAD screen

To open the CAD screen, do one of the following:

- Select Screens > CAD.
- Click the CAD button.
- Press F5.

The CAD screen contains the following:

- **CAD toolbar.** Displays shortcut buttons for CAD actions, such as the New Call button.
- **Calls area.** Displays the current calls based on your preferences. See “Filtering the Calls area” on page 202.
• **Units area.** Displays the current units based on your preferences. See “Filtering the Units area” on page 203.

**Working with CAD detail grids**

The CAD screen displays call and unit information in a detail grid. The columns, rows, and font size of the Calls area and Units area can be changed. Information in any column can be sorted, and the calls and units displayed can be filtered.

To change the font size, see “Setting Voiceless CAD Options” on page 286. Otherwise, to customize the way call and unit information is displayed, complete any of the following:

- “Sorting calls and units” on page 201
- “Resizing columns” on page 202
- “Resizing rows” on page 202
- “Filtering the Calls area” on page 202
- “Filtering the Units area” on page 203

**Sorting calls and units**

The list of calls can be sorted by the following columns:

- Call Number
- Location
- Zone
- Status
- Nature
- City
- Priority
- Unit

The list of units can be sorted by the following columns:

- Unit
- Time
- Zone
- Location
- Status
- Call Number
- Agency
- Description
To sort a list of calls or units, click the heading of the column by which to sort. A small triangle appears on the heading, indicating whether the order is ascending or descending. To reverse the order of the sort, click the heading again.

**Resizing columns**

Columns can be resized to view more or less information.

To resize a column:

1. At the column header, rest the mouse pointer on the vertical line to be moved.
   
   The mouse pointer becomes a vertical line with horizontal arrows.
2. Drag the column to the desired size.
   
   The column remains resized until it is changed again, even if the Mobile session is ended.

**Resizing rows**

Rows can be resized to view more or less information.

To resize rows:

1. At the beginning of a row, rest the mouse pointer on a horizontal line separating two rows.
   
   The mouse pointer becomes a horizontal line with vertical arrows.
2. Drag the row to the desired size.
   
   All rows are changed to the specified size. The rows remain resized until they are changed again, even if the Mobile session is ended.

**Filtering the Calls area**

The **Calls** area can be filtered by category. To filter the **Calls** area, from the menu bar, select **CAD > Call Filters**, or right-click the **Calls** area, and then select the desired category. A check mark is displayed next to the current filter.

Calls can be filtered by the following categories:

- To view only calls assigned to your unit, select **My Unit's Calls**.
- To view only calls assigned to the officers in your zone, select **My Zone's Calls**.
- To view only calls assigned to the officers in your agency, select **My Agency's Calls**.
• To view only calls assigned to other units, select **Other Unit's Calls**. The Set Unit Filter dialog box opens. Select the check boxes for the units whose calls should be displayed, and then click **OK**.

• To view only calls assigned to other zones, select **Other Zone's Calls**. The Set Zone Filter dialog box opens. Select the check boxes for the zones whose calls should be displayed, and then click **OK**.

• To view only calls assigned to other agencies, select **Other Agency's Calls**. The Set Agency Filter dialog box opens. Select the check boxes for the agencies whose calls should be displayed, and then click **OK**.

• To view all the calls assigned by your dispatch center, select **All Calls**.

**Filtering the Units area**

The **Units** area can be filtered by category. To filter the **Units** area, from the menu bar, select **CAD > Unit Filters**, or right-click the **Units** area, and then select the desired category. A check mark is displayed next to the current filter.

Calls can be filtered by the following categories:

• To view all the units in your zone, select **My Zone's Units**.

• To view all the units in your agency, select **My Agency's Units**.

• To view all the units other zones, select **Other Zone's Units**. The Set Zone Filter dialog box opens. Select the check boxes for the zones whose units should be displayed, and then click **OK**.

• To view all the units in other agencies, select **Other Agency's Units**. The Set Agency Filter dialog box opens. Select the check boxes for the agencies whose units should be displayed, and then click **OK**.

• To view all the units dispatched by your dispatch center, select **All Units**.

**Viewing the backup units dispatched to a call**

To view the backup units dispatched to a call:

1. In the **Calls** area, select a call.

2. From the CAD toolbar, click the **Responding Units** button.
The Responding Units list screen opens. All units dispatched to the call, the unit status, call information, and unit contact information is displayed. The responsible unit is marked with an asterisk (*).

Use the scroll bar to view the information. If more units are assigned to the call than fit in the dialog box, then use the Up Arrow or Down Arrow key or the scroll bar to scroll through the list of assigned units.

3. Click OK or press Enter to close the Responding Units list screen.

**Understanding StateLink alerts in the CAD screen**

In the CAD screen, when an officer receives a return with a StateLink alert, the officer’s unit flashes in the **Unit** area, even if the officer has not opened the return in Message Center. The unit flashes by alternating between its normal colors and the inverted colors. This feature is determined by the setup established by your SAA and your Mobile options. For more information, see “Enabling flashing StateLink alerts” on page 287.

If a unit receives multiple StateLink alerts, then only the alert with the highest priority is displayed. Your SAA determines the priority level of the alerts.
In the Description column, the text of the alert is displayed, such as Stolen Vehicle. The StateLink alert is dismissed when the status of the unit is updated.
Adding and Completing Calls in Voiceless CAD

This section describes how to use Voiceless CAD to add and complete calls in Mobile.

To use Voiceless CAD, complete any of the following:

- “Viewing a CAD call” on page 206
- “Receiving CAD calls” on page 207
- “Becoming the Responsible Unit” on page 208
- “Updating your unit status” on page 209
- “Modifying a call” on page 210
- “Completing a CAD call” on page 214
- “Reactivating a call” on page 215
- “Assisting another unit as a backup unit” on page 217
- “Using the Add a CAD Call feature” on page 218
- “Using the Assign Self to Call feature” on page 222
- “Using the On-Site Call feature” on page 224

To use the CAD radio log, see “Using the Radio Log” on page 230. To personalize your CAD screen, see “Setting Voiceless CAD Options” on page 286.

Viewing a CAD call

When a call in the Calls area is selected, the CAD Call Information screen opens and detailed information about that call is displayed.

To view a call, do one of the following:

- Double-click the call.
- Use the Up Arrow or Down Arrow key to highlight the call, and then press Enter.
- From the menu bar, select **CAD > View Call** or **CAD > My Call**.
- Click the My Call button.

The CAD Call Information screen opens.

![CAD Call Information Screen](image)

The Call Number, nature, address, and responsible unit are displayed. To see a list of responding units, click the Responding Units button. For more information on responding units, see “Viewing the backup units dispatched to a call” on page 203. Tabs below the call address contain additional information about the call and location, such as contact information and any Law Incident involvements. For more information, see “Understanding the CAD Call Information Screen” on page 226.

**Receiving CAD calls**

The dispatcher can assign your unit as either the responsible unit or a backup unit for a call. In the Units area of the CAD screen, calls assigned to your unit are highlighted blue. The number of the responsible unit is displayed in the Unit column on the CAD screen. Depending on your settings, when a dispatcher assigns a call to your unit, a sound notification might occur.

If a higher-priority call than the call currently being worked is assigned to your unit, then the higher-priority call becomes your active call. Depending on the setup established by your SAA, one of the following occurs to your original call:

- Your unit is removed from the original call, and the status of the call is changed to RCVD so that the dispatcher can assign it to another unit.
Adding and Completing Calls in Voiceless CAD

- The original call remains assigned to your unit, and the status of the call is changed to **ASSGN**. If your unit is the responsible unit, then your unit number remains in the **Unit** column. After the higher-priority call is completed, the original call can be resumed. For more information, see “Reactivating a call” on page 215.

**Becoming the Responsible Unit**

Depending on the settings established by your SAA, officers can assign themselves as a responsible unit for a call. The officer changing the responsible unit must already be dispatched to the call, and of the same type as the call and the current responsible unit.

To make yourself the responsible unit for a call:

1. In Voiceless CAD, in the **Calls** area, select the desired call.
2. From the CAD toolbar, click the **Become Responsible Unit** button. A confirmation dialog box opens.

3. Click **OK**.

   The following occurs:
   - Your unit is made the responsible unit for the call.
   - The **Responsible Officer** field in the Law Incident record is updated.
   - The previous responsible officer is notified of the change through a message in the Message Center, and remains on the call as an assisting unit.
Updating your unit status

When a dispatcher assigns a call to your unit—whether your unit is the responsible unit or a backup unit—the status of your unit must be updated. Your SAA creates a status sequence to update your unit to the next appropriate status. The Unit Status button on the CAD toolbar and the Unit Status option in the CAD menu both reflect the next status in the sequence.

To update your unit to the next status in the sequence, do any of the following:

- From the CAD toolbar, click the Unit Status button.
- From the menu bar, select CAD > Unit Status, where Unit Status is the next status in the sequence.
- Press F9.

The radio log can also be used to update the status of your unit if the next status in the sequence is not the correct status. For more information, see “Using the radio log to update your unit status” on page 209.

Using the radio log to update your unit status

The radio log can be used to update your status if the next status in the status sequence is not your next status due to the circumstances of your call. For example, if the Unit Status button displays ARRVD, but the correct status is ENRT.

To update your unit status using the radio log:

1. Do any of the following:
   - From the CAD toolbar, click the Radio Log button.

NOTE

If your next available status is CMPLT, then see “Completing a CAD call” on page 214.
– From the menu bar, select **CAD > Radio Log Entry**.

– Press F8.

The Radio Log Entry dialog box opens with the next available status populated in the **Ten-Code** field.

2. Complete the following fields:

   – In the **Ten Code** field, select the correct status from the drop-down list.

   – In the **Comments** field, enter the call comments.

3. Click **OK**, or press Enter.

   The Call record and radio log are updated with the new status and call comments.

---

**Modifying a call**

The nature and address for a call can be modified in Mobile.
Depending on the settings established by your SAA, the changes made to the call affect only your assigned call type, or affect all call types connected to the call. If your agency dispatches calls for multiple disciplines, then the most common setting is to change only the assigned call type. Contact your SAA to confirm the settings for your agency.

**NOTE**

If your agency has set up this feature to modify all types connected to a call, then the following limitations apply:

- When the address for the call is updated, all zones are changed for all call types.
- If a call type is removed in Flex CAD, then when the call is modified in Mobile Voiceless CAD, the removed call type is also modified and the call is recreated.
- When a call is modified, the changes apply to only those call types that have not been modified using the MT command in Flex CAD.

**Modifying a call in Mobile**

Depending on the settings for your agency, either the nature, address, or both for your assigned call can be modified in Mobile.

To modify a call:

1. Do one of the following:
   - From the CAD screen, in the **Calls** area, right-click the desired call, and then select **Modify Call**.
   - From the CAD Call Information screen, from the CAD toolbar, click the **Modify Call** button.
Adding and Completing Calls in Voiceless CAD

The Modify Call screen opens.

2. Do any of the following:
   – In the **Nature** field, enter a new nature or select a value from the drop-down list.
   
   **NOTE**
   
   The new nature must have the same call type as the previous nature.

   – In the **Street** field, enter the new address for the call. Do one of the following:
     – If your agency does not maintain a geobase, then complete the **City** and **Zone** fields for the new address as needed.
     – If your agency maintains a geobase, then the Address Selection window opens. Select the correct address, and then click **Select**. Otherwise, click **Don’t Validate** to skip validation. The city and zone for the call is updated after the address is validated, if necessary.

3. Click **Save**.
The Modify Call screen closes and your changes are applied. The call comments are updated with an urgent comment, indicating the change made, the date and time, and who made the change.

In CAD, the Dispatched Calls window is updated, and the Stat column flashes red until the new comments are viewed.

**Viewing changes to a closed call**

To view changes after the call is closed, do one of the following:

- If your SAA has set up this feature to modify the call type for the assigned call only, then open the Call History screen and select the record for the call type.
- If your SAA has set up this feature to modify all types connected to the call, then open the Call record.
Completing a CAD call

When the responsible officer is finished with a call, the call can be completed in Mobile instead of notifying the dispatcher.

**NOTE**
If your next available status is not CMPLT, then see “Updating your unit status” on page 209.

To complete a call as the responsible officer:

1. Do one of the following:
   - From the CAD toolbar, click the **Unit Status** button.
   - From the menu bar, select **CAD > Unit Status**.
   - Press F9.

   The Complete Call dialog box opens.

2. Complete the following fields:
   - **Disposition**: Enter a disposition, or select a value from the drop-down list.
   - **Observed**: If the observed offense is different than the offense that was dispatched, then enter an offense, or select a value from the drop-down list.
Adding and Completing Calls in Voiceless CAD

- **Clearance**: Enter the clearance code that describes how the incident was cleared, or select a value from the drop-down list.

- **Circumstance**: Enter the correct circumstance code for the incident, or select a value from the drop-down list.

- **Call Comments**: Enter any comments about the call.

3. Click **OK**.

The comments are added to the **CAD Call Comments** field in the CAD Call Information screen, and are appended to the related Call record with the time, date, and name of the responsible officer.

Because new comments always appear at the bottom of the **Call Comments** field, the CAD screen scrolls to the bottom by default so any new information can be seen without having to scrolling through the entire list. To change this setting, see “Changing the default view for call comments” on page 286.

The information from the **Disposition**, **Observed**, **Circumstance**, **Clearance**, and **Comments** fields are added to the related Law Incident record in your agency’s database. Comments are located in the **Supplements** area of the Law Incident screen.

**NOTE**

Calls can also be completed by using the methods described in “Using the radio log to update your unit status” on page 209. However, the **Disposition**, **Observed**, **Clearance**, and **Circumstance** fields are available only in the Complete Call screen.

### Reactivating a call

If a higher-priority call than the call currently being worked is assigned to your unit, then the higher-priority call becomes your active call. If your agency allows multiple calls to be assigned to one unit, then the original call remains assigned to your unit and that call's status changes to **ASSGN**. Depending on how your software is set up, the original call can be reactivated after the higher-priority call is finished.

To reactivate a call:

1. Do one of the following:
   - From the CAD toolbar, click the **Next Call** button (Ctrl+U).
   - From the menu bar, select **CAD > My Next Call**.
– In the Calls area, select the call to reactivate. Right-click the call, and then select Select My Next Call (Call#), where Call# is the Call Number assigned to the call being reactivated.

The Select My Next Call dialog box opens.

2. Complete the following fields:
   – **Call Number**: If necessary, select the call to reactivate from the drop-down list. By default, the Call Number for the selected call is populated.
   – **New Status**: If necessary, enter your unit’s status or select a value from the drop-down list. By default, a status is populated according to the sequence set up by your SAA.
   – **Comments**: Enter any comments regarding the call.

3. Click **OK**.

The Select My Next Call dialog box closes. In the CAD screen, the your unit’s status is updated to show assigned to the reactivated call.

---

**Viewing upcoming scheduled events**

As part of the Recurring Scheduled CAD Events feature in CAD, events scheduled in the next 24 hours can be viewed Voiceless CAD.

To view CAD events scheduled in the next 24 hours:

1. Do one of the following:
   – From the menu bar, select **CAD > Scheduled Events**.
   – From the CAD toolbar, click the **Events** button.

The Scheduled Events list screen opens, and a list of events scheduled to occur in the next 24 hours is displayed.
2. Use the scroll bar to review all the information in the screen.
3. Click **OK** to close the screen.

**Filtering upcoming scheduled events**

The Scheduled Events list screen can also be filtered using the existing call filters. After a filter is selected, open the Scheduled Events screen. A list of events scheduled to occur in the next 24 hours are displayed according to the selected filter. For more information, see “Filtering the Calls area” on page 202.

**Assisting another unit as a backup unit**

To assist another unit on a call as backup, use the **Assist** button. The **Assist** button is not available if your unit is currently assigned to a call.

To assist another unit as a backup unit:

1. From the CAD toolbar, click **Assist**.
   
   The Assist Other Unit dialog box opens.

2. In the **Unit to Assist** field, enter the unit to assist, or select a value from the drop-down list.
3. Click **OK**.
   
   If the unit being assisted is not assigned to a call, then your unit status is set to the same as the unit being assisted. If the unit being assisted is assigned to a call, then your unit status is set to **ARRVD**.
   
   The Radio Log comments displays the following:

   **Assisting Unit xx**
   
   where **xx** is the unit being assisted.
4. When done assisting, click the **Unit Status** button to complete the call.
The call remains on the CAD screen until the responsible officer for the other unit completes the call. In the Units area, your unit status is updated to ONDT.

**Using the Add a CAD Call feature**

The Add a CAD Call feature allows officers to create a call in Voiceless CAD without calling Dispatch, saving time for the officer and the dispatcher. Once created, the call appears in both the Flex and Mobile CAD screens so that the dispatcher and officer have the same call information.

To simplify the call creation, the software uses default information for some fields based on settings and previous entries. For example, if an officer recently created a call with a nature of Traffic Violation, then the default entry for the Nature field would be Traffic Violation the next time the Add a New Call Record window is opened.

To use the Add a CAD Call feature:

1. Do one of the following:
   - From the CAD toolbar, click **New Call**.

   **NOTE**

For the Add a Call feature to be available, Mobile must be opened without opening Flex first.
Right-click the **Calls** area, and then select **New Call**.

**NOTE**

By default, the **New Call** button is not displayed on the main toolbar. However, the toolbar can be customized to include the button. For more information about adding buttons to the toolbar, see “Using the Commands tab” on page 266.

The Add A New Call Record screen opens.

2. Complete the appropriate fields. Some fields are automatically completed based on the default settings or the last call created. However, fields can be modified as needed. For field descriptions, see “Fields on the Add A New Call Record screen” on page 220.

3. When finished, click **Submit**.

A new call record is created. If sufficient license plate information was entered, then the software also sends a vehicle query. The new
Adding and Completing Calls in Voiceless CAD

A new call is displayed in the CAD Call Information screen in Mobile and the Dispatched Calls screen in Flex, and the new call is highlighted.

NOTE
If the address has not been validated, and your agency maintains a geobase, then the Address Selection window opens. To validate the address, select the correct address, and then click Select. To proceed with the non-validated address, click Don't Validate.

Fields on the Add A New Call Record screen

The following describes the fields on the Add A New Call Record screen.

**Nature**
Displays the purpose of the call. By default, this field is completed automatically. However, this field can be modified. Enter a new nature or select a code from the drop-down list.

NOTE
By default, the software uses the value from the previous call in the current Mobile session. If this is the first new call record for this Mobile session, then the default value determined by your SAA is used.

**Status**
Displays the current ten code for the unit. By default, this field is completed automatically. However, this field can be modified. Enter a new status or select a ten code from the drop-down list. Your SAA determines the default value.

**Address**
Enter the street number and name for the call. If your agency uses the Automatic Vehicle Location (AVL) module and the Classic Geobase or GeoValidation module, then the software attempts to populate the field with your Global Positioning System (GPS) coordinates. The ten most recently used addresses from the current Mobile session are stored and can be selected from the drop-down list.

To validate the address:

1. With an address entered, click Validate.
The Address Selection window opens.

![Image of Address Selection window]

2. Select the correct address, and then click **Select**. Otherwise, click **Don't Validate** to continue without validating the address.

A marker is displayed in the field for validated addresses.

**NOTE**

If the software used GPS coordinates for the address, then addresses that match the GPS coordinates are displayed.

City

Enter the city where the call occurred. If the address was validated, then this field is completed automatically.

State

Enter the two-letter postal code for the state where the call occurred. If the address was validated, then this field is completed automatically.

Zip

Enter the five-digit ZIP code where the call occurred. If the address was validated, then this field is completed automatically.

License Plate

Enter the vehicle’s license plate. This field is optional. However, if this field is not completed, then a vehicle query is not performed.
License State

By default, this field is completed automatically with your agency’s state. If necessary, enter the two-letter postal abbreviation for the state that issued the license plate, or select a value from the drop-down list. This field is optional, and the information is used when running a vehicle query.

License Type

Select a value from the drop-down list that best describes the type of license required to operate the vehicle. For example, Motorcycle or CDL. This field is optional, and the information is used when running a vehicle query.

License Year

Enter the four-digit year in which the vehicle’s registration expires using the yyyy format. For example, 2013. This field is optional, and the information is used when running a vehicle query.

Using the Assign Self to Call feature

The Assign Self to Call feature allows officers to select an unassigned call and take responsibility for it. For example, if an officer is sitting at an intersection completing paper work and notices an unassigned call close to the unit’s
location, then the officer can click the Assign Self button and take responsibility for the call. This feature allows units to respond quickly, and minimizes the time dispatchers spend evaluating unit locations for calls.

To assign your unit to a call:

1. In the CAD screen, select the call to assign.
2. Do one of the following:
   - Click Assign Self.
   - Right-click the call and then select Assign Self to Call.

   The Radio Log Entry dialog box opens, and the Ten Code field displays the default entry.
3. If necessary, complete the following fields:
   - Ten Code: Enter a new value, or select a value from the drop-down list.

   NOTE
   For the Assign Self to Call feature to be available, Mobile must be opened without opening Flex first.

   NOTE
   The Assign Self button is only enabled after a call is selected. In addition, the button is disabled if the selected call is already dispatched to another unit.
Adding and Completing Calls in Voiceless CAD

- **Comments**: Enter additional information about the call.

4. Select **OK**.

The call status is updated to the selected ten code and your unit is assigned to the call.

**Using the On-Site Call feature**

The On-Site Call feature allows a new Call record to be immediately created using default settings.

![On-Site Call button](image)

**NOTE**

For the On-Site Call feature to be available, Mobile must be opened without opening Flex first.

To create an on-site call, from the CAD toolbar, click the **On-Site Call** button.

The new call is created using the default settings determined by your SAA and appears in the CAD screen. Your unit status is updated to show assigned to the call.

**NOTE**

The call’s **Nature** and **Status** fields are generated from the default settings determined by your SAA. The **Address** field is generated from the nearest address to the unit’s GPS coordinates.
If the default values for the **Nature** and **Status** fields are invalid, or if the **Nature** field setting established by your SAA requires license plate information, then the **On-Site Call** record is not created, and the Add A New Call Record window opens.

If the Add a New Call Record window opens, then the fields must be completed. For more information, see “Fields on the Add A New Call Record screen” on page 220.
Understanding the CAD Call Information Screen

The CAD Call Information screen contains historical information regarding the location of the call and any involvements. This information allows officers to view the full call history of a location before arriving on scene, and allows units to be dispatched more effectively.

The CAD Call Information screen contains the following tabs:

- **Info.** Displays the nature of the call, the responsible unit, and any comments entered by the dispatcher.

- **Contacts.** Displays the contact information for the complainant, including the phone number and address. Click the Name link to view the complainant's Name record.

- **Other.** Displays the time and date the incident occurred, the time and date it was reported, who received the call, the CAD call ID, zone, agency, the incident number assigned by the dispatcher, the call priority, directions to the call location, and cross street information.

- **Law Incidents.** Displays up to 30 of the most recent incidents that have occurred at the same address as the call. For each incident, the Incident
Number, call nature, date reported, responsible officer, and complainant are displayed.

This tab is available depending on the privileges established by your SAA, whether your agency maintains a geobase, and whether the address of the call exists in the geobase.

- **Fire Incidents.** Displays up to 30 of the most recent fire incidents that have occurred at the same address as the call. For each incident, Mobile displays the Incident Number, call nature, date reported, responsible officer, agency, disposition, and complainant.

  This tab is available depending on the privileges established by your SAA, whether your agency has the Classic Geobase or GeoValidation module, and whether the address of the call exists in the geobase.

- **EMS Incidents tab.** Displays up to 30 of the most recent EMS incidents that have occurred at the same address as the call. For each incident, Mobile displays the Incident Number, call nature, date reported, responsible officer, agency, disposition, and complainant.

  This tab is available depending on the privileges established by your SAA, whether your agency has the Classic Geobase or GeoValidation module, and whether the address of the call exists in the geobase.

- **Names tab.** Displays a list of the persons who are associated with the call address. This tab is available only if your agency has the Classic Geobase or GeoValidation module and the address of the call exists in the geobase.

- **Premises tab.** Displays any Premises records that have the same address as the call. This tab is available only if your agency has the Mobile Premises Information module.

- **Hazmat tab.** Displays any hazardous materials that might be stored on the premises. This tab is available only if your agency has the Mobile Premises Information module and has licensed and installed CAMEO.

---

**Opening a record from the CAD Call Information screen**

Records can be opened using the tabs on the CAD Call Information screen. Some tabs, such as the Law, Fire, and EMS Incidents tabs, are available only if your agency maintains a geobase and the address of the call exists in the geobase.

To open a record from the CAD Call Information:

1. From the main toolbar, click the CAD button.
2. Double-click the call to view, or use the Up Arrow or Down Arrow key to highlight the call in the **Calls** area, and then press Enter.

3. Click the desired tab. The following tabs can be used to open records in Mobile:

   - Law Incidents
   - Fire Incidents
   - EMS Incidents
   - Names
   - Premises
   - Hazmat

4. To open the record, do one of the following:
   
   - Double-click the record in the list.
   - Use the Up Arrow or Down Arrow key to highlight the record, and then press Enter.

   The selected record is displayed.

5. To return to the CAD Call Information screen, click the **Back** button (Ctrl+Left Arrow).
Using the Incident # button on the Other tab

When viewing the CAD Call Information, the Other tab displays the Incident Number associated with the call within the Incident # button. To open the incident, click the Incident # button.

NOTE
To use the Incident # button, Access privileges for the associated incident screen are required.

If the CAD call does not have an associated incident, then the Incident # button displays Get Incident. Click the Incident # button to create an Incident Number and link the incident to the call. The type of incident created matches the dispatched unit type, either Law, Fire, or EMS.
Using the Radio Log

Each time your unit's status is updated, the software creates a radio log entry. Radio log entries contain specific information about your unit's activities. To track the activity of your agency's units, the radio log entries for your unit, zone, or agency can be viewed.

Depending on the settings established by your SAA, radio log entries can also be made in Offline mode. For more information, see “Using client time for radio log entries” on page 231.

Sorting radio log entries

Radio log entries can be sorted by time and date, Call ID, type, unit, code, zone, and description.

To sort your radio log entries, click the heading of the column by which to sort. A small triangle appears on the heading, indicating of the order is ascending or descending. To reverse the order of the sort, click the heading again.

Viewing radio log history

Use the Radio Log History screen to view the radio log entries for your unit, the units in your zone, or all the units in your agency.

To view radio log history:

1. Do one of the following to open the Radio Log History screen:
   - Select Screens > Radio Log History.
   - Press Shift+F8.
   - Click the Radio Log History button.

   The Radio Log History screen opens, and the radio log entries are displayed.

2. If a call ID is listed on the radio log, then on the radio log list, do one of the following:
   - Double-click the radio log to view.
   - Select the radio log, and then press Enter.
   - Select the arrow next to the desired call, and then select Radio Log History > View Call.
Selecting the radio logs to display

Radio logs can be filtered by type.

To select the radio log entries to be displayed:

1. Do one of the following to display the radio log Filters menu:
   - From the menu bar, select **Radio Log History > Filters**.
   - From the Radio Log History screen, right-click any radio log entry.

2. From the Filters menu, select the category to be displayed.
   - To display only call entries for your unit, select **My Unit History w/Calls**.
   - To display only call entries for your zone, select **My Zone History w/Calls**.
   - To display only call entries for your agency, select **My Agency History w/Calls**.
   - To display all entries for your unit, select **My Unit History**.
   - To display all entries for your zone, select **My Zone History**.
   - To select all entries for your agency, select **My Agency History**.

A check mark appears next to the current filter.

Using client time for radio log entries

Depending on the settings established by your SAA, the time on your Mobile client can be used for radio log updates instead of the time on the server. This is useful for agencies that have areas where the network connection is not good and communication with the server is lost, putting Mobile in Offline mode.

Radio log entries can be made in Offline mode. However, entries to complete calls cannot be made. If completing a call is attempted, then the following warning message is displayed.
Click **OK** to close the message. The call can be completed when Mobile is connected to the network.

**Making radio log entries in Offline mode**

If a radio log entry is attempted, then the following message is displayed.

To continue making the radio log entry, click **OK**. The entry is stored until a server connection is reestablished. Once the connection is reestablished, the new unit status is displayed. Otherwise, click **Cancel**.

**Sending radio log entries to the server**

If there are radio log entries that have not been sent to the server, then upon logging out of Mobile, the following warning message is displayed.

To continue logging out, click **OK**. Any radio log entries are sent to the server when a new Mobile session is started and the connection to the server is reestablished. Otherwise, click **Cancel**.
Radio log entries are stored until a connection is reestablished. If there are stored entries, then the **Description** field in the Radio Log History screen displays a message that indicates the entry is pending.

When the connection is reestablished, the software checks whether there are any radio log entries that are newer than the stored entries. For example, if a dispatcher updated the officer’s status while the officer was offline. If the pending stored entry is the most recent update available, then the radio log is updated. If there is a more recent update in the radio log, then no action is taken.
Using the Mapping Module

The Mapping module is used to view the location of calls and units on a map of your jurisdiction.

This section describes the following:

- “Opening the map” on page 234
- “Viewing the entire map” on page 235
- “Buttons on the Mapping toolbar” on page 236
- “Viewing CAD information on the map” on page 237
- “Viewing ScreenTips for calls, units, and devices” on page 239
- “Filtering the CAD calls that appear on the map” on page 239
- “Understanding the Clustering function” on page 240
- “Determining a location's latitude and longitude” on page 242
- “Locating an address on the map” on page 242
- “Measuring distances on the map” on page 245
- “Viewing hyperlinks” on page 246
- “Determining the zoom factor” on page 247
- “Zooming in on the map” on page 247
- “Zooming out on the map” on page 248
- “Panning the map” on page 249
- “Opening the map in Pictometry” on page 249
- “Opening the map in a web browser” on page 250
- “Viewing the current weather” on page 250
- “Printing the map” on page 251

Opening the map

A map of calls, units, and devices can be viewed in Mobile.

To open the map, do one of the following:

- From the menu bar, select Screens > Mapping.
- Press Shift+F5.
Click the **Mapping** button.

The Mapping screen opens. Depending on your settings, CAD information might be displayed on the map. For more information, see “Viewing CAD information on the map” on page 237.

**Viewing the entire map**

A portion of the map can be selected to view, or the entire map can be viewed. By default, the entire map is displayed when the Mapping screen is opened. To view only a portion of the map, zoom in on the desired area. For more information, see “Zooming in on the map” on page 247.

To view the entire map after zooming in, do one of the following:

- Select **Mapping > Entire Map**.
- Press Ctrl+Page Up.
- Click the **Entire Map** button.
- Right-click the map, and then select **Entire Map**.
**Buttons on the Mapping toolbar**

The Mapping toolbar contains several shortcut buttons to assist with viewing the map. Buttons on the toolbar vary depending on the modules your agency has purchased in addition to the Mobile Mapping module.

![Mapping toolbar](image)

The following table describes the toolbar buttons.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print ( )</td>
<td>Used to print the map. For more information, see “Printing the map” on page 251.</td>
</tr>
<tr>
<td>Entire Map (Entire Map)</td>
<td>Used to show the current layer in its entirety so that all objects in it can be seen. For more information, see “Viewing the entire map” on page 235.</td>
</tr>
<tr>
<td>Ctrl+Page Up</td>
<td>Used to show the current layer in its entirety so that all objects in it can be seen. For more information, see “Viewing the entire map” on page 235.</td>
</tr>
<tr>
<td>Zoom In ( )</td>
<td>Used to zoom in on the map. For more information, see “Zooming in on the map” on page 247.</td>
</tr>
<tr>
<td>Zoom Out ( )</td>
<td>Used to zoom out on the map. For more information, see “Zooming out on the map” on page 248.</td>
</tr>
<tr>
<td>Auto Panning (Auto Panning)</td>
<td>Used to keep your unit visible on the screen while the Follow My Unit feature is being used. For more information, see the Automatic Vehicle Location (AVL) Manual.</td>
</tr>
<tr>
<td>(Ctrl+N)</td>
<td>Used to keep your unit visible on the screen while the Follow My Unit feature is being used. For more information, see the Automatic Vehicle Location (AVL) Manual.</td>
</tr>
<tr>
<td>Locate ( ) (Ctrl+F)</td>
<td>Used to open the Locate dialog box. For more information, see “Locating an address on the map” on page 242.</td>
</tr>
<tr>
<td>Get Directions ( )</td>
<td>Used to create and clear custom routes. For more information, see the Quickest Route Manual.</td>
</tr>
<tr>
<td>Selection ( )</td>
<td>Used to select areas of the map.</td>
</tr>
<tr>
<td>Pan ( )</td>
<td>Used to pan the map when zoomed in. For more information, see “Panning the map” on page 249.</td>
</tr>
<tr>
<td>Measure Distance ( )</td>
<td>Used to open the Measure Distance tool. For more information, see “Measuring distances on the map” on page 245.</td>
</tr>
<tr>
<td>Units ( ) (Ctrl+U)</td>
<td>Used to show or hide active units. For more information, see “Filtering the Units area” on page 203.</td>
</tr>
</tbody>
</table>
### Voiceless CAD and Mobile Mapping

#### Using the Mapping Module

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive Units (Ctrl+I)</td>
<td>Used to show or hide inactive units. For more information, see “Filtering the Units area” on page 203.</td>
</tr>
<tr>
<td>Calls (Ctrl+S)</td>
<td>Used to show or hide calls. For more information, see “Filtering the CAD calls that appear on the map” on page 239.</td>
</tr>
<tr>
<td>AVL (Ctrl+A)</td>
<td>Used to show or hide AVL devices, including UNS devices. For more information, see the <em>Automatic Vehicle Location (AVL) Manual.</em></td>
</tr>
<tr>
<td>Locations (Ctrl+L)</td>
<td>Used to display labeled locations on the map. For more information, see “Using a street address to search for a location” on page 242.</td>
</tr>
<tr>
<td>Quickest Route (Ctrl+T)</td>
<td>Used to show and hide the route and directions. This button is available only if your agency has the Quickest Route module. For more information, see the <em>Quickest Route Manual.</em></td>
</tr>
<tr>
<td>Links (Ctrl+L)</td>
<td>Used to display hyperlinks on the map. For more information, see “Viewing hyperlinks” on page 246.</td>
</tr>
<tr>
<td>Pictometry (Ctrl+T)</td>
<td>Used to open the Pictometry map. For more information, see the <em>Pictometry Map Guide.</em></td>
</tr>
<tr>
<td>AVL Device Filter (Ctrl+L)</td>
<td>Used to open the AVL Device Filter. For more information, see the <em>Automatic Vehicle Location (AVL) Manual.</em></td>
</tr>
<tr>
<td>Layers (Ctrl+L)</td>
<td>Used to show or hide the Layers pane. For more information, see “Working with Map Layers” on page 252.</td>
</tr>
<tr>
<td>Configurations</td>
<td>Used to select a map configuration to view. For more information, see “Selecting a configuration” on page 262.</td>
</tr>
</tbody>
</table>

---

**Viewing CAD information on the map**

Depending on your settings, while viewing assigned calls on the map in Mobile, call information, unit information, and call comments can be displayed. When call comments are displayed, **Premises, HAZMAT, Radio Log** buttons are also displayed.
To select what CAD information to show or hide, see “Setting CAD information display options” on page 304.

The following CAD items can be displayed on the Mapping screen:

- **Call Information area.** Displays the call nature, address, agency, zone, and address.
- **Unit Information area.** Displays the unit numbers and status of the assigned unit.
- **Call Comments area.** Displays call comments. To scroll through comments, use the scroll buttons located above and below the Comments area.
- **Add Comment button.** Opens the Call Comment dialog box. To add comments, click the Add Comment button.
- **Radio Log Entry button.** Opens the Radio Log Entry dialog box. To update your unit’s status, click the Radio Log Entry button and complete the fields in the dialog box.
- **Premises button.** Opens the Premises screen. To view premises information, click the Premises button. This option is available only if your agency has purchased the Premises Information module.
- **HAZMAT button.** Opens the Hazmat Search screen. This option is available only if your agency has purchased the Hazardous Materials (HAZMAT) module and has licensed and installed the CAMEO database.

**Viewing ScreenTips for calls, units, and devices**

A ScreenTip displays information about a call on the map. If your agency uses the AVL module, then ScreenTips for units can be displayed. If your agency uses the UNS interface, then ScreenTips for devices can be displayed.

To display a ScreenTip, rest your mouse pointer on the icon for the call, unit, or device.

ScreenTips for calls show the following information, which is also found on the CAD screen:
- Unit assigned
- Priority
- Status
- Location (address of the call)

ScreenTips for units show the following information, which is also found on the Unit Status screen:
- Call assigned
- Zone
- Agency
- Location (call status and call ID)

ScreenTips for devices show the following information, which is also found in the AVL Device Information message box:
- Agency
- Last Moved

For more information on the AVL Device Information message box, see the *Automatic Vehicle Location (AVL) Manual.*

**Filtering the CAD calls that appear on the map**

The category of CAD calls to be displayed on the Mapping screen can be filtered. For example, only those calls assigned to officers in your zone can be displayed.
To show or hide all calls in the selected filter, from the Mapping toolbar, click **Calls** (Ctrl+S).

To select the CAD calls that appear on the map, from the menu bar, select **Mapping > Call Filters**, and then select the category of calls to be displayed. CAD calls can be filtered from the following options:

- To view only calls assigned to your unit, select **My Unit's Calls**.
- To view only calls assigned to the officers in your zone, select **My Zone's Calls**.
- To view only calls assigned to the officers in your agency, select **My Agency's Calls**.
- To view only calls assigned to other units, select **Other Unit's Calls**. The Set Unit Filter dialog box opens. Select the units for which calls should be displayed, and then click **OK**.
- To view only calls assigned to other zones, select **Other Zone's Calls**. The Set Zone Filter dialog box opens. Select the zones for which calls should be displayed, and then click **OK**.

**Understanding the Clustering function**

If too many devices, units, or calls are crowding the map, then your SAA can turn on the Clustering function, which groups like icons in proximity to each other under one label.
For items that are clustered under one icon, the icon label includes a plus sign (+) and the number of additional devices, units, or calls within brackets. For example, 0185 [+6].

**NOTE**

Alerted units and devices are not clustered. For more information about alerts, see the *Automatic Vehicle Location (AVL) Manual*.

To see information about the clustered devices, units, or calls, rest the mouse pointer on a clustered icon to display a ToolTip.

For example, for clustered calls, the ToolTip displays the information for the first call, as well as the ID and nature of nearby calls. Other pertinent information about the device, unit, or call is also displayed.

When the map view is zoomed in, the devices, units, and calls display separately.
Determining a location's latitude and longitude

To determine a location’s latitude and longitude, press the Ctrl key and then right-click the location. A message box with the location’s latitude and longitude opens.

![Position Information](image)

Locating an address on the map

Use the Locate tool to find and label a location on the map. A location can also be searched for by entering the address or the x- and y-coordinates of the location.

Using a street address to search for a location

To use a street address to search for a location:

1. Verify that the **Locations** button is set to show labeled locations on the map.
2. Click the **Locate** button.
The Locate dialog box opens.

The first time the Locate dialog box is opened in a mapping session, the Address tab is selected. For subsequent searches, the Locate dialog box opens to the tab used in your previous search.

3. If the Address tab is not selected, then select it.

4. In the Street Address field, enter the address being searched for. For example, enter 301 Elder St.

5. In the City Code field, enter the city code for the city in which the address is located. For example, enter SFD for Springfield. A city code does not have to be entered unless the address is located in more than one city.

6. Click OK.

The software labels the address and centers it on the map.

**Using x- and y-coordinates to search for a location**

To use x- and y-coordinates to search for a location on the map:

1. Verify that the Locations button is set to show labeled locations on the map.

2. Click Locate.
The Locate dialog box opens.

3. Click the **Lat/Long** tab (Alt+L).

4. Enter the x- and y-coordinates. The coordinates can be entered in either of the following formats:
   - Decimal degrees (**dd.ddddd**). For example, **41.71688**.
   - Degrees, minutes, and seconds (**dd:mm:ss.sss**). For example, **41:43:00.768**

5. Click **OK**.

One of the following occurs:

- The software labels the address and centers it on the map.
- If the software cannot find the location of the coordinates entered, then the following message is displayed:
  
  Location (+dd.ddddd latitude -dd.ddddd longitude) is not within extent of map.

  where +**dd.ddddd** is the latitude entered and -**dd.ddddd** is the longitude entered.

- Click **OK** or press Enter to close the message, and then re-enter the coordinates.
Clearing location labels

Labels for located addresses can be cleared from the map. To clear labels from the map, right-click anywhere on the map, and then select **Clear Locations**. The location labels are removed from the map.

Measuring distances on the map

To measure distances on the map:

1. From the Mapping toolbar, click the **Measure Distance** button (Ctrl+D).
   
   When the mouse pointer is moved over the map, the pointer changes from an arrow to a crosshair.

2. Click the location at which to start measuring.

   A ScreenTip appears near the pointer, displaying the distance (currently 0).

3. Click any points between the beginning location and the ending location. For example, if when measuring a unit’s possible route to a call, there is an intersection at which the unit needs to change direction, click the intersection, and then continue drawing the measuring line.

   Each time the mouse is clicked, a line segment from the last point clicked to the current point is drawn. An accumulated estimate of the distance is also displayed. If the distance is less than 0.25 miles (440 yards), the distance is displayed in yards (yds). If the distance is 0.25 miles or greater, the distance is displayed in miles (mi).

   If the measuring line needs to be extended beyond the current viewable boundaries of your map, then a white arrow appears on the map. When the mouse is clicked, the map pans in the direction of the arrow.

4. Double-click or right-click the ending location.
The ScreenTip displays the total distance from the beginning location to the ending location.

NOTE
If the ending location point is clicked and the measuring line is extended beyond the ending location point in error, then press Esc to end the measuring line at the point last clicked.

The measuring line stays on your map until a new distance measurement is started, a different mapping tool is selected, or the Measure Distance button is clicked again.

**Viewing hyperlinks**

Your SAA can assign hyperlinks to points on the map. To view hyperlinks, make sure that the Links button is clicked. The software displays hyperlinks as yellow lightning bolts.

To display the name of the hyperlink and the hyperlink address in a ScreenTip, rest your mouse pointer on the hyperlink. To open the hyperlink, click the ScreenTip or double-click the hyperlink icon.

NOTE
To open an Internet link, your device must be connected to the Internet.
Determining the zoom factor

The zoom factor determines which layers and labels are visible on the map at any one time. To see the current zoom factor, press Ctrl+Shift+Z. To increase the zoom factor, zoom in on the map. To decrease the zoom factor, zoom out on the map. Layers and labels can be assigned a minimum and maximum zoom factor. Layers with a zoom factor of 1 are always visible. For more information on setting the zoom factor of a layer, see “Defining layer properties” on page 254.

Use the following table to determine what each zoom factor displays.

<table>
<thead>
<tr>
<th>Zoom factor</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The layer or labels</td>
</tr>
<tr>
<td>2</td>
<td>The layer or labels after zooming in one time</td>
</tr>
<tr>
<td>4</td>
<td>The layer or labels after zooming in two times</td>
</tr>
<tr>
<td>8</td>
<td>The layer or labels after zooming in three times</td>
</tr>
<tr>
<td>16</td>
<td>The layer or labels after zooming in four times</td>
</tr>
<tr>
<td>32</td>
<td>The layer or labels after zooming in five times</td>
</tr>
<tr>
<td>64</td>
<td>The layer or labels after zooming in six times</td>
</tr>
</tbody>
</table>

NOTE
Zoom factor settings for map layers that contain many labels can affect Mobile performance. For optimum performance, it is recommended to set the label zoom factor value for these layers to one greater than the general zoom factor value.

Zooming in on the map

When the Mapping screen is opened, the entire map is displayed. To see a more detailed view of an area, zoom in on the map as many times as necessary until the desired details are displayed.

Your SAA sets up the map so that certain features appear only after zooming in a specified number of times. For example, your SAA might set up the streets so that they appear after zooming in four times. Street names might appear after zooming in 16 times. For more information, see “Determining the zoom factor” on page 247.

To zoom in, do one of the following:

- From the menu bar, select Mapping > Zoom In.
Voiceless CAD and Mobile Mapping  
Using the Mapping Module

- From the Mapping toolbar, click the Zoom In button, and then drag a box around the area to view on the map.
- Press the Page Down key.
- Right-click the map, and then select Zoom In.

**CAUTION**
If your agency has the AVL module, and your map is in Follow My Unit mode, then use the Page Down key instead of the Zoom In command to zoom in on the map. If the Zoom In command is used while in Follow My Unit mode, then the software stops following your unit. For more information, see the Automatic Vehicle Location (AVL) Manual.

**Zooming to a layer**
To view a specific layer, zoom in on the layer.
To zoom to a specific layer:

1. If the Layers pane is not visible, then click Layers (Ctrl+L) to open it.
2. Right-click the layer on which to zoom, and then select Zoom to Layer.
   The map zooms to the layer.

**Zooming to a polygon in a polygon layer**
If your SAA has set up polygon layers on your map to define specific areas, then zoom to the polygon layer to view more information about the area.
To zoom to a specific polygon in a polygon layer:

1. If the Layers pane is not visible, then click Layers (Ctrl+L) to open it.
2. To view a polygon in a layer, select the polygon layer and click the plus sign (+) next to the layer name.
3. Right-click the name of the polygon to zoom in on, and then select Zoom to Extent.
   The map zooms to the polygon.

**Zooming out on the map**
To view a larger area of the map, zoom out as many times as necessary until the map is at the desired view.
To zoom out, do one of the following:

- From the menu bar, select **Mapping > Zoom Out**.
- From the Mapping toolbar, click the **Zoom Out** button, and then click the map to zoom out.
- Press the Page Up key.
- Right-click the map, and then select **Zoom Out** from the shortcut menu.

**CAUTION**

If your agency has the AVL module, and your map is in Follow My Unit mode, then use the Page Up key instead of the Zoom Out command to zoom out on the map. If the Zoom Out command is used while in Follow My Unit mode, then the software stops following your unit.

- Hold down the Shift key while clicking the desired area of the map.

**Panning the map**

Pan the map while it is zoomed in to view different areas of the map at that zoom level.

To pan the map, do one of the following:

- From the menu bar, select **Mapping > Pan**.
- From the Mapping toolbar, click the **Pan** button, and drag the map to the desired area.
- Press the Up Arrow or Down Arrow key to move the map.
- Hold down the Shift key while right-clicking the map, and then drag the map to the desired area.

**Opening the map in Pictometry**

If your agency has the Spillman Pictometry map, then the map can be opened in Pictometry. For more information about using Pictometry, see the *Pictometry Map Guide*.

To open the map in Pictometry, do one of the following:

- From the menu bar, select **File > Open in Pictometry**.
- Right-click the icon for a call, unit, or device, and then select **Open in Pictometry**.
• Right-click any location on the map, and then select **Open in Pictometry**.

The map opens in Pictometry.

**NOTE**
If the Pictometry Settings dialog box opens, then contact your SAA.

**Opening the map in a web browser**

A third-party version of the map can be opened in an Internet browser. To open the map in an Internet browser, right-click any call, unit, device, or map feature, and then select **Open Google Maps**. A Google Maps version of your map opens in your default browser with the latitude and longitude displayed.

**Viewing the current weather**

The weather for a selected location can be viewed in an Internet browser.
To view the weather for a selected location, right-click the location on the map, and then select **Open Current Weather**. The website for the National Weather Service opens in your default browser and displays the weather forecast for the selected location.

**Printing the map**

The current map configuration can be printed.

To print the map:

1. Select **File >Print**.
   
   The Print dialog box opens.

2. Configure your printer settings, and then click **OK**.
   
   The map is printed according to the selected settings.
Working with Map Layers

To configure layers on the map, open the Layers pane. The Layers pane is used to rearrange layers, make a layer active or inactive, and to view the contents of multiple layers at one time.

The Layers pane is also used to configure layer properties. For more information about changing layer properties, see “Defining layer properties” on page 254.

The following table explains basic tasks that can be performed in the Layers pane.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a layer to the foreground</td>
<td>Drag the layer to the top of the list in the Layers pane.</td>
</tr>
<tr>
<td>Make a layer active</td>
<td>Select the check box next to the name of the layer.</td>
</tr>
<tr>
<td>Make a layer inactive</td>
<td>Clear the check box next to the name of the layer.</td>
</tr>
<tr>
<td>View the components of a layer</td>
<td>Click the plus sign next to the layer name.</td>
</tr>
<tr>
<td>Hide the components of a layer</td>
<td>Click the minus sign next to the layer name.</td>
</tr>
</tbody>
</table>

This section describes the following:

- “Adding a layer to the map” on page 253
- “Removing a layer” on page 254
- “Working with layer components” on page 257
- “Defining properties for a polygon” on page 259
- “Defining properties for all lines in a layer” on page 260
- “Defining properties for all points in a layer” on page 261
- “Selecting a configuration” on page 262
**Adding a layer to the map**

As many layers can be added to your map as desired. This section describes how to add shapefile and orthophotographic layers to your map.

**CAUTION**

Adding more layers on your map, and creating more detailed layers (for example, layers with many labels), increases the number of system resources your computer must use to properly display the map. Adding additional and detailed layers to your map might slow the performance of Mobile.

To add a layer to the map:

1. From the Mapping toolbar, click **Layers** (Ctrl+L).

   The **Layers** pane opens.

2. Right-click the configuration name (the default is **Layers**), and then select **Add Layer**.

   The Add Layer dialog box opens.
3. Navigate to the file location in which your map layers are stored, select the layer to add, and then click **Open**.

**NOTE**

By default, the type of layer to add is `.shp`. If an orthophotographic layer is being added, then select the type of orthophotograph being added from the file type drop-down list. For example, if your orthophotograph is a TIFF file, then select Tagged Image File Format (.tiff, .tif, .tff).

If the directory does not contain all the correct files, then an error message is displayed. See your SAA for assistance.

The layer is added to your configuration.

**Removing a layer**

To remove a layer, from the Mapping toolbar, click **Layers** (Ctrl+L). The **Layers** pane opens. Right-click the layer, and then select **Remove**. The layer is removed from the map.

**Defining layer properties**

General properties and label properties for a layer can be set. For point layers, hyperlink properties can also be set.

**Setting general properties for a layer**

To set the general properties for a layer:

1. From the Mapping toolbar, click **Layers** (Ctrl+L).
   
   The **Layers** pane opens.

2. Right-click the layer name, and then select **Properties**.
The Layer Properties dialog opens.

![Layer Properties Dialog](image)

3. If necessary, click the **General** tab.

4. If desired, in the **Name** field, change the name of the layer to one that describes the layer, such as **Streets**, **Cities**, or **Zones**.

5. To show or hide the layer, select or clear the **Visible** check box.

6. In the **Display Range** area, do one of the following:
   - To use the default zoom factors, select the **Display at all zoom factors** check box. See “Determining the zoom factor” on page 247.
   - To set the zoom factors, clear the **Display at all zoom factors** check box. In the **Minimum zoom factor** and **Maximum zoom factor** fields, enter the minimum and maximum zoom factor values.

**NOTE**

The zoom factor is the magnification that the map must exceed for the layer to appear on the map. If a minimum zoom factor of 0 and a maximum zoom factor of 20 is entered, then the layer is not displayed after a zoom factor of 20 is exceeded. If a minimum zoom factor of 10 and a maximum zoom factor of 0 is entered, then the layer is displayed for all zoom factors above 10.

7. Click **OK**.

   The Layer Properties dialog box closes and the changes are applied.

---

**Setting label properties for a layer**

Labels for points, lines, polygons on a map are displayed once the map is at the specified zoom level.
To set the label properties for a layer:

1. From the Mapping toolbar, click **Layers** (Ctrl+L).
   
   The **Layers** pane opens.

2. Right-click the layer name, and then select **Properties**.
   
   The Layer Properties dialog box opens.

3. Click the **Labels** tab.

4. In the **Color** field, select a color from the drop-down list, or click **Other** to customize a color.

5. In the **Field** field, select the field whose value should be used as the label from the drop-down list.

   **NOTE**

   If a value is entered in the **Field** field, then labels can be quickly viewed for the specified layer on the map. To display the label, rest the mouse pointer on a map element on the layer. The label disappears when the mouse is moved or any key is pressed.

6. In the **Display labels after a zoom factor of** field, enter the zoom factor at which the label is displayed. See “Determining the zoom factor” on page 247.

7. Click **OK**.

   The Layer Properties dialog box closes and the changes are applied.

**Setting hyperlink properties for a point layer**

Hyperlinks to important documents or websites can be displayed on the map as part of a point layer.
To set the hyperlink properties for a point layer:

1. From the Mapping toolbar, click **Layers** (Ctrl+L).
   The **Layers** pane opens.
2. Right-click the point layer name, and then select **Properties**.
   The Layer Properties dialog box opens.
3. Click the **Hyperlink** tab.
4. In the **Field** field, select the name of the field that contains the hyperlinks from the drop-down list.
5. Click **OK**.
   On the map, the **Links** button is enabled. When the **Links** button is clicked, a yellow lightning bolt for each hyperlink is displayed on the map.

---

**Working with layer components**

Layers are made up of one of the following components:

- **Polygons**. Define a large area of the map, such as city codes and subdivisions.
- **Lines**. Define features, such as streets or rivers.
**Points.** Define points on the map, such as landmarks or businesses.

To get more information about a specific polygon, line, or point on the map, right-click the desired polygon, line, or point and then select **Identify**. The selected item flashes and the Info dialog box opens.

The Info dialog box displays information about the selected item, such as the item’s name, address, latitude and longitude. The information available in the Info dialog box depends on if the item selected is a polygon, line, or point.

To work with specific layer components, do any of the following:
“Defining properties for a polygon” on page 259
“Defining properties for all lines in a layer” on page 260
“Defining properties for all points in a layer” on page 261

Defining properties for a polygon

The properties for up to 50 individual polygons per layer can be defined.

To define properties for a polygon:

1. From the Mapping toolbar, click Layers (Ctrl+L).
   
   The Layers pane opens.

2. Click the plus sign next to the layer that contains the polygon to define.

3. Right-click the polygon, and then select Properties.
   
   The Properties dialog box opens.

4. In the Color field, select a color from the drop-down list, or click Other to customize a color.

5. In the Style field, select the pattern or style to use.

NOTE

If the Transparent style is used, then the background color of your map is used, and not the color specified in the Color field. If Light Gray Fill, Gray Fill, or Dark Gray Fill is specified, then the color selected in the Color field is formatted so that it can be seen through.

6. To display an outline around the polygon, in the Outline area, select the Visible check box and do the following:
Working with Map Layers

– In the **Color** field, select a color from the drop-down list, or click **Other** to customize a color.
– In the **Width** field, select the width for the outline.

7. To apply the settings to all polygons in the layer, select the **Apply To All** check box. Otherwise, clear the check box to apply the settings to only the currently selected polygon.

8. Click **OK**.

Your changes are applied to the map.

**Defining properties for all lines in a layer**

To define properties for all lines in a layer:

1. From the Mapping toolbar, click **Layers** (Ctrl+L).

   The **Layers** pane opens.

2. Click the plus sign next to the line layer to define.

3. Right-click the line icon, and then select **Properties**.

   The Properties dialog box opens.

4. In the **Color** field, select a color from the drop-down list, or click **Other** to customize a color.

5. In the **Style** field, select a line style from the drop-down list.

6. In the **Width** field, select a line width.

7. Click **OK**.

   Your changes are applied to the map.
Defining properties for all points in a layer

To define properties for all points in a layer:

1. From the Mapping toolbar, click Layers (Ctrl+L).
   The Layers pane opens.
2. Click the plus sign next to the layer to define.
3. Right-click the point icon, and then select Properties.
   The Properties dialog box opens.

![Properties dialog box]

4. In the Color field, select a color from the drop-down list, or click Other to customize a color.
5. In the Style field, select a point style from the drop-down list.
   – To use a font marker as a point icon, such as an icon for all homicides, select True Type. Continue to “Selecting a font marker” on page 261.
6. In the Size field, select the size for the point icon.
7. Click OK.
   Your changes are applied to the map.

Selecting a font marker

With the Properties dialog box open for a point layer and with True Type selected in the Style field, a font marker for a point icon can be selected.

To select a font marker:

1. In the Font Marker area, in the Font Name field, select the name of the font to use from the drop-down list.
2. In the **Character Index** field, select the font marker to use as the point symbol from the drop-down list.

3. To rotate the icon, enter the number of degrees in the **Rotation (0-360)** field.

4. If necessary, in the **Size** field, change the font size.

5. Click **OK**.

   Your changes are applied to the map.

### Selecting a configuration

The **Configurations** field contains public map configurations defined by your SAA and any user configurations.

To select a map configuration, select a configuration from the **Configurations** field on the Mapping toolbar. Public configurations are designated by a world icon, and user configurations created in the CAD map are designated by a person icon.

The selected map configuration is displayed in the map area. The next time the Mapping screen is opened, the last selected configuration is displayed.

**NOTE**

The Mobile map can be configured to your preferred settings. However, the changes are not saved when the software is exited. To create a personalized user configuration, use the CAD map.
Chapter 6

Mobile Settings

Using the Customize Dialog Box  264
Using the Options dialog box  277
Setting Search Options  278
Changing Sound Notifications  284
Setting Voiceless CAD Options  286
Customizing Color Settings  292
Setting Mapping Options  298
Setting Message Center Options  307
Using the Customize Dialog Box

Depending on the settings established by your SAA, the main toolbar and menus in Mobile can be customized using the Customize dialog box.

To open the Customize dialog box, do one of the following:

- From the menu bar, select Edit > Toolbars > Customize (Alt+E, T, C).
- Right-click the menu bar or toolbar, and then select Customize from the shortcut menu.

The Customize dialog box contains the following tabs:

- **Commands.** Used to add or remove buttons on the main toolbar. See “Using the Commands tab” on page 266.
- **Toolbars.** Used to reset, show, or hide the main toolbar. See “Using the Toolbars tab” on page 268.
- **Tools.** Used to add programs to the Tools area. See “Using the Tools tab” on page 269.
- **Keyboard.** Used to customize Mobile keyboard shortcuts. See “Using the Keyboard tab” on page 271.
- **Menu.** Used to change the menu bar options for some Mobile screens. See “Using the Menu tab” on page 273.
- **Options.** Used to customize the ScreenTips feature. See “Using the Options tab” on page 276.
Managing toolbar buttons

With the Customize dialog box open, the following changes can be made to the buttons on the toolbar:

- “Changing button appearance” on page 265
- “Moving, removing, or restoring buttons” on page 265

Changing button appearance

Buttons can be set up to display both the button image and text, or to display only the image or only the text.

To change the appearance of a button:

1. Open the Customize dialog box.
2. From the toolbar, right-click the button to change, and then select **Button Appearance**.
   
The Button Appearance dialog box opens.

3. Select one of the following:
   - To display an image only, select **Image only**.
   - To display text only, select **Text only**. The **Button text** field is enabled. If desired, the displayed text can be edited in the field.
   - To display and image and text, select **Image and text**.
4. Repeat steps 2–3 for any additional buttons to change.
5. When finished, click **Close** to close the Customize dialog box.

Moving, removing, or restoring buttons

Buttons on the toolbar can be moved, removed, or restored.
To move, remove, or restore a toolbar button:

1. Open the Customize dialog box.

2. From the toolbar, do one of the following:
   - To move the button, drag the button to the desired location.
   - To remove the button, drag the button off the toolbar, or right-click the button, and then select **Delete**.
   - To restore button settings to the default, right-click the button, and then select **Restore to Default**.

3. Repeat step 2 for any additional buttons.

4. When finished, click **Close** to close the Customize dialog box.

**Using the Commands tab**

Buttons can be added to the main toolbar of Mobile using the **Commands** tab. Buttons can start Mobile features or other programs, such as word processing or digital camera software, installed on your device.

**NOTE**

Buttons can be added for any program on your computer. However, to add a button for a program that is not part of Mobile, the program must first be added to the **Tools** area. For more information, see “Adding programs to the Tools area” on page 269.

To use the **Commands** tab:

1. Open the Customize dialog box.
The **Commands** tab is displayed.

2. In the **Categories** area, select the category that contains the desired command to add to the toolbar. To view all the commands in Mobile, select the **All Commands** category.

   In the **Commands** area, any applicable button icons are displayed next to the command name.

3. To create a toolbar button, drag the desired command from the **Commands** area to the toolbar. For example, drag **ActionsEmergencyAlert** to the toolbar.

   **NOTE**
   When dragging the command, the mouse pointer becomes a gray box with an x mark. Once the command can be placed, the x mark disappears.

   The selected button appears on the toolbar. For example, the **Emergency Alert** button.

4. Repeat steps 2–3 for any additional buttons.

5. When finished, click **Close** to close the Customize dialog box.
Using the Toolbars tab

Use the **Toolbars** tab to do any of the following:

- “Resetting the main toolbar or menu bar” on page 268
- “Showing or hiding the main toolbar” on page 268

**Resetting the main toolbar or menu bar**

To reset the main toolbar or menu bar:

1. Open the Customize dialog box.
2. Click the **Toolbars** tab.

3. In the **Toolbars** area, do any of the following:
   - To reset the main toolbar, select the **Toolbar** check box.
   - To reset the menu bar, select the **Menu Bar** check box.
4. Click **Reset**.
   
   A dialog box opens, asking to confirm resetting the selected toolbars.
5. Click **Yes**, or press Enter.
6. Click **Close** to close the Customize dialog box.

**Showing or hiding the main toolbar**

To show or hide the main toolbar:

1. Open the Customize dialog box.
2. Click the **Toolbars** tab.
3. In the **Toolbars** area, select or clear the **Toolbar** check box to show or hide the main toolbar.

4. Click **Close** to close the Customize dialog box.

### NOTE

The menu bar cannot be hidden.

---

**Using the Tools tab**

From the **Tools** tab, programs can be added and removed from the **Tools** area as needed. From the menu bar, from the **Tools** area, links to other programs located on your computer, such as Notepad or digital camera programs, can be added. To start any program listed on the **Tools** area, click the link.

Mobile automatically adds links for any Spillman software located on your computer. For more information, see “Understanding the Mobile Today Screen” on page 24.

**Adding programs to the Tools area**

To add a program to the **Tools** area:

1. Open the Customize dialog box.
2. Click the **Tools** tab.

3. In the **Menu contents** area, click the **New (Insert)** button.

   The software adds a line in the **Menu contents** area and places the cursor in that line.
4. Enter the name of the program.

5. Complete the following fields:
   - **Command**: Enter the location of the program’s executable (.exe) file.

   **NOTE**
   To browse the location of the program instead of entering the complete path in the **Command** field, click the **Browse** button (...).

   - **Arguments**: Enter any command line options needed to run the program, as necessary. For more information on command line options for a specific third-party program, refer to that program’s user documentation.

   - **Initial directory**: Enter the directory in which the file for that program is saved. For example, if a link to a word-processing program is being added, then enter the directory in which word-processing documents are saved.

6. To move a menu item up or down on the list, select the item and then use the **Move Item Up** (Alt+Up Arrow) and **Move Item Down** (Alt+Down Arrow) buttons.

7. If the value in the **Command** field is a URL, do one of the following:
   - To open the URL in Mobile, select the **Open in Mobile** option.
   - To open the URL in a separate Internet browser, select the **Open in new browser window** option.

8. Repeat steps 3–7 for any additional programs to add.

9. When finished, click **Close** to close the Customize dialog box.

**Removing programs from the Tools area**

To remove a program from the **Tools** area:

1. Open the Customize dialog box.

2. Click the **Tools** tab.

3. In the **Menu contents** area, select the program, and then click the **Delete** button.

   The program is removed from the **Tools** area.

4. Repeat step 3 for any additional programs to remove.

5. When finished, click **Close** to close the Customize dialog box.
Using the Keyboard tab

In the Keyboard tab, keyboard shortcut keys can be assigned to any Mobile command. Once created, a shortcut key can also be changed or removed.

Assigning or changing keyboard shortcuts

To assign or change a keyboard shortcut:

1. Open the Customize dialog box.
2. Click the Keyboard tab.

3. In the Category field, select a category from the drop-down list. To view all the commands in Mobile, select All Commands.
4. In the Commands area, select the command to which the shortcut key is being assigned or changed.

   A description of the command is displayed in the Description area, and the shortcut keys assigned to that command are displayed in the Current Keys list area. More than one set of shortcut keys can be assigned to each command.
5. In the Set Accelerator For field, select the screen in which the shortcut key should work from the drop-down list.

   – To make the shortcut key work in all Mobile screens, select Default.
   – To make the shortcut key work only in the Mapping screen, select Mapping.
6. With the cursor in the **Press New Shortcut Key** field, press the key combination to assign to the command.

### NOTE
A combination of keys or singular keys can be used. However, if a combination of keys is used, then one of the keys must be Ctrl, Alt, or Shift. It is not recommended to use singular keys for shortcuts.

One of the following occurs:

- If the key combination is not assigned to any other command, then the following message is displayed:
  
  **Assigned To: [Unassigned]**.

- If the key combination is assigned to another command, then the following message is displayed:
  
  **Assigned To: [command name]**
  
  where *command name* is the name of the command currently assigned to the key combination.

7. Once an unassigned key combination is pressed, click **Assign**.

8. Repeat steps 3–8 for any additional keyboard shortcuts.

9. When finished, click **Close** to close the Customize dialog box.

### TIP
To reset the shortcut keys to their default settings, click **Reset All**. A confirmation dialog box opens. Click **Yes** or press Enter to reset shortcut keys to their defaults and close the dialog box.

**Removing keyboard shortcuts**

To remove a keyboard shortcut:

1. Open the Customize dialog box.
2. Click the **Keyboard** tab.

3. In the **Category** field, select a category from the drop-down list. To view all the commands in Mobile, select **All Commands**.

4. In the **Commands** list area, select the command to which the shortcut key is assigned.

5. In the **Current Keys** list area, select the shortcut key to remove.

6. Click **Remove**.

7. Repeat steps 3–6 for any additional shortcuts to remove.

8. When finished, click **Close** to close the Customize dialog box.

---

**Using the Menu tab**

To modify a screen’s menu bar without opening the screen, use the **Menu** tab. The menu bar changes depending on what screen in Mobile is active, and whether the menu bar for a screen can be modified.

**Menu bar options by screen name**

The menu bars in Mobile are listed by screen as follows:

- **Mobile Today**. The Mobile Today screen uses the default toolbar, also known as the Today toolbar, and contains the following menu items:
  - File
  - Search
  - Tools
  - Edit
  - Screens
  - Help
- **CAD and CAD Call Information.** The CAD and CAD Call Information screens contain the following menu items:
  - File
  - Search
  - CAD
  - Help

- **Radio Log History Call Information and Radio Log History.** The Radio Log History Call Information and Radio Log History screens contain the following menu items:
  - File
  - Search
  - Radio Log History
  - Help

- **Mapping.** The Mapping screen contains the following menu items:
  - File
  - Search
  - Mapping
  - Help

- **Message Center.** The Message Center contains the following menu items:
  - File
  - Search
  - Actions
  - Help

- **State Forms.** The State Forms screen uses the default toolbar, also known as the Today toolbar, and contains the following menu items:
  - File
  - Search
  - Tools
  - Help
Changing the items in the menu bar

To change the items in the menu bar:

1. Open the Customize dialog box.
2. Click the **Menu** tab.

3. To change the menu bar for a screen other than the current screen, in the **Show Menus for** field, select the screen to change from the drop-down list. Otherwise, continue to step 4.

   The menu bar displays the items for the selected screen.

4. Right-click the menu item to change.

5. Do any of the following:

   - To remove a menu, select **Delete**.
   - To group menu items, select **Start Group**. A line appears to the left of the selected item, creating a group on either side of the line.
   - To change text displayed for the menu, select **Button Appearance**. The Button Appearance dialog box opens and the **Text only** option is selected. In the **Button text** field, enter the desired text to display, and then click **OK**. To reset the menu bar to the system defaults, click **Reset**.

   The menu items for the specified screen are modified according to your changes. The menu items for all other screens remain the same.

6. Repeat steps 3–5 for any additional menu bars to change.

7. When finished, click **Close** to close the Customize dialog box.
Using the Options tab

The Options tab controls the ScreenTips feature in Mobile.

To use the Options tab:

1. Open the Customize dialog box.
2. Click the Options tab.
3. To show or hide ScreenTips, select or clear the Show ScreenTips on toolbars check box.
4. To show the shortcut keys in ScreenTips, with the Show ScreenTips on toolbars check box selected, select the Show Shortcut keys in ScreenTips check box.
5. When finished, click Close to close the Customize dialog box.
Using the Options dialog box

Depending on the settings established by your SAA, certain settings in Mobile can be customized. To customize your Mobile settings, use the Options dialog box.

To open the Options dialog box, from the menu bar, select **File > Options**.

![Options dialog box]

From the Options dialog box, the following options can be customized:

- Searching, see “Setting Search Options” on page 278.
- Sound notifications, see “Changing Sound Notifications” on page 284.
- Voiceless CAD, see “Setting Voiceless CAD Options” on page 286.
- Colors, see “Customizing Color Settings” on page 292.
- Mapping, see “Setting Mapping Options” on page 298.
- Message Center, see “Setting Message Center Options” on page 307.
- Logging options are used by your SAA and Spillman Technical Services in certain support cases. Do not turn logging on or off unless directed by your SAA.
Setting Search Options

In the Options dialog box, the following search options can be set:

- “Setting default search options” on page 278
- “Setting InSight search options” on page 279
- “Setting Mobile’s behavior for query responses” on page 280
- “Displaying the Requesting Unit field” on page 281
- “Setting driver license scanning options” on page 282

Setting default search options

For certain records, the searches that are performed by default when data is entered in a record Search screen can be changed.

To set default search options:

1. Open the Options dialog box.
2. Click the **Searching** tab.
   
The Searching options are displayed.
3. In the **Default Search Options** area, select or clear check boxes as desired to set the categories that are selected by default in the corresponding Search screen. For example, to make performing an InSight query whenever a Name query is performed the default, select the **InSight(TM) Names** check box.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Setting InSight search options**

Use the **InSight Search Options** area to determine the default groups and sites that are searched when an InSight query is performed.

To set InSight search options:

1. Open the Options dialog box.

2. Click the **Searching** tab.

   The Searching options are displayed.

3. In the **InSight Search Options** area, select or clear check boxes to determine the default agencies, sites, or agency groups for your InSight queries.
4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Setting Mobile’s behavior for query responses**

Mobile can be set to become your active application (appear on top of other applications) when a query response arrives, or it can be set to remain in the background.

To set Mobile’s behavior for query responses:

1. Open the Options dialog box.
2. Click the **Searching** tab.
   
   The Searching options are displayed.

3. In the **When Response Arrives** area, do one of the following:
   
   – To make Mobile the active application when a query response is received, select the **Activate application** check box.
   
   – To leave Mobile in the background when a query response arrives, clear the **Activate application** check box.
   
   – To activate Mobile only when certain query response types are received, clear the **Activate application** check box, and then in
the **Other Statelink Forms** field, enter the query type. Multiple query types must be separated by a comma. This field is not case sensitive.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

### Displaying the Requesting Unit field

Mobile can be set to display the **Requesting Unit** field on the Search screen. This is helpful if queries are done on behalf of another officer.

When running a query for another officer, the results of that query can be forwarded automatically to the officer by selecting the officer from the drop-down list in the **Requesting Unit** field. This applies to both state and local returns. However, the ability to forward a StateLink return depends the StateLink settings established by your SAA.

**NOTE**

Local query results are sent to the unit only if the unit is actively connected to the dispatcher. If there are multiple users in the unit, then only the primary active user receives the message. InSight queries are not automatically forwarded.

To display the **Requesting Unit** field:

1. Open the Options dialog box.
2. Click the **Searching** tab.
3. In the **Search Fields** area, select the **Show Requesting Unit** check box.

**NOTE**

To stop displaying the requesting unit, clear the **Show Requesting Unit** check box.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Setting driver license scanning options**

If your agency has purchased the Mobile Driver License Scanning module, and your SAA has set up your work area with a driver license scanner, then driver licenses can be swiped or scanned as an alternative to manually entering the data to send to state and local queries.

To set driver license scanning options:

1. Open the Options dialog box.
2. Click the **Searching** tab.
The Searching options are displayed.

![Options dialog box]

3. In the **Driver License Scanning** area, do one of the following:

   - To automatically perform a search using your default settings when a driver license is scanned or swiped, select the **Auto-search on scan** check box.
   
   - To complete the Name Search screen fields, but not automatically perform a search, clear the **Auto-search on scan** check box.
   
   - To report scanning errors when a driver license is being scanned and Mobile is not the active application, select the **Display errors when inactive** check box.

**NOTE**

Magnetic stripes and bar codes can deteriorate over time. When this happens, errors can occur, and the software populates the Name Search screen with as much of the data as it can read.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.
Changing Sound Notifications

A sound card must be installed on your computer to change sound notifications. Sound notifications are associated with the following events:

- Local Query Received
- State Query Received
- State Voice Response
- My Call Updated
- Other Call Updated
- New Mail Message
- New Alert
- Instant Message Sent
- Instant Message Received
- Approval Received

To change the sound notification for an event:

1. Open the Options dialog box.
2. Click the Sounds tab.
   
The Sounds options are displayed.

3. In the Sound area, select an audio sound for the desired event from the drop-down list.

**NOTE**

For silent event notifications, select **None**.
4. To play the sound, click the **Preview** button.

5. Repeat steps 3 – 4 until all the sound notifications are configured to the desired settings.

6. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**NOTE**

Alerts for state queries can be set separately. To set the message chime alert, use the **State Query Received** field. To set the voice alert, use the **State Voice Response** field. By default, voice alerts are turned on. To turn off voice alerts, set the field value to **none**.
Setting Voiceless CAD Options

CAD can be personalized to make the screens easier to view.

To set CAD options, complete any of the following:

- “Changing the default view for call comments” on page 286
- “Enabling flashing StateLink alerts” on page 287
- “Changing the CAD list font size” on page 288
- “Setting the hours of radio log activity to be displayed” on page 289
- “Displaying One-Touch Status buttons on the map” on page 290

Changing the default view for call comments

By default, when new comments are added to a call, they are displayed at the bottom of the Comments field on the Info tab of the CAD Call Information screen. If desired, the default setting can be changed so that new comments are displayed at the top of the Comments field.

To change the default view for call comments:

1. Open the Options dialog box.
2. Click the CAD tab.
The CAD options are displayed.

![Options dialog box]

3. In the **Calls** area, clear the **Auto-scroll to bottom of call info after update** check box.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Enabling flashing StateLink alerts**

For StateLink alerts, your SAA sets up the red message header and the Hit Alert Message box. However, the flashing feature for Voiceless CAD is enabled in Mobile.

**NOTE**

The StateLink alert settings in Mobile do not take effect until your SAA has enabled and configured StateLink alerts in the StateLink Manager web application. For more information, contact your SAA.

To enable flashing StateLink alerts:

1. Open the Options dialog box.
2. Click the **CAD** tab.
The CAD options are displayed.

3. To have units with StateLink alerts flash in the Voiceless CAD screen, select the **Flash State Query Hits** check box. By default, this check box is cleared and the units do not flash when a StateLink alert is received.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Changing the CAD list font size**

The font size for CAD lists can be changed.

To change the font size for CAD lists:
1. Open the Options dialog box.
2. Click the **CAD** tab.
The CAD options are displayed.

![Options dialog box]

3. In the **List Fonts** area, enter a value from 8–36 in the **Size** field. The default is 14.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Setting the hours of radio log activity to be displayed**

The hours of radio log entries that Mobile searches for can be specified, up to the last 24 hours.

To set the hours of radio log entries to be displayed:

1. Open the Options dialog box.
2. Click the **CAD** tab.
The CAD options are displayed.

3. In the **Hours of radio log activity to display** field, enter the number of hours. By default, the value is 12.

4. Click **OK**.

5. If the Radio Log History screen was open when the number of hours was set, then close it and open it again to update the radio log entries.

6. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Displaying One-Touch Status buttons on the map**

The Mobile map can be set up to display One-Touch Status buttons, which are used to update your unit’s status while using the map, instead of going back to the Voiceless CAD screen.

To display One-Touch Status buttons on the map:

1. Open the Options dialog box.

2. Click the **CAD** tab.
The CAD options are displayed.

3. In the **One-Touch Status Buttons** area, select the **Show One-Touch Status Buttons on Mapping Screen** check box.

   The One-Touch Status buttons are enabled.

4. To change the status codes from the defaults, in the **Status Code** area, select a status code from the drop-down for each desired shortcut key to display on the map.

5. To enable the Function keys to update your unit status, select the **Override Standard Shortcut Keys on Mapping Screen** check box. Mapping shortcuts can still be used by simultaneously pressing Ctrl and the Function key for the desired shortcut.

6. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.
Customizing Color Settings

The color settings in Mobile can be customized. The settings affect the Alert marquee that scrolls across the bottom of the screen and the overall color theme.

The following color settings can be customized:
- “Setting the Alert marquee options” on page 292
- “Setting the Mobile color theme” on page 293
- “Setting CAD colors” on page 295

Setting the Alert marquee options

Set options to change the text color and scroll speed of the Alert marquee.

To set Alert marquee options:

1. Open the Options dialog box.
2. Click the Colors tab.
   The Colors options are displayed.
3. In the Alert area, select a color from the color palette in the Foreground field.
4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

### Setting the Mobile color theme

Mobile has a predefined set of color themes: a Blue theme, a Red theme, and a Night theme that can be switched easily. The color theme is set based on a user’s code classification. However, the color theme can be changed at any time.

**NOTE**

If the **Unit Type** field on the Units Table screen (`cdunit`) is left blank, then the color theme is the Blue theme by default.

To set the color theme:

1. Open the Options dialog box.

2. Click the **Colors** tab.

   The Colors options are displayed.

3. In the **Manually Select Color Theme** field, select one of the following from the drop-down list:
Customizing Color Settings

- **Red Theme**: Sets the background color of Mobile screens to red.
- **Blue Theme**: Sets the background color of Mobile screens to blue.
- **Night Theme**: Sets the background color of Mobile screens to Night mode colors.

4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Setting Night mode settings**

Mobile has a predefined set of colors that are easily viewed in night-time conditions, called Night mode. The Night mode feature uses the Night Theme, and can be turned on and off manually, or set to turn on and off automatically based on a specific time of day or your location.

To manually enable Night mode, from the menu bar, select **Tools > Night Mode** (Alt+T, N). Night mode remains enabled for the duration of the Mobile session. If the Mobile session is ended, then when Mobile is started again, the theme used is based on your default settings.

To set the Night mode settings:

1. Open the Options dialog box.
2. Click the **Colors** tab.
The Colors options are displayed.

3. Select the **Auto-switch to Night Theme** check box to turn Night mode on and off automatically.

4. Do one of the following:
   - To control Night mode based on a specific time of day, in the **Sunrise** field, enter the time to start Day mode. In the **Sunset** field, enter the time to start Night mode.
   - To control Night mode based on your geographical location, click the **Use GPS Coordinates** check box, and then enter your latitude and longitude (to the nearest degree) in the appropriate fields. The software automatically enters the coordinating times in the **Sunrise** and **Sunset** fields.

5. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

**Setting CAD colors**

The colors used in CAD can be set to your own preferences. Color settings are saved on the Mobile server and display on any device without redoing the settings.
To set CAD colors:

1. Open the Options dialog box.

2. Click the **Colors** tab.

   The Colors options are displayed.

3. Do one of the following:
   - To set the colors according to call type, in the **Call Colors** area, select the call type, and then use the drop-down lists in the **Foreground** and **Background** fields to select the foreground and background color for the call type. To use the color scheme specified in the **Other** option for all call types, select the **Disable** check box.
   - To set the colors according to unit status, in the **Unit Colors** area, select the status type, and then use the drop-down lists in the **Foreground** and **Background** fields to select the foreground and background color for the unit status. To use the color scheme specified in the **Other** option for all statuses, select the **Disable** check box. In the **Call Colors** and **Unit Colors** areas, set the colors to your preferences. The foreground and background colors for each call and unit type can be selected. If the **Disable** check box is selected for a call or unit type, then the selected type takes on the color scheme listed under **Other**.
4. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.
Setting Mapping Options

The following options can be set up for Mapping:

- “Defining the appearance of markers and labels” on page 298
- “Adding a current weather feed to the map” on page 300
- “Setting the Emergency Alert Map Zoom settings” on page 302
- “Setting CAD information display options” on page 304

NOTE
The Route Colors and Routing Options area on the Mapping tab pertain to the Quickest Route module, and are not described in this manual. For more information, see the Quickest Route Manual.

Defining the appearance of markers and labels

The appearance of call and unit markers can be defined, as well as the appearance of labels on the map.

To define the appearance markers and labels:

1. Open the Options dialog box.
2. Click the Mapping tab.
The Mapping options are displayed.

3. In the **Call** area, select or clear the check boxes for the desired settings:
   - To show the call label, select the **Show label** check box.
   - To show the call nature, select the **Show call nature** check box.

4. In the **Unit/Device** area, select or clear the check boxes for the desired settings:
   - To show the unit label, select the **Show label** check box.
   - To show the unit status, select the **Show unit status** check box.

**NOTE**
Clearing the **Show label** check box also hides the call nature, unit status, or device status as applicable.

5. In the **Locate** area, select or clear the **Show label** check box to show or hide labels for searched locations.

6. In the **Icon Size** area, select the size of the call and unit marker icons.

7. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.
**Adding a current weather feed to the map**

A current weather feed that is updated every hour can be added to your Mobile map. When selected, the weather information is displayed in the upper-right corner of the map.

To add a current weather feed to the map:

1. Open the Options dialog box.
2. Click the **Mapping** tab.
   
The Mapping options are displayed.

3. In the **Current Weather** area, select the **Show Current Weather** check box.
5. In the **Select a State** field, select your state from the drop-down list, and then click **Find**.
A new web page opens with a list of XML feeds for the selected state.

6. In the **Observation Location** column, find the closest city or area.

7. In the **XML** column, right-click the orange **XML** button, and then do one of the following:
   - For Internet Explorer, select **Copy Shortcut**.
   - For Firefox, select **Copy Link Location**.
   - For Chrome, select **Copy Link Address**.

8. In the Options dialog box, paste the shortcut or link into the **NOAA Formatted Weather Feed** field.

9. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.

The current weather conditions are displayed on your Mobile map and update every hour.

**NOTE**

Make sure to right-click the **XML** button in the **XML** column, and not the **XML** button in the **RSS** column. Using the **RSS** column does not display the current weather on the map, but a series of numbers instead.
Setting the Emergency Alert Map Zoom settings

When an officer sends an emergency alert, if your agency uses the AVL module, and the officer’s vehicle has a GPS device, then the alert message contains a Locate on Map link. The zoom settings for the map when the Locate on Map link is clicked depend on the Emergency Alert Map Zoom settings.

To set the Emergency Alert Map Zoom settings:

1. Open the Options dialog box.
2. Click the Mapping tab.

   The Mapping options are displayed.

3. In the Emergency Alert Map Zoom area, in the Measurement field, select the unit of measurement to zoom from the drop-down list.
4. In the Distance field, enter the value for the unit of measurement. For example, if the selected unit of measurement is Feet, and 1 is entered in the Distance field, then when the Locate on Map link is clicked, the map zooms to within 1 foot of the unit marker for the officer.
5. To save your changes and close the dialog box, click OK. To save your changes without closing the dialog box, click Apply.
**Setting auto-zoom options**

When certain actions occur on the map, the auto-zoom features move the view of the map to the affected unit or device.

To set auto-zoom options:

1. From the Mobile menu bar, select **File > Options > Mapping**.
   
The Options dialog box opens to the **Mapping** tab.

2. To set auto-zoom options for routing features, in the **Routing Options** area, complete the following fields:
   
   - **Auto-zoom to Extent of Route**: Select this check box to continually zoom in as the unit or device approaches the route destination.
   
   - **Maximum zoom level**: Select from the drop-down list the maximum level the map will zoom as a route’s end point is reached. This field is enabled only when the **Auto-zoom to Extent of Route** check box is selected.
   
   - **Auto-zoom when Auto-Pan Enabled**: Select this check box to continually zoom to a pre-set level when auto-panning is enabled.
Setting Mapping Options

– **Zoom level**: Select from the drop-down list the level the map will zoom when auto-panning is enabled. This field is enabled only when the **Auto-zoom when Auto-Pan Enabled** check box is selected.

**NOTE**
For more information on the **Routing Options** area, see the [Quickest Route Manual](#).

3. Click **OK**.

### Setting CAD information display options

The following CAD information can be displayed on the map:

- “Viewing the Call Information and Unit Information areas” on page 304
- “Viewing the Call Comments area” on page 305

**Viewing the Call Information and Unit Information areas**

To view the **Call Information** area and **Unit Information** area on the map:

1. Open the Options dialog box.
2. Click the **Mapping** tab.
The Mapping options are displayed.

3. In the CAD information area, select the Show Additional Call and Unit Information check box.

The Call Information area and Unit Information area appear on the map.

**Viewing the Call Comments area**

The Call Comments area, which contains the Add Comments, Radio Log Entry, Premises, and HAZMAT buttons, can be viewed on the map.

To view the Call Comments area:

1. Open the Options dialog box.
2. Click the Mapping tab.
The Mapping options are displayed.

3. In the CAD Information area, select the Show Call Comments and Premises Links check box.

   The Call Comments area, and the Add Comments, Radio Log Entry, Premises and Hazmat buttons, appear on the map.

4. To save your changes and close the dialog box, click OK. To save your changes without closing the dialog box, click Apply.
Setting Message Center Options

Message Center email and instant message (IM) preferences can be set as desired.

To set your Message Center options:

1. Open the Options dialog box.
2. Click the Message Center tab.
   The Message Center options are displayed.

3. In the IM area, do one of the following:
   – In the Display area, to display an IM user’s name only, select Name. To display an IM users’s name and unit, select Name and Unit.
   – In the New Conversations area, to flash a minimized IM window in the taskbar when a new IM is received, select the Flash in Taskbar option. To automatically open a new window when a new IM is received, select the Open Window option.
   – In the IM User Status area, to show only users who are logged in to Mobile, select Hide Offline Users.

4. In the Messages area, complete any of the following:
- To perform a check prior to sending an email message, verify the **Always check spelling before sending** check box is selected. By default, the check box is selected.

- To move state and InSight returns to the **History** folder only after the current Mobile session is ended, select the **Disable Auto-archiving** check box.

  If the **Disable Auto-archiving** check box is not selected, then state and InSight returns are moved to the **History** folder after viewing the return and leaving the Message Center. By default, the check box is not selected. For more information, see “Using the Record Screens” on page 104.

5. To save your changes and close the dialog box, click **OK**. To save your changes without closing the dialog box, click **Apply**.
Appendix A contains information about using the Verified Entry feature for Mobile.

The Verified Entry feature is used to defer the advanced search that Mobile preforms to validate new records against existing records. Your SAA determines if the Verified Entry feature is used at your agency.

Validation can be completed at a later time, such as in the office after patrol, or by a records clerk.

CAUTION
Failure to validate records in a timely manner will result in inaccurate or duplicate data in your database.

The following sections describe how to use the Verified Entry feature:

- “Using the Verified Entry feature with electronic forms” on page 309
- “Viewing unverified records in Mobile” on page 310
- “Verifying unverified records” on page 311

Using the Verified Entry feature with electronic forms

Unverified records can be added to a State eCitation or State Crash form, and are identified by a blue stripe in the Search List area.
Although unverified records can be added to electronic forms, and the form can be submitted to the state, records are not permanently added to the database until they are verified. For more information on completing an electronic form, see the Mobile State eCitation and State Crash Form Manual.

**Viewing unverified records in Mobile**

If Verified Entry is enabled, then when a record is added to Mobile, it is identified as unverified through a miscellaneous involvement and an Alert flag.

If an unverified record matches search criteria, then an Alert flag is also displayed in the Search Results screen.
Verifying unverified records

If unverified records exist in the database, then they must be verified to avoid duplicate records and inaccurate data.

Depending on the settings established by your SAA, unverified records can be accessed through Mobile only, Flex only, or both Mobile and Flex.

To verify unverified records:

1. Do one of the following:
   - In Mobile, from the menu bar, select Screens > Unverified Records.
   - In the command center, at the command line, enter unverified.

   The Unverified Records screen opens.

2. If necessary, to make changes to the record, double-click the record.

   One of the following occurs:
   - If Flex is open, then the screen for the record opens in your database for editing. Complete your changes, and then click Accept.

Multiple users can access the Unverified Records screen at one time. A Submit button is next to each unverified record.
– If only Mobile is open, then the Edit Record screen opens.
  Complete your changes, and then click **Save**.

3. Click **Submit** to verify the record.

   One of the following occurs:

   – If there are possible duplicate records in the database, then the Validation screen opens. Complete the validation process. For more information, see “Validating a New Record” on page 174. Once the record is validated, the changes are submitted to the database.

   – If there are no duplicate records, then the record is submitted to the database.

   In the Unverified Records screen, a green check mark appears next to the record.

4. To refresh the Unverified Records screen so only unverified records are displayed, click the **Refresh** button.

   The verified records are removed from the Unverified Records screen.

5. Complete steps 2–4 until all unverified records have been verified.